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Safe Operations
For Safe Operations: Precautions

Preventing Mechanical Failure, Electric Shock, Fire and 
Exposure to Hazardous Laser Radiation
For your safety, operate this equipment only as prescribed by the instructions 
in this manual. Operation outside these parameters may subject the pur-
chaser to waive of any liabilities by Hitachi Software Engineering Co., Ltd.

In addition, any claims deemed to arise due to failure to thoroughly read this 
manual may result in the waiver of any liabilities by Hitachi Software Engi-
neering Co., Ltd.

The following symbols are related to safety concerns. Please ensure that you 
understand the meaning and implications of each symbol before continuing 
to read this manual.

WARNING! This symbol indicates the possibility of loss of life or 
serious injury if you accidentally operate the equip-
ment in ignorance of the information highlighted by 
this symbol.

CAUTION! This symbol indicates the potential for personal injury or 
damage to equipment if the equipment is operated in 
ignorance of the information highlighted by this symbol.

Examples of Schematic Symbols
Each symbol indicates the type of warning illustrated.

Cautions the user of a particular hazard (in this case, of potential 
electrical shock).

This symbol represents prohibited actions.

!

!
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WARNING! Proper Handling

Do Not Disassemble or Repair
Please do not disassemble or attempt repairs. Tampering with the 
internal components risks exposure to such hazards as electrical 
shock and laser radiation.

Shield the Scanning Unit from Water
Shield the Scanning Unit from water. Never place objects con-
taining water or other fluids on the Scanning Unit. A spill can lead 
to short circuits or electric shock. If there is a spill, immediately 
turn the power switch off, disconnect the power cord and contact 
your nearest authorized Hitachi Software Engineering Service 
representative.

No Foreign Objects
Keep foreign objects out of the Scanning Unit. Do not allow paper 
clips, hairpins, metallic objects, paper or other combustible 
material to fall in or otherwise enter the Scanning Unit. Foreign 
objects in the Scanning Unit can lead to short circuit, fire or 
electric shock. If this should happen, turn the power switch OFF, 
disconnect the power cord and contact your nearest authorized 
Hitachi Software Engineering service representative.

!
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Safe Operations
WARNING! Handling the Electric Power Unit

Use Only the Specified Power Cable
Ground the Scanning Unit with the proper power cord with the 
three-prong plug provided with the Scanning Unit. Before 
turning on the Scanning Unit, check that the power cord is NOT 
damaged. Using the damaged power cord can lead to short cir-
cuits, fire or electric shock. If the power cord is damaged, turn 
the power switch OFF, disconnect the power cord and contact 
your nearest authorized Hitachi Software Engineering Service 
representative for a replacement. Use only a properly grounded 
three-prong power cord as a temporary replacement. 

Do Not Use a Non-standard Power Supply 
Use the specified power supply (AC100 V and 50/60 Hz). Use 
only with the proper voltage and frequency indicated on the 
specification plate on the rear of the equipment. Use of other 
than the proper power specifications may lead to accidents and 
equipment malfunction. 

!
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1 Overview
Advantages of the FMBIO System
Thank you for purchasing Hitachi Software Engineering Company, Limited, 
FMBIO scanning unit, a device for reading the electrophoresis patterns of 
fluorescent dye-marked samples. FMBIO represents a maturing of fluo-
rescent technology that has been applied to life sciences labs since the 
1960’s. Some of the major benefits associated with the system are improved 
safety, speed, accuracy, and lower cost.

Read this manual carefully before attempting to operate the system and care-
fully heed all safety warnings.

Improved Safety
The FMBIO system eliminates the risks to lab personnel, the need for radio-
active shielding and the storage and procurement problems associated with 
handling I125, C14, S35, and P32. 

Faster Results
With the FMBIO, speed of experimental throughput is substantially greater 
because scanning and analysis are independent of electrophoresis. Many 
more gels can be run and scanned with the FMBIO than with a dedicated 
electrophoretic sequencer.

The FMBIO reads gels, membranes, and plates without the need for x-ray 
film or costly phosphor screens. Over- and under-exposure problems are 
eliminated. Scan times for the FMBIO are typically five to ninety minutes, 
considerably less than the eight hours development time required for conven-
tional radiography. FMBIO images are processed without removing glass 
plates, drying gels, or developing film, saving more time. Using multi-wave-
length scanning, samples labeled by two or more different fluorophores can 
be read in one scan.
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Greater Accuracy
Accuracy, sensitivity, and flexibility of experimental operations are 
improved with the FMBIO system. Sixteen-bit imaging allows detection of 
signal intensity over a much greater linear dynamic range than isotope-based 
systems. This enables both dark and light bands to be read in the same exper-
iment. Many of the errors that stem from sample handling are virtually 
eliminated because glass plates are not removed, gels are not dried, and read-
ability of results does not depend on exposure time. Because scanning does 
not require removing the gel from the glass plate, gels can be run, then 
scanned, then run and scanned again, increasing the number of readable 
bands per gel. 

Lower Costs
When the FMBIO system is in place, the expense associated with X-ray 
film, storage phosphor screens, shields, badges, Geiger counters, low tem-
perature freezers, and disposal services is eliminated.

Simplicity
The FMBIO IIe consists of a scanning unit and two software applications 
that run on Microsoft Windows 95 and above. The Read Image scanning 
software controls the operation of the scanner, and the Image Analysis 
software carries out the analysis of the scans. The two software applications 
may be run on separate computers if desired.
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Overview
FMBIO IIe System

Scanning Unit Features
The FMBIO IIe scanning unit detects laser-induced fluorescent signals on 
gels, blots and thin layer chromatograms. It accommodates plate sizes up to 
200 x 475 mm, with a maximum reading size of 200 x 430 mm. The exci-
tation source is a YAG 532-nm solid state 50mW laser. 

The laser's optical unit moves across the sample (Y direction) as its laser 
beam is directed onto the sample (X direction) via a polygon mirror rotating 
at high speed. The resulting fluorescent light signals emitted from the excited 
fluorophores are then collected by two optical fiber arrays.

The instrument also features two photomultiplier tubes, a large scan area of 
20x43 cm, and a linear dynamic range of four orders of magnitude. The 
FMBIO produces extremely high resolution images capable of resolving 
even single-base microvariants.

Fluorescent probes that are responsive to the frequency of the laser beam 
emit fluorescent signals upon being excited. The emitted light is collected by 
a lens and directed into a fiber optic array which passes it to an interference 
filter. The targeted fluorescence wavelength passes through the interference 
filter and then to a photomultiplier where the light signal is converted to a 
digital signal. Conversion of the digital signal to experimental data takes 
place in the data acquisition circuits, where fluorescence detected at the pho-
tomultiplier is synchronized with the angle of rotation of the scanner mirror 
and with the horizontal motion of the optical unit to produce positional 
values in the sample. See Figure 1-1.
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.    

Figure 1-1. Interior view of FMBIO scanning unit

Multicolor imaging is achieved using band-pass detection filters to discrim-
inate light from fluorescent dyes emitting between 500 and 700 nm. Up to 
four filters can be stored in the instrument and accessed through software. 
Two filters can be used simultaneously to detect emissions from two dif-
ferent dyes.

In three-color analyses, the gel is scanned after electrophoresis using a 505 
nm band-pass filter to detect fluoresceinated amplification products, a 585 
nm band-pass filter to detect products labeled with TMR, and a 650 nm 
band-pass filter to detect the CXR-labeled internal size standards. These 
images can be overlaid into a three-color image or viewed separately.

Optical filters

Laser source

Fiber optic array

Photomultiplier

Lens assembly
Polygon mirror
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FMBIO Specifications

Ensure that the voltage and frequency of the power source correspond to 
FMBIO power settings. Check the power settings on the specification panel 
on the rear of the machine. Verify that the building power supply has a func-
tional ground. 

Software Features
The FMBIO software consists of two modules: FMBIO Read Image and 
Image Analysis. These applications function independently and need not be 
installed on the same computer.

FMBIO Read Image.  This application controls the FMBIO scanning 

Weight 55 kg

Outside dimensions 87 cm (W) x 65 cm (D) x 35 cm (H) 

Operating temperature 10 - 30 °C

Operating humidity 20 - 80% relative humidity

Laser excitation wavelength 532 nm

Emission wavelength Selectable: 500 - 700 nm

Detection sensitivity 
(with polyacrylamide gel)

Rhodamine: 0.1 fmol/band 
Fluoroscein: 0.2 fmol/band

Plate size (max) 295 mm (W) x 470 mm (D) x 5 mm (H) 

Scanning area (max) 200 x 430 mm

Dynamic range 
(signal readability)

Up to five orders of magnitude

Resolution 83 µm maximum spatial resolution;
16 bit (65536 grey-scale levels)

Laser power ~ 50mW, solid state YAG laser

Power frequency 50/60 Hz

Power consumption ~ 100 W

Power supply (AC) 100/110/115/120/220/240 V
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hardware, synchronizes the fluorescent input signal with the scanning mirror 
and optical unit, and converts this data into a bitstream. Read Image is used 
to easily set the scan area, scan resolution, image orientation, and photomul-
tiplier sensitivity. The user can also choose filters, add comments to be saved 
with the scanned image, and perform hardware checks. The experimental 
data collected are converted by Read Image into a 16-bit digital TIFF file for 
analysis with the Image Analysis software. The scanning software provides a 
sixteen-bit gray scale image of fluorescence intensity, with a broader linear 
dynamic range than possible with conventional autoradiography.

Image Analysis.  This application offers a user-friendly interface for 
viewing and analyzing images. The software features analysis functions that 
include automatic band detection to facilitate data processing, quantitation of 
peak height or peak area, and band sizing through comparison to size 
standards.

With fluorescent dyes for sample labeling, and the FMBIO software the 
system can analyze:

• Gels (1D and 2D)
• Membranes (Southern, Northern, Western, dot, slot, TLC)
• low- to medium-density arrays

Multi-wavelength analysis makes it possible to create and analyze multi-
color signal images. You can run fluorophores of multiple spectra in the 
same lanes, and simultaneously scan their emission signals. This function is 
useful for comparative allele analysis or, when a marker of known size is 
added to the lane, for highly accurate size determination. 

FMBIO software contains spatial analysis functions that accurately estimate 
fragment migration distances. It also contains signal intensity analysis func-
tions, so that it can perform densitometry to estimate band or spot intensity. 

Fluorescent Labels 
With the FMBIO, you can select from a wide range of fluorophores, from 
rhodamine red to fluorescein green and including tetramethylrhodamine, X-
rhodamine, beta-phycoerythrin, ethidium bromide, propidium iodide. 
Because of the powerful intensity of the FMBIO laser, you can use fluoro-
phores with emission wavelengths closer to the excitation wavelength. 
Table 1-1 shows a list of dyes and stains that can be used with the FMBIO, 
along with recommended filters.
1-6



Overview
Almost all molecular species absorb and then re-emit light under certain con-
ditions, giving a broad emission spectrum, up to 100 nm wide in condensed 
media. When the emission process (the excited state) takes place at the nano-
second or a slower time scale, the phenomenon is called fluorescence. 

Table 1-1: Dyes and Stains Detected with the FMBIO 

Dye or Stain Excitation
(nm)

Emission
(nm)

*Filter
(nm)

Vendor

Protein Stains

Sypro Orange 472 570 585 Molecular Probes

Sypro Red 530 625 625 Molecular Probes

DNA Post Stains

Ethidium Bromide 300 511 605 A reliable source

Sybr Green I 490 520 505 Molecular Probes

High Sensitivity 532 605 605 Molecular Probes

Dye Labels

FITC Fluorescein 490 520 505 A reliable source

FAM 495 535 505 Perkin-Elmer

JOE 526 548 585 Perkin-Elmer

HEX 529 560 585 Perkin-Elmer

TAMRA 559 578 585 Perkin-Elmer

Tetramethyl rhodamine 546 572 585/605 Molecular Probes

Rhodamine X 574 595 605 Molecular Probes

Texas red 578 602 605 Molecular Probes

ROX 580 605 605 Perkin-Elmer

Bodipy 563 602 605 Molecular Probes

POPRO3 270, 593 567 585 Molecular Probes

BOPRO3 271, 575 600 605 Molecular Probes

BOBO3 245, 572 602 605 Molecular Probes

Cy2 489 505 505 Amersham

Cy3 552 565 585 Amersham

Cy3.5 581 596 605 Amersham

FluorX 494 520 505 Amersham

Alk. Phos. Substrates

*Use these filters for maximum sensitivity. 
1-7



FMBIO®
Attophos 430-440 560 505 JBL

Vector red 605 Vector Labs

Dye or Stain Excitation
(nm)

Emission
(nm)

*Filter
(nm)

Vendor

*Use these filters for maximum sensitivity. 
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2 Installation
Preparing for Installation

WARNING! Failure to follow proper installation procedures could 
result in physical harm to personnel and damage to 
the equipment. Review the warnings and cautions 
detailed after the Table of Contents at the beginning 
of this manual.

Contents of FMBIO Shipment
Before beginning installation, check that you received the following items 
with the FMBIO shipment.
 

1 Scanning Unit

1 Power cord, 2 m long

1 SCSI terminator

2 Dust caps, mounted to SCSI connector

1 Optical filter, 605 nm

!

2-1



FMBIO®
Installing the Scanning Unit
Instrument and software installations are performed by qualified Hitachi 
Service personnel. Any unauthorized attempt to install the scanning unit 
could void the instrument warranty. 

Prepare a level, sturdy, non-vibrating surface in a well-ventilated, 
temperature-stable area for the FMBIO scanning unit. The unit should not be 
placed in a dusty or damp location, or in an area where it will be subject to 
vibration or impact. Allow at least 10 cm of clearance next to the rear and 
left panels. Do not place heavy objects on top of the scanning unit. Keep the 
scanning unit away from flammable or corrosive gases. 

Important: The laser on the FMBIO requires a constant power 
source. If the power specifications on 
page 1-5 are not met, a power shortage could 
result and cause instrument failure. 
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Installation
Installing the FMBIO Software 
FMBIO system requirements:

• IBM® or 100% IBM®-compatible personal computer

• Windows 95 or later

• Pentium II 300 MHz or greater is recommended

• 64 MB RAM minimum (128 MB or more recommended)

• 10 MB free (minimum) of hard disk storage space is required for 
program loading. Image and spreadsheet files could require substantially 
more storage space

• CD-ROM disc drive or a 3.5 inch floppy disk drive is required for 
installation

• Resolution: 1024 x 768 or higher, 16-bit color display or higher

• Mouse or other pointing device

• Keyboard

The FMBIO software can be obtained on a CD or 3.5 inch floppy disks. 

To install the FMBIO software contained on a CD:

1. Turn off the screensaver.

• In the Windows Taskbar, click on the Start button. Choose Settings 
> Control Panel.

• Double-click the Display icon.

• Click the Screensaver tab, then select None.

2. Disable all virus protection programs.

3. On the CD, open the ReadMe file to find out about changes and updates.

4. Click the Start button, then choose Run....

5. Enter the pathname for the setup.exe file on the CD (for example, 
D:\setup.exe), then click OK.

6. Follow the instructions on the screen.
2-3
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File Compression
A single image file may consume up to 10 MB or more of disk storage 
space. FMBIO software save functions include optional file compression to 
allow disc space to be conserved. Depending on the file, compression 
reduces file size to 25-50 percent of its original size. Hard disk capacity is 
scanned prior to image reads to ensure that adequate storage space exists. 

Understanding Personal Computers
Users of the FMBIO system should be familiar with basic IBM-compatible 
computer and Windows system functions. New users should familiarize 
themselves with Windows system operation before attempting to operate the 
FMBIO system. Refer to your manuals and the online help installed with 
Windows system.

Setting Color Display
1. In the Windows Taskbar, click on the Start button. Choose Settings > 

Control Panel.

2. In the Control Panel window, double-click the Display icon.

3. Click the Settings tab, then select the 256 Colors setting or higher.
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Installation
Note When 256 colors are selected, only the active window is displayed 
with sharpness and clarity, while background windows may have a 
rough appearance. When High Color (16-bit) or True Color (32-bit) 
is selected, all windows are displayed with sharpness and clarity, 
but at the cost of slower screen drawing. The number of colors you 
choose depends on the complexity of your images and the speed of 
your system. 

Printer
Images generated by the FMBIO system can be printed on conventional 
postscript laser printers with 600-dpi resolution. While the images rendered 
by such machines are adequate for many reference and record-keeping 
purposes, much information is necessarily left out of images printed on such 
machines. Always remember that images printed on such machines are 
schematics that do not faithfully represent all the information available in the 
digital image in the FMBIO file. 
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High quality images that more faithfully represent in hard copy the 
information present in the FMBIO image file can be created using a high-
quality image printer. Image printer capability should include 256 grayscale, 
3-color dye sublimation, and 300 or higher dpi resolution. 

Peripheral Storage Devices
A single digital image file may be 10 MB or larger. To conserve hard drive 
space, you may store files on a peripheral storage device, such as a magneto 
optical drive or another removable storage drive. Connect the optional 
storage device to the FMBIO using the appropriate 50-pin SCSI cable.
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3 Operating the Scanning Unit 
This chapter describes the steps you should follow to operate the scanning 
unit. These steps are summarized below:

1. Start ReadImage software. See page 3-2.

2. Turn on power to the FMBIO scanning unit and wait for the self-diag-
nosis routine to finish. See page 3-2.

3. Check that the 605-nm filter is in Channel 1 for autofocusing. See 
page 3-5.

4. Clean the sample plates and scanner sample stage. See page 3-8.

5. Load the sample on the FMBIO sample stage. See page 3-10.

6. Choose the appropriate parameter set in the ReadImage dialog box and, 
if necessary, adjust the scanning parameters. See Chapter 4, Read Image 
Software.

7. Use ReadImage software to begin scanning the sample. A scan may take 
from five to ninety minutes.

See page 3-14 for Guidelines to Scanning with the FMBIO ReadImage 
software. 
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Starting the FMBIO Scanner

Before turning on the power to the scanning unit, turn on the computer and 
start the FMBIO ReadImage software.

• To start the ReadImage program, double-click the ReadImage icon.

The FMBIO scanning unit has two electrical switches:

• The Main switch, located on the rear panel next to the SCSI 
cable port

• A Power switch, located inside the front panel

For both electrical switches, the Off position is marked with a circle (O) and 
the On position is marked with a vertical line ( | ). The locations of the power 
switches are shown in the following two figures.

Figure 3-1.Inside front panel with Power switch

Power switch

Power, Ready 
and Error 
lights
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Figure 3-2. Rear view of FMBIO scanning unit

1. Turn on the computer that is connected to the scanner by a SCSI cable.

2. Set the Main switch to the On ( | ) position.

3. Open the front panel of the scanning unit and turn on the Power switch.

When the scanning unit is first turned on, it automatically performs a 
self-diagnostic routine. During the routine, the Ready light on the front 
panel blinks. 

Self-diagnosis Normal
When the Ready light shines steadily, without blinking, the self-diagnostic 
routine has been completed without detecting a problem. You may now use 
the scanning unit.

Error Detected 
When the self-diagnostic routine detects an error, the Ready light shuts off 
and the Error light begins to glow. Turn off the Power switch for at least five 
seconds, then turn on the Power switch. The FMBIO repeats the self-
diagnostic routine. If the routine detects an error again, contact your nearest 
authorized Hitachi Software Engineering service representative.

Main power switch

AC power 

SCSI cable ports

SCSI cable

Power cord,
female
terminal
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CAUTION! Spills on the scanning unit may damage the electronics or 
laser inside the FMBIO. Heavy objects on top of the unit 
may throw the scanning surfaces out of alignment. Avoid 
placing objects on top of the scanning unit. 

WARNING! Normal FMBIO IIe operation uses a 50-mW micro-
laser beam. Exposure to laser radiation can seriously 
damage eyes and vision. A set of built-in safety 
switches places a shutter in front of the laser beam for 
your protection. 

• Do not override the laser safety interlock system. 
• Do not look directly into the open optical filter 

door.

• Do not remove the external panels and covers of 
the FMBIO at any time.

WARNING! Unauthorized repair attempts may expose you and 
your coworkers to extremely high voltage and haz-
ardous laser light, and will also void your warranty or 
service contract. Always call Hitachi Software Engi-
neering for repairs and service. 

Autofocus Calibration
After a power-up, the FMBIO automatically performs an autofocus before 
beginning the first scan. Channel 1 does not have to be active during an 
autofocus, but it must contain the 605-nm filter.

After the initial autofocus, you may remove the 605-nm filter and replace it 
with a filter that accommodates a detection range compatible with the stain 
or dye you are using on your sample.

Inserting Optical Filters
CAUTION! Scratched or dirty filters interfere with precise laser 

detection. Avoid directly touching the surface of the 
optical filter. Use a lens blower to remove dust on the 
filter. For more stubborn dirt, use lens cleaning paper.

!

!

!

!
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Operating the Scanning Unit
Prepare for a scan by placing the appropriate filters in each channel. Only 
active channels collect image data during the scan. See Selecting Active 
Channels on page 4-14 for information about active channels. 

The FMBIO scanning unit can accommodate two filter holders. Each filter 
holder can hold two filters. You must place the appropriate filters in the 
scanning unit before beginning a scan. Once the scan begins, the optical unit 
moves out of home position and the filters are no longer accessible.

Note If this is the first scan after turning on power to the FMBIO unit, 
insert the 605-nm filter in the Channel 1 position.

If the automatic initial autofocus has been completed, turn off Auto 
Focus in the FMBIO menu, and replace the 605-nm filter with a 
filter appropriate to your scanning needs.

Important: If the FMBIO scanning unit has begun a scan, or if the 
unit is in cleaning mode, the optical unit does not return 
to home position when you click the Pause button. You 
cannot change filters when the scanning unit is not in 
home position. See Table 1-1 on page 1-7 for filter 
information.

1. To stop the scan, click the Pause button.

2. A dialog box opens to display three options: Save, Don’t Save, and 
Cancel:

• To stop scanning, return the optical unit to home position and save 
the scan data, click Save. Continue to step 3.

• To stop scanning and discard the scan data, click Don’t Save and 
continue to step 3.

• To continue scanning, click Cancel to close the dialog box, then 
click Resume. 

3. In the FMBIO menu, turn off Autofocus. See the directions for setting 
an autofocus on page 4-13.

4. Replace the 605-nm filter and restart the scan. See the directions for 
changing the optical filters below. 

To insert or change filters:

1. Choose Eject Filter in the FMBIO menu.
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2. Open the front panel, then open the optical filter service door. 

3. Pull out the appropriate filter holder.

The filter holder in the top position holds filters for Channel 1 and 
Channel 3.

The filter holder in the bottom position holds filters for Channel 2 and 
Channel 4.

4. Hold the filter holder in your left hand, so that the arrow on the edge 
faces you and points to the right and the ball bearing on surface of the 
holder faces up. See Figure 3-3 on page 3-7. 

5. In this position, find the two set screws in the groove on the right edge 
of the filter holder. There is one set screw adjacent to each optical filter 
position.

6. Use a 1.5-mm Allen wrench to loosen the set screw that holds in place 
the filter you want to change. 

Note One full turn loosens the screw sufficiently; do not remove the set 
screw. 

Optical filter 
service door

Channels 1 & 3

Channels 2 & 4
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Figure 3-3. Changing optical filters

7. After one full turn of the set screw, hold the filter holder over a clean, 
lint-free tissue and gently tilt the holder upright until the filter falls out. 
Set the filter aside.

8. Return the filter holder to a horizontal position and hold the replacement 
filter over the appropriate hole in the filter holder. The alphanumerics on 
the edge of each filter should be upright. If there is an arrow on the edge 
of the filter, it should point up. Drop the filter in place. 

9. Turn the set screw one full turn to tighten the filter. 

Important: To avoid breaking the filter, do not overtighten the set 
screw. 

10. Return the filter holder to its place in the scanning unit. Be sure the 
finger hole in the filter holder is nearest to the service door. Close the 
optical filter service door.

Set screws

Ball bearing

Filter positions

Finger hole
1.5 mm Allen wrench

Alphanumerics
on edge of filter
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Preparing for Scanning

You can use the FMBIO system to scan and generate an image of:

• Gels —1D and 2D

• Membranes —Southern, Northern, Western, dot, slot, and TLC

• Low- and medium-density arrays

Opening the Cover
Below is a figure that shows the location of the button which, when pressed, 
causes the top cover to open.

 

Figure 3-4. Front view of FMBIO scanning unit

When the cover is open, you can access the glass plates and the scanner 
sample stage. 

Press button 
to open cover
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Operating the Scanning Unit
Important: When the cover is open, the scanning unit cannot scan 
and the computer cannot start a scanning operation. 
When closing the cover, be sure to firmly press it down 
so that it is securely closed and the scanning unit can 
operate.

Glass Plates 
The scanning unit accommodates a glass plate that is 200 mm wide x 475 
mm long and 5.0 mm thick ± 0.1 mm. For best results, only use low-
fluorescence borosilicate glass of “Tempax” or similar grade. The use of 
other grades or sizes of glass may result in poor scanning quality.

The sample stage supports the sample plates on two sides only to allow the 
maximum area to be scanned, and when the glass plate is properly seated on 
the scanner bed, the scannable area is 200 mm (width) x 430 mm (length).

Be careful when loading the sample stage; use both hands, lower the sample 
plate gently onto the stage supports, and close the scanning cover gently. 
Sample plates break easily, and broken glass inside the instrument exposes 
the operator to cuts and the equipment to mechanical damage.

Fingerprints, reagents and other foreign objects on the glass plate surface can 
cause noise in the image and may even show up as signal. 

• Keep the surfaces of the plates clean. Use soap and water, plain water, or 
70% methanol (MeOH) to clean plates. Avoid using ammonia-based 
glass cleaners. Wipe plates until dry to avoid streaks.

Scanner Sample Stage
Dust and particles on the sample stage reflect stray light which can increase 
background signal or cause loss of signal. 

• Keep the sample stage clean, particularly the autofocus strip and adja-
cent areas. 

• Regularly use the cleaning mode to clean the mirror and lens that passes 
below the sample. 

• Wipe the stage and interior areas with a damp, low-lint cloth. 

• Immediately wipe off any gel or samples that fall onto the sample sup-
ports or into the unit itself.
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Loading the Sample 

Figure 3-5. Loading the glass plates on to the scanner bed

To maximize the scannable area on the glass plates, the scanner supports the 
sample plate only on two ends. Take great care when placing the glass plates 
on the scanner bed to avoid breaking the glass plate and damaging both the 
sample and the scanning unit. 

Orientation of glass plates. Scanning begins in the upper left corner of the 
scanner bed, near the sample alignment surface. (See Figure 3-5.) The longer 
of the two glass plates should rest on the sample supports.

Removing spacers.  It is not necessary to remove the spacers on the glass 
plates.

Important: For optimal results and to minimize image file size, do 
not include the spacers in the defined scan area. 

Note Begin the scan as soon as possible after electrophoresis to ensure a 
clear scan image. 

1. Set the Power switch to the On position and open the cover of the scan-
ning unit.

2. Clean and thoroughly dry the surfaces of the glass plates. You may want 

Glass plate
Sliding 
sample support

Sample alignment 
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Operating the Scanning Unit
to mark the front of the plate so that it can be distinguished on the scan. 

3. Before putting the glass plate on the scanner bed, adjust the sliding 
sample support so that it is ready to accommodate the length of the plate. 

4. Carefully and firmly place the end of the longer glass plate up against 
the sample alignment surface. See Figure 3-5 on page 3-10.

5. As you carefully begin to lower the rear end of the glass plate to lay flat 
on the scanner bed, finely adjust the position of the sliding sample plate 
so that it offers full support. 

6. When both ends of the glass plate are firmly supported on the scanner 
bed, gently close the scanning unit cover to avoid vibrations that might 
unsettle the glass plate. You can hear a clicking sound when the cover 
shuts.

WARNING! Laser radiation can leak from the scanning unit when 
the cover is not closed tightly. Stray radiation can 
damage vision and interfere with accurate image 
scanning. Carefully check that the cover is closed 
tightly before beginning a scan. 

!
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Scanning the Image

The sensitivity of the scanning unit is dependent on a number of factors 
including: the dyes or stains used; the quality of the reagents; gel density and 
the diffusion rate of the sample in the gel; protocols and technique. You can 
fine-tune the image scan by adjusting the scanning parameters in the 
ReadImage dialog box. 

Before beginning a scan, read Chapter 4, Read Image Software, to become 
familiar with the features of this software.

Beginning the Scan
Once you are satisfied with the ReadImage scanning parameters, click the 
Read button on the ReadImage dialog box to begin the scan.

Auto Focus. After the Power switch is first turned on, the FMBIO 
ReadImage software automatically performs an autofocus before it begins 
the first scan. During autofocusing, the rotating mirror and other signal 
tracking and processing elements are adjusted to optimize optical alignment. 
The entire process requires about thirty seconds to complete. The 605-nm 
optical filter should be in Channel 1 during autofocusing.

After the initial autofocus, you can turn autofocusing off and on with 
ReadImage software. See page 4-13 for more information.

After the initial autofocus routine, you may stop the scan and replace the 
605-nm filter with a filter of a different wavelength. See Autofocus 
Calibration on page 3-4 for more information. 

Stopping a Scan
When you stop a scan in progress, you either save or delete the partially 
scanned image.

1. To stop a scan in progress, click Pause.

2. A dialog box offers three actions after you click Pause: Save, Don’t 
Save, and Cancel:

• Click Save to save scan data and end the scanning process.

• Click Don’t Save to discard scan data and end the scanning process. 

• Click Cancel to close the dialog box, then click Resume to continue 
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the scanning process.
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Scanning Guidelines

Following is a list of guidelines for use when scanning with FMBIO 
ReadImage.

Auto Focus. After the FMBIO is turned on, it performs an autofocus before 
it begins the first scan. The 605-nm filter must be in Channel 1 position 
although Channel 1 does not have to be active during the autofocus. 

PreRead. Use PreRead to identify the area of interest on the sample and to 
make sure that spacers and other reflective items are not included in the scan 
area.

Scan area.  The rectangle on the Scan Control window represents the total 
possible scan area. You may specify a smaller rectangle within the total scan 
area to represent a pre-defined scan area. By default, ReadImage displays the 
last scan area used with each Parameter Set. 

Time. The amount of time it takes to perform a scan is a product of the area 
of the scan, the resolution (dpi), and the number of repeats per scan line.

Repeats. As you increase the number of repeats per scan line, the signal to 
noise (background) ratio increases.

Signal.  At lower resolutions, the amount of visible signal may increase, but 
resolution of bands and spots decreases.

Resolution.  The resolution of bands and spots improves as you increase 
both resolution (dpi) and repeats per line.

Saving parameters. You can save a set of customized scanning parameters 
as a ReadImage file. You can open this file and reapply the saved settings to 
new scans.

Multiple scans of the same gel. If necessary, you can remove a gel from the 
FMBIO scanning unit, remount it in the gel box for additional 
electrophoresis, and then rescan the gel. 
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4 Read Image Software
The Read Image software controls the FMBIO scanning unit as it generates 
digital images of gels, membranes, blots, and microtiter plates. ReadImage 
converts the experimental data into a digital file which you can store on the 
computer hard disk or on a peripheral storage device. You can then use 
Image Analysis software to analyze the image.

Note This manual does not discuss sample preparation. Refer to standard 
texts such as Ausubel or Maniatis, and to the documentation accom-
panying your fluorophores.

With Read Image software you can:

• Define the type of material being scanned and the scan area

• Set scan resolution (dpi) and number of repeats

• Adjust PMT sensitivity

• Adjust cutoff thresholds for background and signal

• Adjust the focusing point

• Set and save an autofocus routine 

• Add comments to be recorded and saved with the scanned image

• Create and save customized scanning preferences

The procedures discussed in this chapter can be used with all types of scan-
nable materials.

An example which illustrates some of the procedures begins on page 4-27. It 
is followed by a troubleshooting guide on page 4-31 and a list of error codes 
on page 4-32.
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Opening Read Image
Read Image provides default scan settings for four types of scannable 
material: agarose gels, acrylamide gels, membranes, and TLC (thin layer 
chromatography). You can modify the default settings and save the changes 
as a custom file.

• To start the Read Image program, double-click the Read Image icon. 
When the program opens, a untitled Scan Control window is displayed.

Use this window to do the following:

• Pre-read the scan object

• Define the scan area
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Read Image Software
• Read the scan object

• Provide a unique name for the image

• Enter comments

For more information about this window, see page 4-15.

Read Image Files
You can save all the Read Image parameters in a file. When you open a saved 
Read Image file, the Scan Control window is displayed. Read Image auto-
matically displays the scanning parameters. You may modify these 
parameters or apply them unchanged to a new scan. 

• Use the commands in the File menu to create, open, and save Read 
Image files. See page 4-20 for a description of this menu.
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Setting the Parameters
To set the FMBIO II parameters, choose Set Parameters... in the Command 
menu.

Use the Setting dialog box to specify:

• Parameter name

• Scanning resolution

• SCSI ID

• Experiment type

• Channel name, sensitivity, and filter

• Focusing height

• Scan line repeats 

For more information about this window, see page 4-6.
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Additional Scanning Parameters
Use items in the Command menu to specify:

• Gray level adjustment settings, including high and low cutoff thresholds

• Orientation of the scanned image 

See page 4-10 for more information about this menu.

Use items in the FMBIO II menu to choose:

• Autofocus

• Active channels

See page 4-13 for more information about this menu.
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Features of the Parameters Window 

Name Description

Parameter Name Parameters for the scan.

Reading Resolution Horizontal and vertical scan resolution.

SCSI ID SCSI ID assigned to the FMBIO scanning 
unit.

Experiment Type User defined label for experiment.

Channel Name User defined label for channel.

Reading Sensitivity Percentage of the collected laser signal is 
amplified by the PMT at each channel.

Filter Filter used for the channel.

Focusing Focal length (range: -2 to +3 mm).

Repeat Number of laser passes per scan line.
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The most appropriate parameter values for your experiment depend on image 
quality (signal to noise ratio), sample volume (heavy bands or faint bands), 
and fluorophore chemistry. Improper scan parameters may lead to images 
saturated with signal or images so faint that missing important elements, 
such as weak bands, are missing. If in doubt, it may be helpful to scan a 
portion of the image a number of times using different parameters, then 
choosing one set of parameters for the entire image.

1. In the Parameter Name pull-down list, choose the material type you 
want to scan. 

The each parameter name is associated with default settings for the 
scanning parameters. 

2. Examine the parameters in the window and modify them as needed to 
accommodate your particular experimental conditions.

3. Click OK to apply the scanning parameters to your scan. See page 4-15 
for information about defining scan area.

Defining the Parameter Name
The Parameter Name list contains various types of scannable material. Five 
parameter names are available: agarose gel, acrylamide gel, membrane, and 
TLC (thin layer chromatography). Each parameter name is linked to a pre-
defined set of default scanning parameters. 

You can modify any of these parameters as needed to accommodate your 
particular gel conditions. You may also specify and save a customized set of 
parameters for repeated use. See page 4-20.

Agarose Acrylamide Membrane TLC

Horiz. dpi 150 150 150 150

Vert. dpi 150 150 150 150

Repeat 256 256 256 256

1 Ch 80 80 45 45

2 Ch 100 100 55 55

3 Ch 80 80 45 45

4 Ch 100 100 55 55
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Selecting SCSI ID
The SCSI ID of the FMBIO scanning unit is set to 6 at the factory. If you 
have any other peripherals attached to the SCSI port of the computer, make 
sure they do not share the same SCSI ID number. 

• Verify that the SCSI ID is set to Auto or 6 in the ReadImage software.

Setting the Reading Resolution
The higher the resolution, or dots per inch, of the scanned image, the more 
information is collected during the scan. The resulting file for a scan col-
lected at a higher resolution requires more storage space. You can specify 
resolution for both vertical and horizontal scan directions. Each parameter 
name has a limited number of resolution choices for each direction. 

• Select horizontal and vertical scan resolutions. 

Reading Sensitivity
The intensity of the charging voltage generated by the photomultiplier tube 
(PMT) influences how much of the collected light signal is considered as 
viable data. The higher the voltage, the greater the sensitivity and the more 
background signal is included in the data. Material with inherent high back-
ground signal, such as membranes, require lower reading sensitivity. 

When you use more than one filter to produce an image, one or more fluo-
rescent signals may be noticeably stronger than the others. You can adjust 
the sensitivity of each channel to equalize the intensity of the signals. 

Important: You must use the FMBIO menu to activate all the chan-
nels used in the scan. See page 4-13.

• Enter a value between 0-100% for each channel. Read Image 
automatically assigns a value of 0% to sensitivity fields that are left 
blank.

Setting Repeats
During a scan, the laser scans across each line repeatedly before moving on 
to the next. ReadImage software retains median signal values for each line 
and throws out high and low values. This process of throwing out extreme 
values reduces anomalies due to temperature shifts in equipment and sample 
during processing.
4-8



Read Image Software
The ideal number of repeats for any sample is difficult to predict and is 
dependent on a number of factors, including gel density and sample concen-
tration. Increasing the number of scan repeats per line increases the ratio of 
signal to noise and also increases the scan time. You may begin with 150 to 
256 repeats per line, but do not hesitate to use values outside this range.

• Enter a number in the Repeat field. 

Focusing Point
When you modify the focusing point value, ReadImage software adjusts the 
height of the focusing point at the scanning bed to read thick samples, based 
on 5.0-mm glass plates. For most acrylamide gels (0.35 - 0.4 mm thick) and 
membranes, the focusing point value should be set to zero (0). For a 5-mm 
agarose gel, you may raise the focusing point to + 1.2 mm. 

WARNING! The FMBIO scanning unit can accommodate a 
focusing point range from +3.0 to -2.0 mm. Do not 
enter a focusing point value outside of this range 
or severe damage may result.!
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Settings in the Command Menu

The Command menu contains two kinds of commands:

• Commands that correspond to buttons on the Scan Control window.

• Settings that affect the format and appearance of the scanned image. 
These are displayed in the Scan Control window.

Preparing to Scan
Before beginning a scan, check the following settings displayed in the Scan 
Control window:

• Gray Level Adjustment, including the Adjustment Type and the High 
and Low Cutoff Thresholds

• Image File Type

• Orientation

Setting Gray Level Adjustment 
Proper setting of the Gray Level Adjustment parameters enhances signal and 
suppresses noise, resulting in clean, readable images. Improper setting of 
these parameters might result in either saturated or faint images. The Gray 
Level Adjustment parameters modify the signal intensity of each “dot,” or 
pixel, in the scanned image. A pixel, is the smallest unit of a scanned image. 
FMBIO ReadImage files contain 16 bits per pixel, or 65,536 grayscale levels 

(216 colors [black and white] = 65,536 shades of gray). Most computer mon-

itors are 8-bit and can therefore only display 256 (28) shades of gray.
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The Gray Level Adjustment tool tells your computer monitor how best to 
display your image. It allows you to optimize your image by assigning these 
256 shades of gray to the region of sample signal only. All pixels below the 
sample signal range will be shown as white and all pixels above as black.

Cutoff Thresholds.  Cutoff thresholds are applied to the range of 216— or 
65,536—shades of gray that are generated during a scan. Background, or 
noise, lies at the low end of this range; signal lies near the high end of this 
range. 

By adjusting the cutoff thresholds, you are adjusting the range between the 
highest and the lowest acceptable gray shades. When the high cutoff is too 
low, dark band images may be blurry, with indistinct edges. When the low 
cutoff is too high, faint images are lost in the background. 

When you change the percentages for high and low cutoff thresholds, you 
change how the image appears on your monitor. You do not change how 
much imaging data is collected. Once the image file has been saved, you can 
use Image Analysis software to further experiment with the high and low 
cutoff thresholds.      

1. Choose Gray Level Adjustment... in the Command menu.

2. Enter cutoff threshold values in the fields labeled Low (Background) 
and High (Signal).
4-11



FMBIO®
3. Click OK to save the Gray Level Adjustment settings.

Defining Image Orientation
You change the viewing orientation of the image in the saved file. You can 
change this orientation again in the Image Analysis software.

• Choose Command > Orientation, then choose an orientation.
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Settings in the FMBIO II Menu

The FMBIO II menu contains these commands:

• Requesting an Autofocus before each scan

• Determining which channels are active during a scan 

• Preparing the FMBIO scanning unit for cleaning

• Ejecting the filter

Performing an Autofocus
During an autofocus, ReadImage adjusts the focusing mirror and other signal 
tracking and processing elements to find the best optical alignment. This pro-
cedure takes approximately thirty seconds. After the initial autofocus, the 
procedure does not need to be repeated unless the scanning unit is moved or 
bumped. The FMBIO always performs an autofocus at the beginning of the 
first scan after the unit is turned on.

If you do not check the Auto Focus command, an autofocus occurs only 
once, at the beginning of the first scan after you turn on the power switch, 
which is on the front of the FMBIO scanning unit. 

When a checkmark appears before the Auto Focus command, an autofocus 
occurs before each scan.

The 605-nm filter should be in Channel 1 during the autofocus.

Performing an autofocus as part of a routine scan.  Choose the parameter 
settings and load a sample for a routine scan. When FMBIO completes the 
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autofocus, it begins the scan. If Channel 1 is active, ReadImage creates an 
image file for the emission wavelength that passes through the 605-nm filter.

1. Place the 605-nm filter in Channel 1. See page 3-6 for directions.

2. Select Auto Focus in the FMBIO menu. 

3. Select the appropriate ReadImage settings and load the sample.

4. Click the Read button on the Scan Control window.

Before the FMBIO scanning unit begins the scan, it performs the autofocus.

Note  You can stop the scan after the autofocus. See page 3-12. 

Selecting Active Channels
The FMBIO scanning unit has two optical filter holders and each filter 
holder can hold two filters. As a result, the FMBIO scanning unit can simul-
taneously read four different emission wavelengths in the same lane or on an 
entire gel. 

Read Image collects emission data from all active channels during a scan. 
Active channels are preceded by a checkmark in the FMBIO menu and are 
listed in the Scan Control window. Channel 1 is the default active channel.

Note Channel 1 does not have to be active if it is only in place for an 
autofocus. 

1. Before beginning a scan, place the appropriate filters in the filter 
holders.

2. Choose the corresponding channels in the FMBIO menu to make them 
active. Read Image collects emission data from each active channel 
during the scan.

3. Check the reading sensitivity setting for each active channel in the 
FMBIO Parameter window. See page 4-8.

Important: Each active channel must have an associated filter in the 
filter holder. 

If you make a channel active in Read Image, the corresponding channel on 
the FMBIO scanning unit must contain a filter. During a scan, if an active 
channel does not contain a filter, or if the filter holder is not in place, the 
resulting scanned image is white. If an active channel contains an opaque, 
plastic barrier, the resulting scanned image is black.
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See Inserting Optical Filters on page 3-5 for directions on changing optical 
filters.

See page 4-22 for information about the other commands in the FMBIO 
menu.

Scan Control Window

Feature Name Description

Total scan area Displays available scan area and a pre-
defined scan area. 

Scan area coordinates Four values that define the scan area.

Setting button Opens the FMBIO Parameters window.

Read button Begins an image scan. Changes to Pause 
during a scan. Changes to Resume during 
a Pause.

PreRead button Begins a prescan. Changes to Cancel 
during a scan.

All Area button Sets the scan area to the total scan area.

Comment field Stores your comments.
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Using the Scan Control Window
In addition to providing the tools for defining the scan area and performing 
scans, the Scan Control window displays:

• Scan settings specified in the Parameters window. See page 4-6.

• Image file type, orientation, gray level adjustment—settings defined by 
items in the Command menu. See page 4-10.

• Autofocus and the active channels—settings defined by commands in 
the FMBIO menu. See page 4-13. 
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Important: Before defining the scan area and beginning the scan, 
review the settings displayed in the text of the Scan Con-
trol window. Verify the gray level adjustment and active 
channels are appropriate for your scan.

Defining Scan Area 
The PreRead Display in the Scan Control window represents the total scan 
area of the FMBIO scanner bed. The material you are scanning is positioned 
within the total scan area, but may be smaller than the total area. When there 
is a rectangle inside the total scan area, it represents a pre-defined scan area 
that is smaller than the total scan area.

When you choose PreRead, ReadImage produces a low-resolution, rasterized 
image of the scan area in the PreRead Display. You can then modify the scan 
area to include only essential information.

The total scan area is 200 mm x 430 mm. The minimum scan area is 20 mm 
x 20 mm. 

Total Scan Area

Pre-defined Scan Area

Scan Area Coordinates
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Note To reduce the file size of a scanned image, avoid including the glass 
plate spacers and areas outside the sample in the scan area.

During a PreRead scan, the optical unit moves under the scanning bed and a 
rasterized image begins to appear on the monitor.

To preview the entire scan area:

• If the PreRead display is empty, the All Area button is not active. Click 
the PreRead button to preview the entire scan area. 

• If the PreRead display contains a smaller, pre-defined scan area, the All 
Area button is active. Click All Area to preview the entire scan area.

To preview a pre-defined scan area:

1. Click the PreRead button to preview the pre-defined scan area. 

2. To redefine the scan area, place the cursor in the scan area and drag it to 
the area of interest. You can change the size of the scan area by 
dragging the sides of the rectangle.

Adding Comments
You may enter memo information about the scan, such as date, researcher’s 
name, or particular experiment features, in the Comment field in the Scan 
Control window. The comment field holds up to 255 characters. Comments 
are saved in a small text file associated with the image file. You can also use 
Image Analysis to add comments to the image file.

Read 
When you have defined the scan area and all the scan settings, you can begin 
scanning the sample.

• To begin a scan, click the Read button.

Before the scan begins, a Save As dialog appears. Use this window to 
name the image and select its folder location. 

When you click the Read button, ReadImage estimates the size of the 
image file that will be created and compares that size to available disk 
space. If the amount of available free disk space is inadequate, an alert 
box appears to warn you of insufficient space and ReadImage cancels 
the scan. If there is adequate disk space, the scan continues. 
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Depending on the size of the image and the stringency of the scan param-
eters, scanning may take between five and ninety minutes. As the scan 
progresses, a low-resolution raster image appears in the PreRead Display 
window. 

When scanning is complete the data is assembled into the digital image file. 
This last step takes a short time. 
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Additional Features
The menu bar in Read Image software contains many standard commands 
found in IBM-compatible programs, as well as specific commands for oper-
ating the FMBIO scanning unit, modifying scan settings, and opening the 
Image Analysis software. These additional features are discussed in this 
section of the manual. 

File Menu

Most of the commands in the File menu are standard Windows commands.

New.  Opens a new Read Image file.

Open.  Opens a saved Read Image file.

Close.  Closes the active Read Image file.

Saving Read Image Files.  Two commands in the File menu provide a way 
to save Read Image files: Save and Save As. You can use these commands to 
assign a unique name to a unique collection of settings that you plan to use 
repeatedly. 

Recent Files.  Files that have been opened recently are listed. Choose a file 
to open it.

Exit.   Closes only the ReadImage software.
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Command Menu

The Command menu contains commands to do the following:

• correspond to buttons on the Scan Control window. 

• modify settings that appear in text on the Scan Control window.

See page 4-15 for information about the Scan Control window.

Read.  Corresponds to the Read button on the Scan Control window. 

PreRead.  Corresponds to the PreRead button on the Scan Control window. 

Set Parameter...  Corresponds to the Setting button on the Scan Control 
window. Choose this command to open the FMBIO Parameters window.

Set Gray Level Adjustment..., Orientation.  For a discussion of these 
commands, see page 4-10.
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FMBIO Menu

The commands in the FMBIO menu directly manipulate the FMBIO 
scanning unit. These commands only work if your system has been con-
figured by qualified Hitachi Service personnel.

Auto Focus.  See page 4-13 for a description of this command.

Channels.  Checkmarks precede the active channels. See page 4-13 for a 
discussion of active channels. 

Do Cleaning.  Moves the optical unit to allow access to the inside of the 
scanning unit. You cannot change filters when the scanning unit is in the 
cleaning position. See page 9-1 for more information about cleaning the 
scanning unit.

Eject Filter.   Moves the filter holders to make filters accessible for 
removal. 

Note Use the Eject Filter command only when the optical filter service 
door is closed.
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Imaging Basics
In the scanning process, light signals are converted into a bitstream. The 
FMBIO scanning unit generates 16-bit images. Each pixel in the image con-

tains 216 or 65,536 possible signal intensity levels. Sixteen-bit imaging can 
produce very fine-grained images, in which very small or subtle differences 
in the elements of the image may be discerned. 

The resolution, or density of pixels (dots) in the digital image may be 75, 
150, or 300 dots per inch (dpi) in each direction. Dot density of the image is 
determined in ReadImage before scanning. 

Due to two limitations inherent in video display monitors, the image as it 
appears on the monitor is a rough representation of the actual image data 
present in the digital file. First, video monitors use 8-bit processing which 

means only 28, or 256, signal intensity (grayscale) levels are displayed per 
pixel. Thus file signals that are close but not identical to one another in gray-
scale value appear to have the same intensity on the monitor. Signals that are 
slightly above the low cutoff threshold may also be submerged in back-
ground on the monitor. 

Second, most video monitors have a resolution of 72 dpi. Thus an image 

scanned at 150 x 300 dpi would contain 45,000 pixels/in2 in the digital file, 
while the monitor is capable of displaying only about 72 x 72, or 5184, 

pixels/in2. File pixels are averaged together for display purposes with a con-
sequent loss of resolution, in this case at a resolution loss ratio of nearly 9:1. 
The combined effect of these two limitations is that display images are apt to 
appear coarser, grainier, or blurrier than they actually are. 

You can compensate for these limitations in a number of ways:

• Adjust grayscale and gamma controls to fit the particular conditions of 
an image. With Image Analysis, you can modify the image to reveal a 
very broad range of signal intensities. Just remember that considerably 
more information is latent in the image than can be displayed with any 
particular set of display parameters. 

• Many factors contribute to the success of DNA detection. Variables 
include: gel type and concentration, sample preparation, band size, dye 
concentration, staining time, destaining time, gray level settings, and 
laser focusing point. Further optimization of protocols may result in 
higher detection sensitivity.
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• For best scanning results, avoid dust specks by using only powderless 
gloves, rinsing gloves with distilled water, thoroughly cleaning all 
containers used for staining, and filtering all buffers and solutions with a 
0.45µ filter.

• Loading buffers containing xylene cyanol and bromophenol blue 
fluoresce strongly when excited by the FMBIO laser, and can interfere 
with the gel image. For best results, use loading buffers containing no 
xylene cyanol, and bromophenol blue concentrations decreased 1:10.

• Gels can be cast with ethidium bromide to save time after 
electrophoresis. However, electrophoretic mobility of linear double-
stranded DNA is reduced by up to 15% in the presence of ethidium 
bromide and background staining is not uniform when casting agarose 
gels with ethidium bromide. Therefore, post-staining is highly 
recommended.

• Detection sensitivity is higher in acrylamide gels than in agarose gels, 
due to lower background.

• Ethidium bromide can be used to detect both single-and double-stranded 
DNA or RNA. The affinity for double-stranded DNA is higher than for 
single-stranded DNA or RNA.

• Longer staining times do not necessarily increase sensitivity.

• Shortening the ethidium bromide staining time or lengthening the water 
destaining time may decrease detection sensitivity.

• Keep all solutions containing ethidium bromide covered by aluminum 
foil to prevent bleaching of the dye by ambient light.

• Ethidium bromide is a powerful mutagen. Follow usage precautions as 
described on the MSDS.
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Multi-Color Images
Multi-wavelength analysis makes it possible to create and analyze signals 
from multi-color gel images. Two or more fluorophores of different emission 
spectra can be run in the same lanes, or on the same gel. This function is 
useful for comparative allele analysis, or for highly accurate size determi-
nation by running a marker in the same lane with a sample.

To scan material with more than one emission wavelength requires that you 
scan with multiple channels, with the appropriate filters in place.

Multi-color analysis depends on the use of appropriate filters. Each filter 
captures one emission wavelength by screening out the others. To load 
filters, see page 3-5.

Long Pass Filters 
Long pass filters reject shorter wavelength light while allowing longer wave-
lengths to pass through. Long pass filters are named for the wavelength at the 
midpoint of the transition range, for example, OG 610. The midpoint of the 
sigmoid curve that describes the transition from 0 to maximum transmission. 
The narrower this transition range is, the better, especially when the two flu-
orophore emission frequencies are close. 

The name of the long pass filter may also include letters such as OG (orange 
glass), RG (red glass), E (emission), LP (long pass), EFLP (edge filter long 
pass). OG and RG are colored glass absorption filters, whereas E, LP, and 
EFLP filters are coated interference filters. Colored glass filters are cheaper 
and have broader transition slopes than coated interference filters. 

Match filters to fluorophores in such a way as to maximize the amount of 
signal separation. This multi-color image contains red, green and blue 
signals, which were created with FITC, TMR and CXR dyes matched with 
505, 585 and 650 filters, respectively.
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Example Scanning Process
This section describes the process of scanning, using as an example the 
detection of fluorophore-labeled str alleles. 

WARNING! This is only an example. These procedures are not 
meant to describe the only or optimal method to 
carry out the scanning of any material. It is 
included only to illustrate the application of var-
ious FMBIO II functions.

1. Turn on power to the computer. 

2. Turn on power to the FMBIO II. (The switch is behind the pull-down 
panel, on the front left).

3. After electrophoresis has been performed, keep the polyacrylamide gel-
plate assembly together. Carefully clean and dry the outside of the 
plates. The gel/plate assembly does not need to be taken apart, unless 
post-staining is necessary for your application. 

Note Maintaining the integrity of the gel-plate assembly can allow for 
better separation of larger STR loci, because the gel can be returned 
to the electrophoretic apparatus after scanning for additional 
electrophoresis.

If you have an agarose gel, polyacrylamide mini-gel or membrane, 
place them on a 5mm thick, low-fluorescent glass plate. Avoid dripping 
by removing excess buffer on stain. Smooth out bubbles under gels, as 
they can interfere with the scan. Membranes should be mounted wet, 
face down between two pieces of glass. Polystyrene and other clear 
plastics may also be acceptable for holding sample(s), but may result in 
high levels of background.

4. Place the gel-plate assembly in the scanner.

a. Press the button on the top right of the front of the instrument, and 
open the sample door.

b. Slide the right side stage bar to the proper distance to support the 
plate, without obscuring the area to be scanned.

c. Place the plate assembly (long plate face down) on the stage, resting 
the plate assembly on the black bars at each end and between both 
of the stabilizing screws on the bars. Make sure the plate is level 

!
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and secure. For polyacrylamide gels, place long plate face-down.

5. Start the FMBIO II Readlmage program. 

6. Click the Setting button. The Read Image Parameter dialog box is 
displayed.

7. Set the Scanning parameters:

Note The example show described below is for illustration only, and must 
not be interpreted as a suitable procedure for any particular case.

a. Choose the Parameter Name. In this example, Acrylamide is 
entered.

b. Choose the resolution. 150 dpi is an example for the initial setting.

c. Enter the sensitivity. In this example, 80% is enter for Channels 1 
and 3, and 100% for Channels 2 and 4. One of the factors 
influencing this choice is the types of filter to be used.

d. Enter the focusing. 0 is shown in this example. It may need to be 
lower for the thinner plates used in pre-cast gels. Note that the 
range of focusing is ONLY - 2 mm to + 3 mm. Use of values 
outside of this range can seriously damage the instrument.

e. Choose the number of repeats. A example initial setting is 256.
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a. Click OK to return to the Scan Control window.

8. In the FMBIO II menu, set the active channels. A separate image is 
collected for each channel.

9. Since the instrument will always autofocus before the first read after 
power-up, turn Auto Focus off in the FMBIO II menu to save time 
during subsequent scans. The 605 nm filter must be installed in Channel 
1 for autofocusing.

10. In the Command menu, set the gray level adjustment for 
polyacrylamide gels. Examples might be 50% for Low and 1% for 
High.

11. Make any changes needed to Orientation in the Command menu.

Note To save the Read Image parameters for future scans, choose Save 
from the File menu, assign a filename and location, and then click 
Save. Double-click on the saved parameter file to launch the Read 
Image program and return the user to the saved scanning 
parameters.
4-29



FMBIO®
12. Add any comments to an image file by typing those comments in the 
text box in the lower section of the Scan Control window.

13. Click the PreRead button to quickly identify the gel area to scan.

Note If a small scanning box is already set from a previous scan, click on 
the All Area button before prereading. If you need to terminate an 
in-progress prereading, click Cancel.

14. Designate the scan area by dragging with the mouse from top left to 
lower right in the viewing window.

Note DO NOT include SPACERS or other solid objects in this box, 
because they can distort the gray scale balance of the image. 
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15.  Click Read. Specify a file name, and a location for the saved file.

Note You can terminate a scan before completion by clicking Cancel, 
then save or discard the image data.

16. Wait for the instrument to complete all of its scans. The FMBIO II will 
autofocus and might scan twice depending on the channels chosen. 
After the scan begins, a calculated time for completion is noted in the 
lower right of the Read Image Window. This time is per scan, and 
calculation accuracy improves as the scan progresses

17. To view the results, use the Image Analysis software.

18. Adjust the grayscale to optimize the image.

Note See Gray Level Adjustment on page 5-14 for information about 
grayscale adjustment.

19. If the image is satisfactory, proceed to Chapter 5.

20. If the grayscale adjustment does not produce an adequate image, make 
the adjustments suggested in the Image Troubleshooting Guide at the 
end of this chapter, then rescan the image.

Table 4-1: Image Troubleshooting Guide

Problem Suggested Adjustments

Poor band definition • increase repeats and/or resolution

• adjust focussing point

Too much signal • lower the sensitivity

Low signal • increase sensitivity

• adjust focusing point

Grainy appearance • increase sensitivity

• increase repeats

• adjust focusing point

High Background • use low fluorescent glass

• de-stain gel or membrane

• adjust focusing point
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ReadImage Error Codes
In the process of using ReadImage software, you may occasionally see an 
error code number appear on the screen.

Error code = 161, 162, 163, 164, 165, 167, or 169.  Perform the following 
steps:

1. Press the Power switch to the Off position and wait at least 5 seconds. 

2. Press the Power switch to the On position.

The FMBIO performs a self-diagnostic routine.

• If the error code appears again, repeat steps 1 and 2 one more time.

3. If the error code persists, call Hitachi Software Engineering service 
personnel.

Error code =166.   Insert a filter holder in either Channel 1 or Channel 2, 
and then restart the scan.

Error code = 168.  Firmly close the scanning unit cover.

Error code = 192.   There is an internal memory shortage.

Error code = 193.   There is an external memory shortage.

Error code = 198. The optical unit did not return to the home position.
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With the FMBIO scanning unit and Read Image software, a single scan can 
create a multi-color image of a gel that contains one, two, or more fluoro-
phores. In Image Analysis, you can view and analyze the image.

You can run fluorophores of two or more different emission spectra in the 
same lane or gel for comparative allele analysis. Highly accurate size deter-
minations can be achieved when a internal lane standard is run in the same 
lane with a sample. If a sample contains two or more fluorophores and you 
designate two or more channels as active during the scan, FMBIO Read 
Image creates a single multi-color image.

In Image Analysis, you create a project to analyze your 1D or array experi-
ments. You can create a project for a single- or multi-color image. You can 
also display images and data from more than one project simultaneously.
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You can view all the colors in the image simultaneously, or select the layers 
you want to view. You can assign a color to each layer in the project and 
modify the intensity of each color, or display all layers in grayscale.

This chapter describes the tools you can use to modify and analyze the 
scanned image.

Note While the following chapter describes each of the analysis tools 
in the order of use it is not meant to serve as an procedural 
guide. Please refer to Chapter 6, 1D-Gel Analysis, for step-by-
step procedures.

Channel
Lane & Band Data

Standard Curves

Channel
Image Data
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Image Analysis Projects
Double-click the Image Analysis shortcut icon to start the Image Analysis 
program. When Image Analysis window opens, a new project is automati-
cally created for you and a new Project window is displayed.

You can use this new project, create another new project, or open an existing 
project.

Creating a New Project

• To create a new project, click the New Project button or choose 

New Project from the File menu.

Opening a Project

• To open an existing project, click the Open Project button or 

choose Open Project from the File menu.

Saving a Project

• To save a project, click the Save Project button or choose Save 

Project from the File menu. Give the project a name and click Save. 
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Image Menu and Tools
1. In the Project menu, choose New 1D-Gel Experiment or New Array 

Experiment.

2. Select an image file from the directory window. The image icon is 
added to the project tree.

3. Double-click the image icon to display the selected image. 

Once an image is displayed, the Image menu appears in the menu bar and the 
Image Tool buttons become active.
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Command Description

Gray Level Adjustment See Gray Level Adjustment on page 5-14.

Color Separation See Color Separation on page 5-30

Show Image 
Setting Dialog

See Image Setting Dialog Box on page 5-11.

Image Information View sample, image and scanning information 
from the FMBIO II Read Image file.

Save Image As Save an image or selected area as a TIFF or 
BMP file. See Saving an Image on page 5-7.

Transparent Background See Transparent Background on page 5-36

Line Selection Draw a line to select a location on the image

Area Selection Draw a rectangle to select an area on the image.

Show Spectrum See Spectrum on page 5-26

Color Separation

Gray Level Adjustment

Image Information

Show Image Setting Dialog

Line Selection

Area Selection

Show Spectrum
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In addition, you can use the Zoom tools to magnify or reduce the image.

Saving an Image
You can save the entire image or a selected area of an image as a TIFF or 
BMP file.

1. If you want to crop the image, click the Select area to draw but-

Tool Description

Zoom Out Each click reduces the image.

Zoom In Each click to enlarges the image.

Magnification 
Input/List Box

Displays current magnification. Enter the desired 
magnification or select a magnification from the 
drop-down list.

Zooming Tool 1. Click the button. The cursor transforms into a 
magnifying glass with a “+” sign. 

2. Drag the magnifying glass cursor to create a 
rectangle surrounding a region of the image. 
The image is magnified to show the region.

Fit Window Once a magnification is selected, the image fills 
the entire window.

Moving Tool Click the button, and then drag the image with the 
hand cursor.

Zoom Out

Magnification Input/List Box

Zooming Tool

Fit Window

Moving Tool
Zoom In
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ton or choose Area Selection from the Image menu. Place the 

crosshair pointer on a corner of the rectangular area you want to save, 
and click-and-drag the mouse to the opposite corner of the area. Release 
the mouse.

2. Choose Save Image as... from the Image menu. The Save Image as 
dialog box is displayed.

Parameter Description

Image Size Save the entire image or a selected area. 
Select the area using the Area Selection 
tool.

Image Type TIFF or BMP

Invert Gray Inverts the image grayscale values.

Image Rotation None, 180, 270, or 360.
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3. Select the appropriate parameter settings, and click OK. The Save As 
dialog box is displayed.

4. Specify a location for the file in the Directory window, and enter a 
filename

5. Click the Save button. 

Viewing a Multi-Color Image
A multi-color image is a combination of two or more scanned image chan-
nels that share the same scan area and orientation. FMBIO Read Image 
automatically creates a multi-color image file whenever two or more chan-
nels are active during a scan. When Image Analysis opens the image file, it 
displays the combined image channels as one multi-color image.

1. Click the folder expansion symbol next to the image icon to display 

the names of each layer in the image.

Bits 8-bit, or 16-bit.

Channel Save any of the channels represented by 
colors 1, 2, 3, and 4.

Color Separation If color separation has been performed in 
Image Analysis, save the color separated 
image or the raw (pre-color separated) 
image.

Flip Flips image horizontally or vertically.

BMP Format Save the image only or include other items, 
such as band and lane markers.

Parameter Description
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2. In this example, during one multi-color scan CTTv, DDDD, and inlane-
CXR were the active channels.
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Image Setting Dialog Box
You use the Image Setting dialog box to change how the image is displayed 
on the screen.

• By default the Image Setting dialog box is displayed. If it is not dis-

played, click the Show Image Setting Dialog button or choose 

Show Image Setting Dialog from the Image menu. A checkmark indi-
cates the dialog box is displayed.

The Image Setting dialog box looks like this:

Gamma Level 
Adjustment
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Note The Show color-separated images option is active only after you 
have performed a color separation on the image. See Color Sep-
aration on page 5-30.

Display Mode
The Image Setting dialog box assigns a unique color to each channel in the 
multi-color image. The colors available depend on the display mode. The 
Display Mode list box provides three options: Blend, Over, and Mono. Use 
the Display Mode drop-down list box to choose how you want a multi-color 
image displayed. The colors available in the Image Setting dialog box 
change as the display mode option changes.

Displaying a Channel
You can choose to display or hide the image data from one or more channels. 

• Select the channel to show the channel image data. To hide a channel’s 
image data, remove the checkmark adjacent to the channel.

Note You cannot turn off the channel display in Mono display mode. 

Changing Channel Color
You can change the color associated with a channel in the multi-color image. 
The Color Chooser is the colored square next to the channel name. No two 
channels may have the same color assignment.

• Click the Color Chooser for the channel you want to change. A pop-up 
menu of available colors is displayed. Click the desired color.

 Mode Colors Available

Blend Red, Green, Blue. Colors in each channel blend together when they 
overlap to make another color. Red blends with green to make 
yellow; blue blends with green to make cyan; red blends with blue to 
make magenta.

Over Red, Green, Blue, Yellow. Colors in each channel remain distinct 
when they overlap. Use this mode when the multi-color project con-
tains a yellow channel.

Mono All channels display 65,535 shades of gray. All channels in the multi-
color image appear in shades of gray.
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Changing Intensity Level
You can change the intensity of each color associated with a channel.

• Drag the gamma level bar to the right to increase intensity. Slide the bar 
to the left to decrease intensity.

Displaying Detected Bands
After you use Image Analysis to define bands on all channels, you can 
choose which channel displays the band definition lines. 

• Click the radio button adjacent to the channel name. The black dot in the 
radio button indicates the active channel. In the image, Image Analysis 
displays the band definition lines for the active channel. 

For more information on detecting bands, see page 5-63.
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Gray Level Adjustment
The proper setting of the Gray Level Adjustment parameters enhances signal 
and suppresses noise, resulting in clean, readable images. Conversely, 
improper settings might result in either saturated or faint images. 

The Gray Level Adjustment parameters modify the signal intensity of each 
“dot,” or pixel, in the scanned image. A pixel, is the smallest unit of a 
scanned image and each channel in an FMBIO file contains 16 bits per pixel, 

or 216 = 65,536 grayscale levels (starting at 0). Most computer monitors are 
8-bit and can therefore only display 256 shades of gray.

Image Analysis transforms the 16-bit image for display on an 8-bit monitor, 
averaging the additional 16-bit values within each of the 256 8-bit grayscale 
levels to give an 8-bit value. The Gray Level Adjustment tool tells your 
computer monitor how best to display your image. It allows you to optimize 
your image by assigning these 256 shades of gray to only the region 
containing sample signal. 

Note The raw image data is not affected by the gray level settings.

Cutoff Thresholds.  Image Analysis assigns a background cutoff threshold 
and a high signal cutoff threshold for each image. Cutoff thresholds are 
applied to the range of 65,536 shades of gray generated during a scan. Back-
ground, or noise, lies at the low end of this range; signal lies near the high 
end of this range. 

Signals below the background cutoff threshold appear white in the image; 
signals above the high signal cutoff threshold appear as black. The range 
between the background and high signal cutoff thresholds signals is trans-
formed into 256 gray levels.
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To obtain greater clarity of an entire image or certain selected bands within 
it, you can modify the range of gray levels in each channel. In the Gray Level 
Adjustment window, you can use a histogram to adjust the cutoff threshold 
values. Alternatively, you can designate reference background and high 
signal areas on the scanned image. Using these reference areas, Image Anal-
ysis automatically adjusts all gray levels on the image.

By adjusting the cutoff thresholds, you are adjusting the range between the 
highest and the lowest acceptable gray shades. When the high signal cutoff is 
too low, dark band images may be blurry, with indistinct edges. When the 
background cutoff is too high, faint images are lost. 

Because signal intensities can vary greatly from one scan to the next, it is 
difficult to assign default values for high signal and background cutoff 
thresholds. Images that contain only faint bands against a clean background 
can be enhanced with high signal and background cutoff thresholds set to 
relatively high values. Images that contain heavily stained or optically dense 
regions may suffer substantial loss of content even with low threshold 
values. 

The diagnostic guide on page 5-25 provides guidelines for threshold adjust-
ment. See also Imaging Basics on page 4-23.
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Gray Level Adjustment Window

• Click the Gray Level Adjustment button or choose Gray Level 

Adjustment from the Image menu. The Gray Level Adjustment window 
is displayed. 

Channel Selector.  

The gray level must be adjusted for each individual channel.

• Select the channel from the Channel drop-down list box. The Gray 
Level Adjustment window displays the image data for the selected 
channel. 

Background and High Signal cutoff thresholds.  

The values in the High Signal Percent and High Signal Number fields 
change to reflect the selected region. In the following example, 1.85% of the 
pixels have a value between 4,081 and 65,535. These pixels will appear on 
the monitor as black.
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All regions of the image with gray level values below the background cutoff 
threshold value will appear white. As shown, 90.44% of the pixels have a 
value between 0 and 1,537. These pixels will appear on the monitor as white. 
All other elements of the image that fall within the range between the high 
signal and background cutoff thresholds appear as shades of gray.

Histogram.  

The Gray Level Histogram shows the 16-bit gray level gradations (0 to 
65,535) on the X axis and the number of pixels in the image on the Y axis.

Boundary lines indicate the high signal cutoff threshold and background 
cutoff threshold. The red line slider indicates the background cutoff 
threshold value. The blue line slider shows the high signal cutoff threshold 
value. The green line on the histogram displays the current mapping curve. 
By default, the mapping curve is displayed. 

gray level value

# 
of

 p
ix

el
s
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Show Selected Range.  This option magnifies the histogram to show the 
range between the high signal and background cutoff thresholds.

Mapping Type Selector.  

The mapping type defines the method used to transform 16-bit gradation (0 
to 65535) into 8-bit gradation (0 to 255). The gray level gradations between 
the high signal cutoff threshold and the background cutoff threshold are 
divided into 255 equal parts. To view the mapping curve, select the Show 
Mapping Curve option.

Background Threshold

Mapping Curve

High Signal Threshold 
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Mode Description

Equal Range • Range of the histogram between the high signal cutoff 
threshold and background cutoff threshold divided into 
256 equal parts.

Note: Use the Equal Range mode to display of the 
relative concentration of the bands.
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Equal Area • Area of the histogram between the high signal cutoff 
threshold and background cutoff threshold divided into 
256 equal parts. 

In this mode, more pixels are contained in the very 
dark gray parts than in the Equal Range mode. 
Therefore, faint bands are displayed darker than their 
actual pixel values.

Note: Use the Equal Area mode to enhance detection 
of faint bands; this mode is NOT recommended for 
determining the relative concentration of bands.

Mode Description
5-20



Image Analysis Tools
Procedure
The gray level for each channel is adjusted by setting the background and 
high signal cutoff thresholds. You can set these thresholds in three different 
ways:

• Drag threshold boundary lines in the histogram.

• Visually defining signal and background pixels.

• Entering numbers for the high signal and background values.

Using the histogram.  

1. Select a channel and mapping type.

2. To adjust the high signal cutoff threshold value, place the pointer over 
the blue line. The pointer transforms into a horizontal double-headed 
arrow. 

3. Drag the line along the gray level axis until the desired value is dis-
played. The new high signal cutoff threshold value is applied to the 
Whole Image and Zoomed Area windows and a new High Signal 
Percent value is calculated.

4. To adjust the background cutoff threshold value, place the pointer over 

User Defined • Drag any of the four rectangular points to define the 
mapping curve.

Note: Use the User Defined mode to customize your 
mapping curve.

Mode Description
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the red line. The pointer transforms into a horizontal double-headed 
arrow and the value appears in the upper left corner of the window. 

5. Drag the line along the gray level axis until the desired value appears. 
The new background cutoff threshold value is applied to the Whole 
Image and Zoomed Area windows and a new High Signal Percent value 
is calculated.

6. Click the Try button to apply the modified gray levels to the actual 
image. To return to the original settings, click Reset. 

7. Continue to try different gray level settings until your are satisfied with 
the signal and background levels.

8. Repeat the procedure for each channel.

9. When you are finished, click OK. 

Image Analysis recalculates the gray levels for the channels using these 
values as high signal and background limits. 

Note The raw image data is not affected by the gray level settings. 

Visually defining signal and background pixels.  You can define the 
signal and background intensities using the Zoom and Selection cursors.

1. Select a channel and mapping type.

2. In the Whole Image window, drag the Zoom Cursor to a region con-

Zoom Cursor Selection Cursor
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taining average intensity bands/background. If necessary, adjust the size 
of the Zoom Cursor to include the desired area. The area appears in the 
Zoomed Area.

3. In the Zoom window, surround a band with the Selection Cursor.

4. Click the High Signal button. The image displays appear with the new 
high signal cutoff threshold and the values are displayed in the High 
Signal Percent and High Signal Number fields.

5. Move the Selection Cursor to a background area away from the band.

6. Click the Background button. The selected background cutoff threshold 
is applied to the Whole Image and Zoomed Area windows and the 
values appear in the Background Percent and Background Number 
fields.

7. Click the Try button to apply the modified gray levels to the actual 
image. To return to the original settings, click Reset. 

8. Continue to try different gray level settings until your are satisfied with 
the signal and background levels.

9. Repeat the procedure for each channel.

10. When you are finished, click OK. 

Image Analysis recalculates the gray levels for the entire image using these 
values as high signal and background limits. 

Using the percent and number fields.  
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You can also adjust the high signal and background cutoff thresholds by 
entering values in the percent and number fields.

Select a channel and mapping type.

1. Enter numbers in either the percent or absolute value fields, and then 
click OK. 

2. Click the Try button to apply the modified gray levels to the actual 
image. To return to the original settings, click Reset. 

3. Continue to try different gray level settings until your are satisfied with 
the signal and background levels.

4. Repeat the procedure for each channel.

5. When you are finished, click OK. 

Image Analysis recalculates the gray levels for the entire image using these 
values as high signal and background limits. 

Creating a template.  

If you have a series of gels that have been run under the same conditions and 
produce similar images, you might want to save your gray level adjustment 
values as a template for future use:

1. Click the Template button.

2. Click the Create New button. The Template dialog box is displayed.

3. Type a unique name for the template, then click the Close button.

Note When a Gray level Adjustment Template is created, only the 
mapping type, high signal cutoff threshold value, and back-
ground cutoff threshold value are saved. The percent values are 
not saved. Therefore, it is imperative that a Gray Level 
Adjustment template is created for each channel.

To apply a gray level adjustment template:

1. Select a channel.

2. Click the Template button.

3. Select the template name, then click the Apply button.
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Image Diagnostic Guide

If, after these steps, you cannot achieve a satisfactory image, you may have 
too much signal. Try rescanning the sample at a lower photomultiplier tube 
(PMT) sensitivity, scan using a different filter or, if stains were used, destain 
the gel.

Image Quality Cutoff threshold

Entire image is too dark. Increase background and high signal 
thresholds.

Entire image is too faint. Decrease background and high signal 
thresholds.

Image signal blurred with solid 
color.

Increase high signal threshold.

Image background is blank. Decrease background threshold.

Image is chaotic and unclear, due 
to noise.

Decrease background threshold and increase 
high signal threshold.

Image and signals unclear. Increase background threshold and decrease 
high signal threshold.

Image has too much contrast. If the value settings are too close together 
then you may be spreading your 256 shades 
of gray across too small an area. Try using 
the cursor to draw a box that encloses a dark 
band.

Scan shows spacers only. If highly fluorescent objects (such as 
spacers, combs, or gel thermometers) are 
included in the image, the High Signal value 
will be set too high. Enter a lower number in 
the value column. To avoid this problem in 
future scans, eliminate these objects from 
your scan area.
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Spectrum
With the FMBIO system you can accurately quantify signal strength at 
particular locations on the image. This quantification is more accurate than 
conventional radiography followed by scanning densitometry because the 
intermediate film and scanning steps are eliminated. The FMBIO spectrum 
function analyzes the pixel and grayscale data in the digital image and calcu-
lates the signal strength at a given location.

You can use two methods to select the location on the image for spectrum 
analysis.

• Draw a rectangle on the image. The spectrum displays the sig-
nal strength of the bands within the rectangle.

• Draw a straight line on the image. The spectrum displays the 
signal strength at each point on the line.

Area Selection Method

1. Click the Area Selection button or choose Area Selection from 

the Image menu.

2. Position the tool at a corner of the group of bands you want to select. 
Drag the cursor down to the opposite corner until the bands are con-
tained in the rectangle.

3. Release the mouse button. A selection rectangle is displayed. If nec-
essary, adjust the rectangle by dragging the selection handles.
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4. Click the Spectrum View button or choose Show Spectrum from 

the Image menu. The Spectrum window displays an overlay trace of the 
signals, with the areas of signal intensity represented by peaks.

5. To change the dimensions of the graph, resize the window.
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Normalize Baseline tool.  Click the Normalize Baseline tool to normalize 
the vertical range by converting the low end of the range to 0 (zero) and the 
upper end of the range to 255. Use this feature to compare lane traces from 
different image files or from files created by different filters.

Before the vertical range is normalized, it represents the range between the 
high and low Cutoff Thresholds on the Gray Level correction. The low and 
high ends of the vertical range before normalization lie somewhere within 
the range of available pixels in a 16-bit file, from 0 to 65535. On this range, 
spots on the image that appear black or “saturated” may actually have a 
signal above the high cutoff threshold.

However, when the vertical range is normalized, it is compressed to fit to the 
range of available pixels in an 8-bit file, from 0 to 255. The low cutoff 
threshold becomes 0; the high cutoff threshold becomes 255. When Image 
Analysis encounters signal above the high cutoff threshold, it extrapolates a 

Tool Description

Normalize Baseline Normalizes vertical range.

Switch Axis Switches between the horizontal and vertical 
spectrum views.

Display Channel Toggles display of spectrum for individual 
channels. 

Switch Axis

Normalize Baseline

Display Channel
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value for these spots that may actually be greater than 255. The upper end of 
the vertical range reflects the value assigned to these high signals.

Straight Line Method

1. Click the Area Selection button or choose Line Selection from the 

Image menu.

2. Drag the cursor in a straight line over the location you want to analyze.

3. Release the mouse button. A selection line is displayed. If necessary, 
adjust the line by dragging the selection handles.

4. Click the Spectrum View button or choose Show Spectrum from 

the Image menu.
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Color Separation
In multi-color fluorescence imaging, up to four fluorescent dyes (fluoro-
phores) can be detected in a single image. Although each fluorophore 
exhibits its own characteristic emission spectrum, with a distinct maximum 
at specific wavelength, there may be some overlap (bleed-through) between 
the spectra of the different fluorophores.

The purpose of color separation is to identify these areas of emission spectra 
overlap by quantifying the proportion of each fluorophore that is known to 
overlap with the other fluorophores.

Image Analysis allows two methods for color separation: 

• Color separation by individual band selection

• Multi-band color separation

Multi-band color separation is a feature of the 1D-Gel analysis tools. See 
page 5-43.

Color Separation Theory
The following is a theoretical treatment of color separation for an image with 
two channels. Below are shown the spectra for an image from a lane with 
two channels. In this example, the pixels in region B of Channel 2, bleed 
through into area A of Channel 1 so the following type of color separation is 
performed.

Remove the background portion (N1, N2) from each channel.
5-30



Image Analysis Tools
1. Calculate the bleed-through rate:

Bleed-through rate Rab = Sa / Sb

2. The bleed through rate (Rab) is calculated for each pixel value in 
Channel 2 and the corresponding pixel value in Channel 1. This rate is 
multiplied by the image pixel values in Channel 2, and the result is sub-
tracted. Then the spectra in Channel 2 is as follows:

For any point on the image P (x,y), the image pixel value in Channel 1 is 
I1 and the image pixel value in Channel 2 is I2. After color separation, 
the pixel value in Channel 1 is:

I2' = I2-(I1-N1) x Rab, provided (I1-N1) > 0

3. The operations explained above for Channel 1 are then applied to 
Channel 2.
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Individual Band Color Separation
To separate the colors in an image using individual bands, you must select at 
least one non-overlapping, medium intensity, representative band of each 
color.

1. Click the Color Separation button or choose Color Separation 

from the Image menu.
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The Color Separation window is displayed.

2. Choose a channel from the Selected Fluorophore drop-down list box, 
and select a color.

Note In the Blend mode, the color associated with each channel 
appears in the box adjacent to it.

3. In the Whole Image window, move the Zoom Cursor to an area with 
medium intensity bands of that color.

4. In the Zoomed Area window, pick a band of medium intensity that 
matches the color, but does not overlap any other band. Surround the 
band with the Selection Cursor. Make the Selection Cursor larger than 
the band to include a portion of the image background.
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5. Click the Set button to make the color of the selected band represent the 
fluorophore. Image Analysis calculates the percent overlap between the 
selected fluorophore and each of the other channels. The percentages 
are displayed in the Emission Overlap fields. 

• You can click the Preview button at any time to test the color 
separation process.

• Click the Original button to revert to the original color settings.

6. Use one of the other channels in the Selected Fluorophore list.

7. Repeat this process for each of the remaining channels.

8. If the Color Separation parameters are to be used again in the future, 
click the Template... button. Click Create New... and assign the template 
a unique name.

9. When you are satisfied with the color settings, click OK.

10. If you want to remove the color separation, uncheck the Show Color-
Separated Images checkbox in the Image Setting dialog box. You can 
now repeat the color separation process.

Whole Image window

Selection cursor

Zoomed Area window

Zoom cursor
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Using a Color Separation Template
To perform this function a previously created Color Separation template 
must have been saved. 

1. Click the Color Separation button or choose Color Separation... 

from the Image menu. 

2. Once the Color Separation window has opened click the Template... 
button. The Template dialog box is displayed.

3. Select a template, then click the Apply button.

4. Click Close.

5. Click OK. The selected Color Separation template is applied to the new 
image. 

Modifying Color Separation Results
On some gel images, the color separation process can result in over-subtrac-
tion of a dye that has minimal bleed-through signal.

For example, a gel image might contain three dyes: tetramethyl rhodamine, 
carboxy-x-rhodamine, and fluorescein. The two rhodamine derivatives have 
overlapping emission curves, but fluorescein has minimal overlap with the 
other two dyes. The following procedure explains how to exclude the non-
overlapping dye, fluorescein, from the color separation process.

1. In the Image Setting dialog box, turn off the Show color-separated 
images option. 

When the option is off, the checkbox is empty.

2. Click the Color Separation button or choose Color Separation... 

from the Image menu.

3. Choose one of the overlapping dyes (carboxy-x-rhodamine) from the 
Selected Fluorophore drop-down list.

4. In the Target Channel section, enter a zero (0) in both the Background 
and Percent entry fields for the fluorescein channel.

5. In the Mode section, click Preview to examine the new values in the 
Whole Image window and Zoom window. You may see a slight color 
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change.

6. In the Selected Fluorophore list, use the drop-down list to choose the 
second overlapping dye (tetramethyl rhodamine).

7. Enter a zero (0) in both the Background and fluorescein Percent entry 
fields.

8. Preview the color separation. 

If you are satisfied with the results, click OK on the Color Separation 
box. When the message “Create the Separated Images this time?” 
appears, click OK again.

9. If you want to remove the color separation, uncheck the Show Color-
Separated Images checkbox in the Image Setting dialog box. You can 
now repeat the color separation process. 

Transparent Background
You can choose to make the background of an image transparent and posi-
tion it over another image to compare bands.

To make the background of an image transparent, select Transparent Back-
ground from the Image menu.
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1D-Gel menu and Tools

1. Click the New Project button or choose New Project from the 

File menu.

2. Choose New 1D-Gel Experiment from the Project menu. 

The 1D-Gel Experiment window, Image Setting dialog box, 1D-Gel 
menu and its corresponding tool bar appear.
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Tool Description

Set Marker Displays Marker Setting window.

Volume Calculation Performs a volume calculation.

Overlay Trace Displays new overlay trace of selected 
lanes.

Open Spreadsheet Displays spreadsheet.

Preferences Displays Preferences window.

Lane Template Displays Lane Template dialog box

Open Standard Curve Displays standard curve.

Quantification Setting Displays Quantification Setting window.

Multi-Band 
Color Separation

Displays Multi-Band Color Separation win-
dow.

Open Spreadsheet

Overlay Trace

Volume Calculation

Set Marker

Preferences

Open BP Curve

Quantification Setting

Multi-Band Color Separation
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Tool Description

Select Selects objects.

Lane Selection Defines a single lane.

Multiple Lane Selection Defines multiple adjacent lanes.

Lane Alignment Aligns lanes with migration lines.

Automatic Lane Fitting Automatically adjusts lane boundaries.

Lane Template Creates a template for lane definition.

Automatic Band Detection Detects selected bands automatically.

Delete Band Delete all bands in the selected lanes.

Band Edit Add, edit, or delete bands.

Lane Selection Tool

Multiple Lane Selection Tool

Band Edit

Lane Alignment

Lane Template

Select Tool

Automatic Lane Fitting

Delete Band
Automatic Band Detection
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Tool Description

Show/Hide Lanes Toggles display of lane boundary lines.

Show/Hide 
Band Information

Toggles display of band information, e.g., 
OD,MM, Bp value.

Show/Hide 
Comments

Toggles display of label information entered 
in spreadsheet.

Lane Style Toggles among different display options: 
center line with lane borders, center lines 
only, lane boundaries only, and lane display 
off.

Band Style Toggles among the different band styles: 
band display off, peak and range bands dis-
played, and only peak bands displayed.

Show/Hide Comment

Show/Hide Band Information

Show/Hide Lanes

Lane Style

Band Style
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Multi-Band Color Separation 
In a 1D-Gel Experiment, Image Analysis lets you perform separation of all 
colors simultaneously using multiple bands within a lane. The colors 
assigned to the bands collectively constitute a Multi-Band Separation Param-
eter Set, which is used to calculate the spectral overlap between the 
individual fluorophores.

Band Selection Parameters
Before performing multi-band color separation can be performed, you assign 
values for the Band Selection Parameters, which define the criteria for calcu-
lating the background, band area, and overlap between bands in a lane.

1. Choose New 1D-Gel Experiment from the Project menu. 

The 1D-Gel Experiment window, Image Setting dialog box, 1D-Gel 
menu and its corresponding tool bar appear.

2. Click the Preferences button or choose Preferences... from the 

1D-Gel menu.

3. Click the Multi-Band Color Separation tab. This filecard displays the 
default Band Selection Parameter set.

4. Try these settings and, if necessary, adjust them for different gels:

• Overlap = 0.0 mm

• Band Area = 0.1 mm

• Background Area 1 = 0.5 mm

• Background Area 2 = 0.5 mm

• Background % = 100%

Note If you plan to use these parameter settings in the future, it is nec-
essary to save a template with a unique name.
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Overlap.  Specifies the width of the band used in the area calculation when 
checking for band overlap. 

• If this Overlap value is 0.0 mm, the overlap will be the width 
detected by the Auto Band tool.

• If there is no overlap, the band area is the total that is calcu-
lated by the Auto Band tool.

• When the Overlap value (X) is greater than 0 mm the width 
used to calculate the area will -X to +X from the peak maxi-
mum.

• Overlap values may range from 0-99.9 mm with a minimum 
increment of 0.1 mm.
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Band Area.  Specifies the area that is used to calculate the volume for color 
separation. 

• If this Band Area value is 0 mm, the band area will be the area 
detected by the Auto Band tool. 

• If the Band Area value (X) is greater than 0 mm the band area 
will be -X to +X from the peak maximum.

• Band Area values may range from 0 to 99.9 mm with a mini-
mum increment of 0.1 mm.
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Background Area 1.  The area directly adjacent to either side of the band of 
interest that is used in the background calculation.

Background Area 2.  The area between bands of interest that is used in the 
background calculation.

Background %.  Specifies the correction value for the calculated back-
ground value. This Background % value should range from 1 to 100%.

Multi-Band Color Separation Window
To use the multi-band color separation window, you must select a lane 
containing a minimum of one medium intensity band of each color.

1. Find a portion of a lane containing a minimum of one non-overlapping 
band of each color. 

Note Two or more bands of each color is recommended.

2. Click the Lane Selection Tool button or choose 1D-Gel > Tool > 

Lane Selection. Drag down and then across that portion of the lane.

3. Click the Automatic Band Detection button or choose 1D-Gel > 

Function > Auto Band. 

Note Auto Band detects bands in all channels. To view the detected 
bands in a channel, select the channel in the Image Setting 
dialog box. See Displaying Detected Bands on page 5-13.
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4. After Image Analysis has automatically detected the lane, click the 

Multi-Band Color Separation button or choose Multi-Band Color 

Separation... from the 1D-Gel menu. Using the Band Selection param-
eters, Image Analysis assigns a color to each band, and the Multi-Band 
Color Separation window is displayed.

Magnification

Lane Window

Lane Selector
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Lane Window.  The Lane window displays all detected bands and a spec-
trum trace of the selected lane. The color of the Detected Band number 
indicates the color assigned by Image Analysis.

Magnification Selector.  To view the Lane window at a higher magnifica-
tion, select a desired value from the drop-down list box.

5. If you are not satisfied with the separation of the colors, you can adjust 
the Multi-Band Color Separation preferences. Click the Set Multi-Band 
Parameters... button, and change the parameter values. When you click 
OK, the colors are automatically separated according to the new values.
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6. On the right side of the window the Status Edit Sheet displays the 
detected band numbers.

• If you want to use the colors assigned by the Multi-Band Color 
Separator, click the Copy ==> button.

• If you want to load a previously saved Multi-Band Separation 
template, click Template.... Select a template, and then click 
Apply. The detected bands appear in the Status Edit Sheet.

7. Review each band in the Status Edit Sheet, verifying that the assigned 
colors are representative of the colors viewed in the gel image. 

Typically, the Multi-Band Color Separator accurately selects bands and 
assigns colors to them. In a rare instance, you might want to edit the 
bands displayed.

8. If you want to change the color or status of a band, click its row in the 
Status Edit Sheet. The Status Edit Sheet toolbar is activated.

Detected Band 
Numbers

Status Edit Tools
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• If the band was not assigned the appropriate color, click the 
appropriate color. The new color is displayed.

• If the band is overlapped by another band, click Overlap. The 
band is grayed out. 

• If you do not want to use the band, click None. The band is de-
selected and no color is displayed.

• If you have applied a template to the Status Edit Sheet and the 
band is not listed in the template, click Not Band. The band is 
deselected and the color list is shifted down. 

• If you do not want to use the band, click Skip. The Detected 
Band numbering skips the band.

Any band that has an Overlap, None, Not Band, or Skip status is not 
used for the multi-band color separation.

Tool Description

Band Colors Designates band color for the selected band.

None No color is assigned. Excludes band from multi-
band color separation.

Overlap Overlapped band. Excludes band from multi-band 
color separation. 

Not Band Band is not listed in template. Color list is shifted 
down.

Skip The Detected Band numbering skips the band.

None

Not Band

Skip

Overlap

Band Colors
5-50



Image Analysis Tools
9. If this Multi-Band Separation Marker is to be used in the future (i.e. 
Controls such as K562, 9947A, etc.), click the Template... button. Click 
Create New... and assign it a unique name. 

10. Once the bands have been verified, then click OK. The Color Separation 
window is displayed with the bleedthrough values that were calculated 
during the multi-band color separation.

11. Click Preview. Image Analysis performs the multi-band separation on 
the images in the Color Separation windows.

12. If the Color Separation parameters are to be used again in the future, 
click the Template... button and give the parameter set a unique name.

13. Click OK. Image Analysis creates a set of color separated images, each 
channel displaying only the signal from a single dye.

14. If you want to remove the color separation, uncheck the Show Color-
Separated Images checkbox in the Image Setting dialog box. You can 
now repeat the color separation process.

None
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Indicating Lanes
To analyze the data in a lane, the lane must first be defined with lane bound-
aries. Image Analysis automatically numbers each defined lane. Any data 
outside the lane boundaries are not included in the analysis. You can define 
single lanes or multiple lanes in sequence. Adjustment to lane position, 
width and shape can be made after the lanes are set. You can also create a 
lane template for use on other gels.
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The Project window lists the lanes defined for each channel.

Defining a Single Lane
To define a single lane:

1. Click the Lane Selection Tool button or choose 1D-Gel > Tool > 

Lane Selection.

2. Position the tool at a corner of the lane. Drag the cursor down to the 
opposite corner below the bottom migration line until the bands are con-
tained in the boundary. 

By default, Image Analysis displays a line down the center of the lane 
with a line on either side of the center defining the line width. When the 
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lane is selected, square edit handles are displayed on the lane lines.

Defining Multiple Lanes
You can define up to 255 adjacent lanes simultaneously. To define multiple 
sequential lanes:

1. Click the Multiple Lane Selection Tool button or choose 1D-Gel 

> Tool > Multiple Lane Selection. 

2. Position the tool above the top migration line at the corner of the first 
lane in a sequence of lanes.

3. Drag the tool below the bottom migration line to the opposite corner of 
the last lane in the sequence.
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4. Release the mouse. The Multiple Lane Setting dialog box is displayed.

5. Choose either Automatic Lane Detection and Fitting or Manual Input. 

If you choose Automatic Lane Detection, you can also choose to check 
the uniformity of the lanes.

Note We do not advise using automatic lane detection on lanes that 
are not clearly defined, such as lanes produced by sharks tooth 
combs.

If you choose Manual Input, enter the number of lanes in the sequence 
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then choose to either automatically determine the lane width or specify a 
width. Lane width may range from 1.0 to 100.0 mm, in 0.1-mm 
increments. 

6. Click OK. By default, Image Analysis displays a central line down each 
defined lane, with additional lines marking the lane width. When the 
lane is selected, square edit handles are displayed on the lane lines.

Displaying Lane Lines

The Lane Style button  toggles among different display options: 

center line with lane borders, center lines only, lane boundaries only, and 
lane display off. You can also choose lane styles from the 1D-Gel menu.

Editing a Lane Boundary
You can change the length, width, location, or angle of each defined lane. 

• Click the Select Tool button or choose 1D-Gel > Tool > Select, 

and then click on the lane. Six handles appear in the lane boundary. 
Handles also appear on the center line to adjust the lane boundaries for 
curved lanes.

There are several methods for editing the lane boundaries:
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• Place the cursor inside the lane, then drag the entire lane to the new 
location.

• The top center handle moves the position of the top boundary.

• The bottom center handle moves the position of the bottom boundary.

• An interior center handle shifts a segment of both side boundaries in the 
same direction.

• The side handles change the width of the lane. Drag a handle away from 
the center to make the lane wider; drag the handle toward the center to 
make the lane narrower.

• The corner handles change the lane width at the top or bottom of the 
boundary.

Copying and Deleting Lanes
• To make a copy of a selected lane, choose Duplicate from the Edit menu 

or press Ctrl + C on the keyboard.

• To delete a lane boundary, select the lane and press the Delete key.

Selecting Multiple Lanes
• Hold the Shift key as you click each lane. 

• To select all lanes, choose Select All from the Edit menu.

Lane Templates
Image Analysis allows you to save lane templates for future use. When 
preparing a lane template, it is recommended that the total length of each 
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lane extends beyond the lowest band in the gel to allow for increased migra-
tion distance in future gels. A lane template may be applied to any 1D-Gel 
experiment. 

Note When defining lanes for a template, it is suggested that the total 
length of each lane extend beyond the lowest band in the gel to 
allow for increased migration distance in future gels.

To create a lane template:

1. Click the Lane Template button or choose Lane Template... from 

the 1D-Gel menu. The Template dialog box is displayed.

2. Click the Add button. In the Lane Template Saving dialog box, deselect 
any lanes you do not want to save. 
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3. Click Save.

4. Assign a unique name when prompted, then click OK. 

5. The template name is listed with the number of saved lanes in brackets.
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To apply a lane template:

1. Click the Lane Template button or choose Lane Template... from 

the 1D-Gel menu, then select the template from the list.

2. Click Apply.
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Defining the Migration Area
You can adjust the top and bottom migration lines according to your labora-
tory's protocol. Some labs adjust the lines to encompass only the sample 
bands. Other labs set the markers above the top band in the internal ladder.

To adjusting the migration lines:

1. Click on a migration line. Each migration line has a handle at each end. 
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2. Click the left or right handle and drag it to change the angle of the 
migration line with respect to the migration direction axis of the gel. 
This is useful for gels that are misaligned, as in pulse field gels, where 
migration paths may deviate from the gel axis.

3. Click on any other point along the migration line and drag it up and 
down to move the migration line perpendicular to the gel.

HandleHandle
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Defining Bands
Once lane boundaries are defined, you can define bands in each lane. Use the 
Automatic Band Detection (Auto Band) tool to let Image Analysis automati-
cally assign bands. You can also use the Band Edit tool to manually define 
bands. The Project window lists all defined bands in each channel.

Automatic Band Detection
Band recognition depends on four parameters: Gradient Start, Gradient End, 
Duration, and Noise Level. Image Analysis can automatically detect bands 
by calculating the linear differential coefficient of the spectrum curve. It 
recognizes a signal peak as a band if the linear differentiation of the spectrum 
curve is greater than the value set for the gradient start, and continues to 
exceed that value across a specified duration. The gradient and duration 
values must also exceed a baseline, or noise level. 

You can adjust these four parameters in the Preferences dialog box. Values 
you enter in the Automatic Band Detection filecard depend on the quality of 
your gel. Heavily loaded and smeared lanes require more gradual gradients, 
longer gradient durations, and higher background settings. Gels with faint or 
partially hidden bands require more stringent settings for these parameters. 

Note For optimum band identification, adjust the gray level to 
improve band appearance in the 1D-Gel Experiment window. 
See Procedure on page 5-21.
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Automatic Band Detection Preferences.  

To set the Automatic Band Detection preferences:

• Click the Preferences button or choose Preferences... from the 

1D-Gel menu, and then click the Automatic Band Detection tab.
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Using the Auto Band Tool.  

To use the Automatic Band Detection tool: 

1. Choose Select All from the Edit menu to select all lanes for automatic 
detection, or hold down the Shift key and click the lanes. 

Name Description

Gradient Start Defines the minimum change in signal intensity 
necessary to signal the leading edge of the band. 
This parameter, combined with the duration 
parameter, defines the slope of the function. 

Gradient End Defines the minimum change in signal intensity 
necessary to signal the trailing edge of the band. 
This parameter, combined with the duration 
parameter, defines the slope of the function.

Duration Defines the gradient length in the leading and 
trailing edges of the band. 

Noise Level Defines the baseline signal intensity. Gradient and 
duration must exceed noise level if the signal is to 
be recognized as a band. Choose a value between 0 
and 255. Choose higher values for gels with dirty 
or “noisy” background. Choose lower values for 
clean or “quiet” gels. Evaluate the noise level of 
your gel by trying different Gray Scale Adjustment 
values (see Procedure on page 5-21).
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Click the Automatic Band Detection button or choose 1D-Gel > 

Function > Auto Band. 

2.
For each detected band, Auto Band creates a Band Start line, Band Peak 
line, and Band End line. The migration distance is also calculated.

3. Check the accuracy of the automatic detection. Switch from one to the 
other channel by selecting the desired channel on the Image Window 
Setting dialog box. See Image Setting Dialog Box on page 5-11.

4. Magnify the image to view individual bands more closely. If you still 
cannot view a detected band, increase the gamma level for the channel. 

5. If necessary, you can manually add, move, and delete band lines. See 
Manual Band Input on page 5-67.

6. To customize you auto band detection, adjust the Automatic Band 
Detection preferences, page 5-64.

Band Start line

Band End line

Band Peak line
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Manual Band Input
Bands that are faint, partially obscured, or highly smeared may not be recog-
nized by the Automatic Band Detection tool. You can manually add bands 
that have not been detected.

1. Double-click on the lane you want to edit. The lane is selected and the 

Band Edit button is activated.

2. Magnify the image with the Zoom tools to view the band.

3. Align the Band Edit cursor over the center of the band image.

4. Click on the band. Image Analysis places the band lines onto the band, 
and the cursor transforms into a two-headed arrow. Initially, the active 
(violet) band line is the Band End line.
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5. Drag the Band End line down to the desired position, then release the 
mouse button.

6. Go back and click on the group of band lines. The Band Start line 
becomes active. Drag the Band Start line up to the desired position, then 
release the mouse button.

Moving bands.  

1. Double-click on the lane you want to edit. The lane is selected and the 

Band Edit button is automatically selected.

2. Click on the band line to select it. The band line changes from yellow to 
violet.

3. Drag the band line to the new position.

Deleting bands.  

There are two methods to delete bands:

Area Selection method

1. Draw a rectangle around the bands you want to delete. 
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The edit handles for the bands are displayed.

2. Press the Delete key.

Note If you want to delete bands in multiple areas, hold down the 
Shift key while selecting the additional areas.

Band Edit Method

1. Double-click on the lane you want to edit. The lane is selected and the 

Band Edit button is automatically selected.

2. Click on any band line to select it. The band line changes from yellow to 
violet.

3. Press the Delete key. 

Hiding bands.  

The Show/Hide Band Information button and the 1D-Gel > View > Band 
Information menu item control the display of the band migration values and 
lane numbers.

Displaying band lines.  
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The Band Style button toggles among the different band styles: band 

display off, peak and range bands displayed, and only peak bands displayed. 
You can also choose a band style from the 1D-Gel menu.
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Standard Markers
Standard markers serve as reference points for base pair length calculations. 
You may load more than one marker in the same lane. You can load markers 
in sample lanes, and intersperse marker lanes with sample lanes. If you are 
using an internal standard (such as Promega's CXR Fluorescent Ladder), 
choose Layer and select the corresponding channel. After the bands have 
been detected and edited, the length of the fragments in each band can be 
calculated.

Registering Markers
To register markers in your gel:

1. Click the Marker Setting button or choose 1D-Gel > Marker....

A Marker Setting dialog box is displayed. The Marker Setting dialog 
box lists the defined lanes. In brackets adjacent to each lane is the 
number of defined bands. 
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Note This is a good time to again check the number of expected bands 
in each marker lane. Compare the number to the actual number 
of defined bands in the lane.

2. Select a channel and a marker mode from the drop-down list boxes. 
There are three marker modes:

Separate —markers are selected for each channel. The results based on 
markers for other channels are ignored.

Mix —selected markers are used to calculate the results for all channels.

Layer —markers are selected for each channel. The calculated results 
for the channels are layered.

3. Click on the lane numbers in the list that contain the same marker. To 
select more than one lane, hold down the Ctrl key, then click each lane.

4. Select the marker from the Marker list.

5. Click the Set Marker to >> button.

6. Continue this process for each marker or marker group.
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Note To deselect a marker lane, remove the checkmark adjacent to its 
lane number.

7. Click OK to complete the marker registration.

Importing and Exporting Markers
You can import a set of markers, including markers exported from the 
Macintosh FMBIO Analysis software, or export a set of markers.

To import a marker set:

1. Click the Import... button. The Open File dialog box is displayed.
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2. Select a marker set file, and click the Open button. The size markers are 
added to the BP Values list.

To export a set of markers:

1. Click the Export... button. The Save As dialog box is displayed.

2. Enter a name for the marker set, and click Save.
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Working with Marker Templates
You can edit an existing marker, add new markers, duplicate, rename, or 
delete markers.

Adding Marker Templates
To add new marker templates:

1. Click the Add button. The New Marker dialog box is displayed.

2. Enter the name of the marker template, then click OK.
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3. Select the new marker, then enter the length of the marker band in the 
BP field. 

4. Click Add. The new band length appears in the BP list.

5. Repeat this process for each band in the new marker.

Base Pair Standard Curve
Image Analysis automatically creates a standard curve using the base pair 
markers as a reference.

1. Click the Open BP Curve button or choose Open BP Curve from 

the 1D-Gel menu. The curve is fitted to the base pair values (Y-axis) 
versus Rf (X-axis). 
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You can also choose to use the Least Squares curve fitting:

1. Click the Preferences button or choose Preferences... from the 

1D-Gel menu, then click the Calculation tab.

2. Click on the Use Least Squares Method for bp calculation option to 
place a checkmark in the box.
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3. Click OK. The calculation is performed automatically.

4. Click the Open BP Curve button or choose Open BP Curve from 

the 1D-Gel menu. In addition to the base pair curve, the correlation 
coefficient is displayed.
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Calculating Volumes and Peak Heights
Image Analysis automatically calculates the volume (IOD) and/or peak 
height (OD) of each designated band. A standard curve is created based on 
the marker IOD values. These reference values are used to determine the 
concentration of each sample band. Once the peak area is defined, Image-
Analysis multiplies the area by the number of grayscale bits in that area to 
determine the volume. 

Note You cannot compare volume calculations until you have used 
the commands in the 1D-Gel menu to define bands. See 
Defining Bands on page 5-63. 

To select the Calculation parameters:

• Click the Preferences button or choose Preferences... from the 

1D-Gel menu, then click the Calculation tab.
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Background Value
The background value defines a cutoff value, in grayscale bits per pixel, 
below which signal will not be calculated. Specify the background value for 
each channel in your image.

Background of Gray Level Adjustment.  This option allows you to use the 
background cutoff threshold value for volume calculations. It is automati-
cally entered.

User Defined.  This option allows you to enter a background value.

Calculating Normalized Volume (IOD)
Image Analysis can subtract the background signal for more accurate volume 
(IOD) calculation. Use this feature with any of the four background types. 

Volume Calculation Types
Image Analysis offers four types of volume calculation. Each type offers a 
different method of defining the area of the selected peak relative to the 
background.

Type 1.   The area incorporates any signal that is greater than the background 
on either side of the selected peak. This gives the largest value of the four 
calculation types. Use Type 1 for bands or spots that are distinctly separated 
from others, or for quantifying isolated faint bands with signal intensities 
that are close to background value. 

Type 2.  The area incorporates any signal that is greater than the spectrum 
valleys on either side of the designated peak. The value of the deeper of the 
two valleys on either side of the peak is used as the local background value. 
Use Type 2 to quantify individual bands or spots that are packed in with 
others in a group.
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Type 3.  The peak is split and the lower of the two valleys is defined as the 
local background value. The area is defined as half of the peak, between the 
highest and the lowest signal. Use Type 3 volume to quantify border regions 
of spots or bands, where the signal fades into background.

Type 4.  Local background is defined by a line that connects the spectrum 
valleys at their lowest point on either side of the peak. The area incorporates 
signal above this line and below the peak. Use Type 4 calculation to deter-
mine relative volumes of adjacent bands or spots that are packed in with 
others in a group.

Setting Quantification Markers

1. Click the Quantification Setting button or choose Quantification 

Setting... from the 1D-Gel menu.

2. Select a channel from the drop-down list box.

3. Select a lane number containing standard markers from the drop-down 
list box. The defined bands in the lane appear in the list box.

4. Click on a marker band to highlight it, then enter a concentration value 
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in the field below the list box.

5. Click Enter. The value appears in the Concentration column.

6. Continue to enter concentration values for all marker bands.

7. Place a checkmark in the box next to each marker band you want to use.

8. Select a standard curve fit in the drop-down list.

Linear —straight line least squares regression

Second Order —second order curve least squares regression

Logarithmic —natural logarithms least squares regression

9. Select a straight line or logarithmic X-axis scale.

10. Click OK.

11. Click the Open Standard Curve button or choose Open Standard Curve 
from the 1D-Gel menu. The curve is fitted to the marker IOD values (Y-
axis) versus concentration (X-axis). 
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Volume Calculation
After the lanes, bands, and markers have been established, Image Analysis 
can compare the known markers to unknown sample bands. Using the 
markers as reference points, the volume (IOD), concentration, and fragment 
length of the sample bands is calculated.

• To initiate the analysis, click the Volume Calculation button or 

choose Volume Calculation from the 1D-Gel menu.

Displaying Results
You can display the results of the calculation in a spreadsheet and on the 
image.

To choose the variables to display:

1. Click the Preferences button or choose Preferences... from the 

1D-Gel menu, then click the Band Information tab.
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2. Select the variables to display.

To save your selections as a template:

1. Click the Template... button. The Template dialog box is displayed.

2. Click the Add... button, and type in a name for the template. The default 
name for the first template is info1.tmp, and each additional template is 
numbered sequentially.

3. Click OK, and then click Close.

Spreadsheet Display.  The results of the analysis are shown in a spreadsheet 
that can be exported. Image Analysis can display the OD, IOD, IOD%, Rf, 
base pair, concentration value or a user-defined label.

1. To display a spreadsheet of results, click the Open Spreadsheet but-

ton or choose Open Spreadsheet from the 1D-Gel menu. The 

Spreadsheet window is displayed, and the SpreadSheet menu appears in 

Variable Contents

mm Migration distance between the top migration line and band 
peak line.

OD Optical density of the peak fluorescent signal on the band 
peak line.

IOD Amount of fluorescent signal in a band. Band volume.

IOD% Band volume as a percentage of the total volume of all 
bands in the lane.

Rf Relative electrophoresis mobility. When the top migration 
line is 0% and the bottom migration line is 100%, it is the 
ratio of the band peak migration relative to the total length.

bp Fragment length in base pairs determined with standard 
markers. Enter numeric values.

Concentration Concentration determined with standard markers. Enter 
numeric values.

Label Enter any alphanumeric label or comment for a band.
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the menu bar.

2. Select a channel by clicking its tab at the bottom of the spreadsheet.

Each band is listed in order of migration distance. Image Analysis displays a 
set of band information columns for each lane.

Entering Spreadsheet Data.  You can enter and edit data in the base pair, 
concentration, and label fields.

1. Click on the field.

2. Enter the data.

Note Enter numeric values in the base pair and concentration fields. 
Enter alphanumeric values in the label field.

Band Information display.  In the 1-D Gel Experiment window, Image 
Analysis can display the OD, IOD, IOD%, Rf, base pair, concentration value 
or a user-defined label next to the band.

To display values in the 1D-Gel Experiment window: 

1. Click the Preferences button or choose Preferences... from the 

1D-Gel menu, then click the Band Information tab. Select the item you 
want to display. See page 6-6 for an explanation of these parameters.

2. Select the lanes. The information is displayed next to the band.
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The Show/Hide Band Information button or 1D-Gel > View > 

Band Information menu item toggles the display on and off.

Updating Spreadsheet Values
Changes you make to your 1D-Gel experiment may affect the values 
displayed in the spreadsheet. These changes include:

• Adding or deleting values

• Changing units of measurement

• Moving, adding, or deleting bands or lanes

Whenever you make these changes, you must be sure the corresponding 
values in the spreadsheet are updated.
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To update spreadsheet values after changes in the 1D-Gel Experiment 
window:

• Click the Volume Calculation button or choose 1D-Gel > Volume 

Calculation.

Exporting the Spreadsheet
You can save the spreadsheet as a tab-delimited text file for export to other 
programs, such as Microsoft Excel and Microsoft Word.

To export a spreadsheet:

1. Click the Open Spreadsheet button or choose Open Spreadsheet 

from the 1D-Gel menu.

2. Choose Export... from the SpreadSheet menu.

3. In the Save As dialog box, select a location for the file, and then enter a 
unique name.

4. Click Save.
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Overlay Trace
In an Overlay Trace window, you can compare the spectrums of different 
lanes. This window also allows you to edit a band while viewing the graphic 
trace of its signal. To use Trace Overlay, you must first use the1D-Gel anal-
ysis tools to define one or more lanes in an 1D-Gel Experiment window. See 
Analyzing 1D-Gels on page 6-6. 

Note Your images must have defined lanes, but creating an overlay 
trace does not require previously defined bands. 

Overlay Trace Window
1. Open one or more 1D-Gel Experiment windows that have defined lanes. 
1. Select the lane or lanes of interest by clicking the Arrow cursor on the 

desired lane. Shift-click to select more than one lane.

2. A maximum of 16 lanes may be converted into Lane Trace format at 
one time.

3. Click the New Overlay Trace button or choose New Overlay 

Trace from the 1D-Gel menu. The Overlay Trace window is displayed 
and the Trace menu appears in the menu bar.
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Vertical Zoom tools.  You can proportionally increase or decrease the 
vertical range of all traces in the window simultaneously.

Note Use the Image Zoom tools to control the vertical magnification. 
See page 5-7.

Drawing tools.  You can draw and type text on your overlay trace. 

1. Click the Drawing Tool button or choose Draw from the Trace 

menu. The Drawing Tool bars become active and the Draw menu 
appears in the menu bar. 

2. Use the Drawing tools to draw and type text on the overlay trace. See 
Chapter 8, Drawing Tools.

3. When you have finished, choose Save Project... from the File menu. An 
Overlay Trace icon is added to the 1D-Gel Experiment tree.

Tool Description

Zoom In Vertically Magnify in vertical direction.

Zoom Out Vertically Reduce in vertical direction.

Drawing Use drawing tools for Overlay Trace window.

Overlay Trace Setting Displays Overlay Trace Setting window.

Zoom In Vertically

Zoom Out Vertically

Drawing Tool

Overlay Trace Setting
5-92



Image Analysis Tools
Overlay Trace Setting Window
To display the Overlay Trace Setting dialog box, click the Overlay Trace 

Setting button or choose Setting... from the Trace menu.

Item Description

Channel Place a checkmark in the box next to each channel you 
want to display. You can also select channels in the 
Image Setting dialog box.

Lane Place a checkmark in the box next to the lane you want to 
display.
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Exporting Lane Trace Data
In some cases it may be desirable to export the Lane Trace data from Image 
Analysis into an Excel spreadsheet. The data will be displayed in the 
spreadsheet as migration distance (mm) and intensity (OD).

1. Define the desired lanes in the images.

2. View the lane traces if desired.

3. The lane trace data can be exported to a folder as a set of Microsoft 
Excel spreadsheets by choosing Export Lane Trace... from the 1D-Gel 
menu. The Select Folder dialog box is displayed.

View Mode Separated (On Lane) —The spectra for each lane is 
shown. One spectral graph is shown for each lane, and 
spectra from all channels are shown.

Separated (On Channel) —One spectral graph shows one 
channel, and all lanes are shown overlapped.

Overlapped —The spectra of all channels are shown 
overlapped.

Lane Image Show —Select the show lane image/hide image check 
box.

Width —Enter the width of the lane image.

Spectrum Enter the width of the spectral graph.

Show/Hide Y (Rf) axis.

Show/Hide X (Value) axis.

Adjustment Margin —Enter the spacing for lanes and spectra.

V Increment —Enter the units for magnification/
reduction for the overlay trace. To increase magnifi-
cation, enter a higher value.

Item Description
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4. Specify the folder to store the files, and click Select.

Note The window will automatically choose the Image Analysis program 
folder as the default folder and create filenames using previously 
entered information. (i.e. “Lane #. Project Name.#CH.csv”).

5. Open the desired file in Microsoft Excel.

6. The spreadsheet displays the migration distance (mm) and the intensity 
(OD) of the trace.
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Printing
Image Analysis allows you to print an image, experiment, standard curve, 
spreadsheet, or overlay trace. You can also customize the print job in several 
ways.

To customize a print job:

• Choose Print Setup from the File menu. The Page Setup window is 
displayed.
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Print Setup.  To set the print options, click the Options... button.

Print Preview.  To preview your print job, click Print Preview.

Printing.  To begin printing, click the Print button or choose Print 

from the File menu.

Feature Description

Header, Footer, Align Left, Align 
Center, Align Right 

%n =project name

%d =current date

%t =current time

%p =page number

%P =total number of pages

Margins Top, Left, Right, Bottom, Header, 
Footer

Scaling Adjust to —Enter scaling (whole 
numbers)

Fit to a page —Scaling determined by 
paper size, e.g. if the figure is reduced 
if it is larger than the page size

Fine Adjustment Horizontal and vertical (50 - 150%, 
real numbers).
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Batch Analysis
A set of templates can be saved and loaded for use in a different analysis. 
There are four sections:

• Gray Level Adjustment

• Band Settings

• Lane Template

• Color Separation

Procedure
1. Choose Batch Control from the 1D-Gel menu. The 1D Batch Control 

dialog box is displayed. 
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Item Description

Gray Level 
Adjustment

Select a template from the drop-down menu. 

Note Special care should be given to match the 
template with the correct channel.

Band Setting Select the templates for the Band Selection Parameters 
and Band Information from the drop-down menus.

Select the calculation type from the drop-down menu.

Lane Template Select the Lane template from the drop-down menu. If 
you want to use auto lane detection, click the On radio 
button to select it.

Color Separation Choose the Conventional or Multi-Band separation 
method.

If you choose the Conventional method, select a template 
from the drop-down menu.

If you choose the Color Separation method, select a 
Color Separation template and a Parameters template 
from the drop-down menus.
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2. Choose the templates and enter the appropriate parameters in the fields.

3. If you want to use this set of Batch Control settings again, click on the 
Save/Load Setting... button. The Template dialog box appears.

4. Click the Add... button, and enter a name for the Batch Control template.

5. Alternatively, if you want to Load a previous Batch Control template, 
select the template by clicking on it’s filename in the list box. Then click 
the Apply button.

6. When you have finished entering the parameters, click OK in the Batch 
Control dialog box. Image Analysis processes the 1D-Gel experiment.
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6 1D-Gel Analysis
One-dimensional (1D) analysis entails studying the migration patterns of 
molecules that have been separated and spread out in one linear dimension 
by the passage of a voltage through a gel. Image Analysis provides a versa-
tile assortment of display options and tools for 1D gel analysis.

Chapter 5, Image Analysis Tools, describes how to use Image Analysis tools 
to create single and multi-color image project files. This chapter describes 
how to use the 1D-Gel tools to analyze these single- and multi-color images. 
The following summaries are provided:

• Single-color analysis example. See page 6-8.

• Multi-color analysis example. See page 6-16.

You can also use the Drawing tools to enhance the results of 1D analysis. See 
Chapter 8, Drawing Tools.

Note The procedures and parameters settings contained in this chapter 
are recommendations that can be modified to achieve the best 
results for your images.
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1D-Gel Menu and Tools
1. Choose New 1D-Gel Experiment from the Project menu. 

The 1D-Gel Document window, Image Setting dialog box, 1D-Gel 
menu and its corresponding tool bar appear.
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Tool Description

Set Marker Displays Marker Setting window.

Volume Calculation Performs a volume calculation.

Overlay Trace Displays new overlay trace of selected 
lanes.

Open Spreadsheet Displays spreadsheet.

Preferences Displays Preferences window.

Lane Template Displays Lane Template dialog box

Open Standard Curve Displays standard curve.

Quantification Setting Displays Quantification Setting window.

Multi-Band 
Color Separation

Displays Multi-Band Color Separation win-
dow.

Open Spreadsheet

Volume Calculation

Set Marker

Preferences

Open Standard Curve

Quantification Setting

Multi-Band Color Separation

Overlay Trace
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Tool Description

Select Select objects.

Lane Selection Define a single lane.

Multiple Lane Selection Define multiple adjacent lanes.

Lane Alignment Aligns lanes with migration lines.

Automatic Lane Fitting Automatically adjusts lane boundaries.

Lane Template Saves all lanes on image.

Automatic Band Detection Autoband selected lanes.

Delete Band Delete all bands in the selected lanes.

Band Edit Add, edit, or delete bands.

Lane Selection Tool

Multiple Lane Selection Tool

Band Edit

Lane Alignment

Lane Template

Select Tool

Automatic Lane Fitting

Delete Band
Automatic Band Detection
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Tool Description

Show/Hide Lanes Toggle display of lane boundary lines.

Show/Hide 
Band Information

Toggle display of band information.

Show/Hide 
Comments

Toggle display of label information entered 
in spreadsheet.

Lane Style Toggle among different display options: cen-
ter line with lane borders, center lines only, 
lane boundaries only, and lane display off.

Band Style Toggle among the different band styles: band 
display off, peak and range bands displayed, 
and only peak bands displayed.

Show/Hide Comment

Show/Hide Band Information

Show/Hide Lanes

Lane Style

Band Style
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Analyzing 1D-Gels
With the tools and commands in the 1D-Gel menu, you can identify lanes 
and bands of interest. Image Analysis then calculates the following band 
parameters: 

• mm—migration distance of the band from the top limit line, in 
millimeters

• OD— optical density of the peak fluorescent signal, relative to a 
standard marker

• IOD—average band volume, based on the fluorescent signal intensity

• IOD%—band volume as a percentage of the total volume of all bands in 
the lane

• Rf—relative electrophoretic mobility

• bp—estimated size of the fragment in basepairs (DNA only)

• concentration

Summary of Analysis Steps
 Image analysis of a 1D gel consists of these steps:

1. Open project. 

2. Create 1D-Gel analysis.

3. Adjust gray level. 

4. Set lanes. 

5. Set migration lines. 

6. Perform color separation (if required). 

7. Review image.

8. Autoband. 

9. Set markers. 

10. Calculate base pairs. 

11. View results. 
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Single-Color Experiment Flowchart

Set Marker

Open Project

Create 1D-Gel 
Analysis

Adjust Gray Level

Set Lanes

Set Migration Lines

Autoband

Calculate Base Pairs

Export Spreadsheet  
to STaR Call
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Single-Color Experiment Procedure
The following section is a summary of steps used in the analysis of a single 
color image. While this summary utilizes diagrams from a single color mul-
tiplex, the process is also applicable to other types of single color images 
including gels stained with ethidium bromide.

Create a New Project (page 5-3).  

1. In the File menu, click the New Project button or choose New 

Project. A new Project window is displayed.

2. In the Project menu, choose Add Image..., then select a file that contains 
a digital image of a 1D gel. Image Analysis adds an icon representing 
the image file to the project tree. 
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1D-Gel Analysis
The Image menu appears in the menu bar and its corresponding tool 
buttons become active.

Create 1D-Gel analysis (page 5-14).  

• Choose New 1D-Gel Experiment from the Project menu. 

The 1D-Gel Document window, Image Setting dialog box, 1D-Gel 
menu and its corresponding tool bar appear.

Adjust Gray Level. (page 5-14).  

1. Click the Gray Level Adjustment button or choose Gray Level 

Adjustment from the Image menu. The Gray Level Adjustment window 
is displayed. 
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FMBIO®
1. In the Full Image Display, drag the Zoom Cursor to a region containing 
average intensity bands/background. If necessary, adjust the size of the 
Zoom Cursor to include the desired area. 

2. The area appears in the Zoom Display.

3. In the Zoom Display, surround a band with the Selection Cursor.

4. Move the Selection Cursor to a background area away from the band, 
then click the Background button. The calculated Background cutoff 
threshold is applied to the Full Image and Zoom windows and the values 
appear in the Background Percent and Background Value boxes.

5. Use the High Signal and Background threshold marker lines in the 
histogram to adjust the gray scale range.
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1D-Gel Analysis
6. When you have finished, click OK.

Set Lanes (page 5-52).  

1. Click the Multiple Lane Selection Tool button or choose 1D-Gel 

> Tools > Lane Selection. 

2. Create a rectangle surrounding the group. Position the tool above the top 
migration line at the corner of the first lane in a sequence of lanes.

3. Drag the tool below the bottom migration line to the opposite corner of 
the last lane in the sequence. 

4. Release the mouse. The Multiple Lane Setting dialog box is displayed.

5. Choose either Automatic Lane Detection and Fitting or Manual Input. 

If you choose Automatic Lane Detection, you can also choose to check 
the uniformity of the lanes.

If you choose Manual Input, enter the number of lanes in the sequence 
then choose to either automatically determine the lane width or specify a 
width. Lane width may range from 1.0 to 100.0 mm, in 0.1-mm 
increments. 

6. Click OK. By default, Image Analysis displays a central line down each 
defined lane, with additional lines marking the lane width. When the 
lane is selected, square edit handles are displayed on the lane lines.

7. If any of the lanes need adjustment, click the lane to highlight it and 
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move it to the correct position. The Lane Style button toggles 

among different display options: center line with lane borders, center 
lines only, lane boundaries only, and lane display off. You can also 
choose lane styles from the 1D-Gel menu.

Set Migration Lines (page 5-52).  

• Adjust the top and bottom migration lines according to the user’s 
laboratory protocol. 

Autobanding (page 5-63).  

With the lanes selected and the migration lines adjusted, autoband determi-
nation can be performed.

1. Select Normalized Volume (IOD) and choose Type 4 as the calculation 
type in the 1D-Gel Preferences dialog box.

2. Click the Automatic Band Detection tab to edit the autobanding 
parameters.

3. Try these settings and adjust the settings as needed for different gels:

Gradient Start = 2.5
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1D-Gel Analysis
End = 2.5

Duration = 0.2

Noise Level = 20

4. Choose Edit > Select All to select all the lanes. 

5. Click the Automatic Band Detection button or choose 1D-Gel > 

Function > Auto Band. You might need to adjust the Image Analysis 

automatic band calls. The Band Style button toggles among the 

different band styles: band display off, peak and range bands displayed, 
and only peak bands displayed. You can also choose a band style from 
the 1D-Gel menu.

6. Click the Band Edit button or choose 1D-Gel > Tool > Band Edit, 

then use the cursor to place bands.

Set Marker (page 5-71).  
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1. Click the Quantification Setting button or choose Quantification 

Setting... from the 1D-Gel Menu. 

Select the standard curve fit from the drop-down list box. Logarithmic is 
the correct standard curve fit for most applications.

2. Click the Marker Setting button or choose Set Marker... from the 

1D-Gel menu.

3. Highlight the lanes containing the marker by holding down the Shift key 
while clicking on them with the mouse. Select the correct marker from 
the Template list, then click Adopt. The selected marker appears next to 
each lane in the list.

Calculate Base Pairs (page 5-80).  
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1D-Gel Analysis
1. Click the Volume Calculation button or choose Volume 

Calculation from the 1D-Gel menu to calculate base pair sizes in 
reference to the assigned marker. 

2. Click the Open Spreadsheet button or choose Open Spreadsheet 

from the 1D-Gel menu to view the table of base pair values for each 
layer. Click the tabs at the bottom of the window to switch among 
channels. 

3. Choose Export from the SpreadSheet menu to save the spreadsheets as 
comma-delimited text files that can be exported to STaR Call ™.
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Multi-Color Experiment Flowchart
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1D-Gel Analysis
Multi-Color Experiment Procedure
The following section is a summary of steps used in the analysis of a multi-
color image. While this summary uses diagrams from the Promega 1.1 
Powerplex, the process is also applicable to other types of multi-color 
images.

Create a New Project (page 5-3).  

1. In the File menu, choose New Project. A new Project window is 
displayed.

2. In the Project menu, choose Add Image..., then select a file that contains 
a digital image of a one-dimensional gel. Image Analysis adds an icon 
representing the image file to the project tree.
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3. The Image menu appears in the menu bar and its corresponding tool 
buttons become active.

4. Click the Marker Setting button or choose Set Marker... from the 

1D-Gel menu.
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1D-Gel Analysis
5. If you are using an internal lane standard (such as Promega’s CXR), 
select the channel used to scan the internal lane standard, and then select 
Layer from the Marker Mode drop-down list box. 

6. If an internal lane standard was not used, select the channel used to scan 
the any standard markers on the gel, and then select Separate from the 
Marker Mode drop-down list box.

Create 1D-Gel analysis (page 5-14).  

• Choose New 1D-Gel Experiment from the Project menu. The 1D-Gel 
Document window, 1D-Gel menu, and its 1D-Gel tool bar appear.
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Adjust Gray Level. (page 5-14).  

1. In the Image Setting dialog box, select Mono as the display mode.

When a black and white image is displayed, the user is ready to adjust 
the grayscale.

2. Click the Gray Level Adjustment button or choose Gray Level 

Adjustment from the Image menu. The Gray Level Adjustment window 
is displayed. 

3. In the Full Image window, drag the Zoom Cursor to a region containing 
average intensity bands/background. If necessary, adjust the size of the 
Zoom Cursor to include the desired area. The area appears in the Zoom 
window.

4. In the Zoom window, surround a band with the Selection Cursor, then 
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1D-Gel Analysis
click the High Signal button. The new High Signal cutoff threshold is 
applied to the Full Image and Zoom windows and the values appear in 
the High Signal Percent and Background Number boxes.

5. Move the Selection Cursor to a background area away form the band, 
and then click the Background button. The new Background cutoff 
threshold is applied to the Full Image and Zoom windows and the values 
appear in the Background Percent and Background Number boxes.

• All regions of the image with gray level values below these Back-
ground values will appear white.

• All regions of the image with gray level values above the High Sig-
nal values will appear black.

• All other elements of the image that fall within the range between 
High Signal and Background values appear as shades of gray. 

6. If these gray level adjustment parameters is to be used again in the 
future click the Template button and assign a unique name. 

7. Repeat the gray scale adjustment for each channel. Switch to a different 
channel by placing a checkmark next to it in the Image Setting dialog 
box. 

8. Click OK to apply these values to the image.

Perform Color Separation (page 5-30).  

In this example, color separation is performed using the Multi-Band Color 
Separation window. You can also use the Color Separation window (see Indi-
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vidual Band Color Separation on page 5-32), or a previously saved template 
(see Multi-Band Color Separation on page 5-43).

You must select a lane containing at least one non-overlapping, medium 
intensity, representative band of each color. 

1. Select Blend as the display mode. 

2. Review the Multi-Band Separation parameters. Click the Preferences 

button or choose Preferences... from the 1D-Gel menu, then click 

the Multi-Band Color Separation tab.

3. Try these settings and, if necessary, adjust them for different gels:

• Overlap = 0.0 mm

• Band Area = 0.1 mm

• Background Area 1 = 0.5 mm

• Background Area 2 = 0.5 mm

• Background % = 100%
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1D-Gel Analysis
4. Click the Lane Selection Tool button or choose 1D-Gel > Tool > 

Lane Selection. 

5. Find a lane that contains a minimum of one band of each color. 

6. Position the tool at a corner of the lane above the top migration line. 
Drag the cursor down to the opposite corner below the bottom migration 
line until the bands are contained in the boundary. 

7. Click the Automatic Band Detection button or choose 1D-Gel > 

Function > Auto Band. 

8. After Image Analysis has automatically detected bands in the lane, click 

the Multi-Band Color Separation button or choose Multi-Band 

Color Separation... from the 1D-Gel menu. 

Using the Band Merging parameters, Image Analysis assigns a color to 
each band, and the Multi-Band Color Separation window is displayed. 
The color of the Detected Band number indicates the color assigned by 
Image Analysis. The numbers of the detected bands appear in the Status 
Edit Sheet.
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9. If you are not satisfied with the separation of the colors, adjust the 
Multi-Band Color Separation preferences. Click the Set Multi-Band 
Parameters... button, and change the parameter values (see Band 
Selection Parameters on page 5-43). When you click OK, the colors are 
automatically separated according to the new values.

10. After the Multi-Band Color Separation window is displayed, click the 
Copy>> button or load a previously generated Multi-Band Separation 
Marker template. The band colors appear in the Status Edit Sheet.

Typically, the Multi-Band Color Separator accurately selects bands and 
assigns colors to them. In a rare instance, you might want to edit the 
bands displayed.

11. Click the row of the band you want to edit. The Status Edit buttons are 
activated.

Magnification

Lane Window

Lane Selector
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1D-Gel Analysis
• If the band was not assigned the appropriate color, click the appro-
priate color. The new color is displayed.

• If the band is overlapped by another band, click Overlap. The band 
is grayed out. 

• If you do not want to use the band, click None. The band is de-
selected and no color is displayed.

• If you have applied a template to the Status Edit Sheet and the band 
is not listed in the template, click Not Band. The band is deselected 
and the color list is shifted down. 

Detected Band 
Numbers

Status Edit Tools

None

Not Band

Skip

Overlap

Band Color
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• If you do not want to use the band, click Skip. The Detected Band 
numbering skips the band.

Any band that has an Overlap, None, Not Band, or Skip status is not 
used for multi-band color separation.

In this example, Band 5 is an overlapping signal, so click the band row 
to select it and then click the None button from the tool bar.

In addition, Band 2 is actually two overlapping bands, so click Band 2 to 
select it and then click the Overlap button.
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1D-Gel Analysis
12. If this Multi-Band Separation Marker is to be used in the future (i.e. 
Controls such as K562, 9947A, etc.) click the Template button and 
assign the template a unique name. 

13. Once the band colors have been verified, click OK. The Color 
Separation window is displayed.

14. Click OK to perform the color separation. Image Analysis creates an 
image for each channel that displays only the signal from a single dye.

Set Lanes (page 5-52).  

1. Click the Multiple Lane Selection Tool button or choose 1D-Gel 

> Tool > Multiple Lane Selection. 

2. Create a rectangle surrounding the group. Position the tool above the top 
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migration line at the corner of the first lane in a sequence of lanes.

3. Drag the tool below the bottom migration line to the opposite corner of 
the last lane in the sequence.

4. Release the mouse. The Multiple Lane Setting dialog box is displayed.

5. Choose either Automatic Lane Detection and Fitting or Manual Input. 

If you choose Automatic Lane Detection, you can also choose to check 
the uniformity of the lanes.

If you choose Manual Input, enter the number of lanes in the sequence 
then choose to either automatically determine the lane width or specify a 
width. Lane width may range from 1.0 to 100.0 mm, in 0.1-mm 
increments. 

6. Click OK. By default, Image Analysis displays a central line down each 
defined lane, with additional lines marking the lane width. When the 
lane is selected, square edit handles are displayed on the lane lines.

7. If any of the lanes need adjustment, click on the lane to highlight it and 

move it to the correct position. The Lane Style button toggles 

among different display options: center line with lane boundary, center 
line only, lane boundary only, and lane display off. You can also choose 
a lane style from the 1D-Gel menu.

Set Migration Lines (page 5-52).  
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1D-Gel Analysis
• Adjust the top and bottom migration lines according to the user’s 
laboratory protocol. 

Autoband (page 5-63).  

With the lanes selected and the migration lines adjusted, autoband determi-
nation can be performed.

1. Select Normalized Volume (IOD) and choose Type 4 as the calculation 
type in the 1D-Gel Preferences dialog box.

2. Click the Automatic Band Detection tab to edit the autobanding 
parameters.

3. Try these settings and adjust the settings as needed for different gels:

Gradient Start = 2.5

End = 2.5

Duration = 0.2

Noise Level = 20
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4. Choose Edit > Select All to select all the lanes. 

5. Click the Automatic Band Detection button or choose 1D-Gel > 

Function > Auto Band. You might need to adjust the Image Analysis 

automatic band calls. The Band Style button toggles among the 

different band styles: band display off, peak and range bands displayed, 
and only peak bands displayed. You can also choose a band style from 
the 1D-Gel menu.

6. Click the Band Edit button or choose 1D-Gel > Tool > Band Edit, 

then use the cursor to place bands. 

Set Marker (page 5-71).  

1. Click the Quantification Setting button or choose Quantification 

Setting... from the 1D-Gel Menu. 

Select the standard curve fit from the drop-down list box. Logarithmic is 
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1D-Gel Analysis
the correct standard curve fit for most applications.

2. Click the Marker Setting button or choose Set Marker... from the 

1D-Gel menu.

3. Highlight the lanes containing the marker by holding down the Shift key 
while clicking on them with the mouse. Select the correct marker from 
the Template list, then click <<Adopt Marker. The selected marker 
appears next to each lane in the list.

Calculate Base Pairs (page 5-80).  

1. Click the Volume Calculation button or choose Volume 

Calculation from the 1D-Gel menu to calculate base pair sizes in 
reference to the assigned marker. 
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2. Click the Open Spreadsheet button or choose Open Spreadsheet 

from the 1D-Gel menu to view the table of base pair values for each 
layer. Click the tabs at the bottom of the window to switch among 
channels. 

3. Choose Export from the SpreadSheet menu to save the spreadsheets as 
comma-delimited text files that can be exported to STaR Call™.
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7 Array Analysis
Image Analysis can extract information from two-dimensional (2D) objects 
as small as one pixel by one pixel. This capability is especially useful when 
you need to analyze arrays and other tightly-spaced objects.

Using the analysis tools in the Array menu, you can analyze dot blots, slot 
blots, gels or arrays. These tools allow you to calculate the following param-
eters, and display them in a table: 

• Spot coordinates (Position)

• Spot area (Area)

• Average signal intensity of the fluorescence of the pixels in a designated 
spot area (Mean)

• Volume of relevant pixels in a spot area. (Volume)

• Quantity in spot, e.g., micrograms DNA (Mol)

• Standard deviation of signal intensity range in each designated spot area.

Note For quantification of 1D-gels, see Setting Quantification Markers 
on page 5-82.
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Array Menu and Tools 

Drawing Tool

Select Tool

Create Rectangle Spot

Create Oval Spot

Create Grid Spot

Show/Hide Spot Information

Show/Hide Comment
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Array Analysis
Set Selected Spots to Background

Set Selected Spot(s) to Marker

Calculation

Preferences

Set Grid Marker

Open Standard Curve

Open Spreadsheet

Ungroup

Group

Array Template

Grid Comparison
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Creating an Array Analysis
To create an Array analysis experiment:

1. Create a new project.

2. Choose New Array Analysis in the Project menu.

3. Select a file that contains a digital image. A new Array experiment is 
added to the project tree and the Array menu appears in the menu bar.

4. Double-click the Array Experiment icon. An Array Experiment window 
containing the image is displayed.
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Array Analysis
5. To deselect an item, remove the checkmark adjacent to it.

6. Click OK.
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Analyzing Spots in an Image
To analyze spots in an image, you must first create a boundary surrounding 
each spot of interest. You can either create a single boundary or create an 
evenly spaced grid over a region with many spots. A single spot can be a 
rectangle or an oval. In addition, you can specify a region to analyze within 
the spot area.

Creating a rectangle or oval spot boundary.  

1. Click the Create Rectangle Spot or Create Oval Spot .

2. Drag the cursor to draw a rectangle or oval around each spot of interest. 

Modifying the boundary of a spot.  

To move a boundary:

1. Click the Select Tool button or choose Array > Tool > Select.

2. Place the cursor inside the boundary until it transforms into a crosshair, 
then drag the crosshair to the desired location.

To enlarge or compress a boundary:

1. Click the Select Tool button or choose Array > Tool > Select.

2. Place the cursor over a transformation handle (initially the upper left or 
lower right handle), and then drag the cursor until you have the desired 
shape.
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To rotate a boundary:

1. Click the Select Tool button or choose Array > Tool > Select.

2. Place the cursor over a rotation handle (initially an upper right or lower 
left handle), and then drag the cursor about the midpoint.

Duplicating a spot boundary.  

You can duplicate a spot boundary by using the Copy and Paste function in 
the Edit menu.

Creating a Grid
To create a grid over a group of spots:

1. Click the Preferences button or choose Preferences... from the 

Array menu.

2. In the Grid Option filecard, enter the number of cells in the H (hori-
zontal) and V (vertical) direction. By default, the grid dimensions are 12 
(horizontal) by 8 (vertical) boxes. 
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3. If you entered 1 as the number of cells horizontally, enter a value in the 
cell width field.

4. If you entered 1 as the number of cells vertically, enter a value in the cell 
height field.

5. Click OK.

6. Click the Create Grid Spot button .

7. Place the crosshair cursor in the center of the spot at the top corner, and 
then drag the cursor through the spots in the top row.
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8. Release the mouse button, then move the cursor down until the inner 
rectangle passes through the spots on the four sides.

9. Then click the mouse button. The grid is created according to the grid 
options set in the Preferences dialog box.

2. Drag cursor across top.

3. Release mouse

1. Click here.

4. Move tool down.

5. Click at corner.
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Modifying a Grid

You can use the Select Tool to modify the grid size, position, and rota-

tional angle.

To move the grid:

• Use the up, down, left, and right arrow keys on the keyboard.

• Place the Select Tool cursor inside the grid, and then drag the crosshair 
to move the shape.

To enlarge or compress a grid:

• Place the Select Tool cursor over a transformation handle (initially the 
upper left or lower right handle), and then drag the cursor until you have 
the desired shape.

To rotate a grid:

• Place the Select Tool cursor over a rotation handle (initially an upper 
right or lower left handle), and then drag the cursor about the midpoint.

Grouping Spots and Grids
You can group spots and grids to change their parameters simultaneously.

To Group spots/grids:

1. Hold down the Shift key, and then click the single spots or grids you 
want to group. Any type of spot or grid may be selected. 
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Array Analysis
2. Choose Group from the Array menu.

3. Change the spot parameters. Your changes will affect all spots in the 
group.

To Ungroup spots/grids:

• Click the group to select it, and then choose Ungroup from the Array 
menu.

Note In the Array menu, if Group is grayed out and Ungroup is active, 
then the spots/grids are already grouped. If Group is active and 
Ungroup is grayed out, then the spots/grids are not grouped.

Creating a Template
Image Analysis allows you to save spots or grids as templates for future use. 
You can also duplicate and rename saved templates.

To create an Array template:

1. Click on the Array Template button . Array Template dialog box 

is displayed.

2. Click Add. The Select Spots and Grids dialog box lists the spot and grid 
elements in the image. Select the spots and grids you want in the tem-
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plate by clicking the checkboxes or using the Select All and Clear 
buttons.

3. When you are finished, click the Save button. The template appears in 
the list preceded by the number of elements contained in it.

To apply a template:

4. Click on the Array Template button . The Array Template dialog 

box is displayed.

5. Click on the desired template in the list, and click Apply.

Background Calculation
You can specify the background value, the method for averaging a back-
ground marker, and the side of a rectangular spot to use as the background.

1. Click the Preferences button or choose Preferences... from the 

Array menu.

2. In the Preferences dialog box, click the Volume Calculation tab.
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Registering the Background Value
1. Create a rectangle or oval spot surrounding the area that represents the 

background.

2. Click the Set Selected Spots to Background button or choose Set 

Selected to Background from the Array menu.

3. The boundary color changes to yellow.

Background Option Description

Gray Level Adjustment Uses gray level background value for 
the image.

Local Uses average pixel value of spot/grid 
cell boundary. Does not use the 
background marker.

Spot Average Uses average pixel value of background 
spot marker.

User Defined Background Uses value entered in the field.

Average Method
(Local or Spot Average)

Mean = (total volume)/(number of 
pixels)
Median = middle pixel value, e.g., 1, 2, 
5, 15, 16*, 20, 300, 2000, 5000
Mode = most frequent pixel value

Effective side(s) of Average 
(Local Background)

Side of cell used to calculate local 
background: All, Left, Top, Right, 
Bottom.

For example, if there is significant 
horizontal overlap of signal between 
spots, you might want to select the top 
of each cell.
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Registering Markers
You can assign known amounts to spots and use these spots as markers to 
quantify unknown samples.

Standard Curve Type.  

To set the type of standard curve:

1. Click the Preferences button or choose Preferences... from the 

Array menu.

2. In the Preferences dialog box, click the Quantification tab. 

3. Select the desired standard curve in the list box, then select a straight or 
Logarithmic scale for the X-axis.

4. Click OK.

Spot Markers.  

To set any combination of spots as markers:
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1. Select any spot or group of spots, then click the Set Selected Spot(s) to 

Marker button or choose Set Selected to Marker from the Array 

menu. The boundary color of each spot changes to violet.

2. Click the Open Spreadsheet button or choose Open Spreadsheet 

from the Array menu.

3. Enter a quantity value for each marker spot in the column labeled 
“Mol.”. If necessary, use the bottom scroll bar to view the right side of 
the Channel table.

Grid Cell Markers.  

To set cells in a grid as markers:

1. Double-click on the grid containing the marker cells. The Grid Marker 
dialog box is displayed.

2. In the Grid Marker table, enter the amount of each marker corre-
sponding table cell. Any cell containing a value greater than zero is set 
as a marker.
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3. If you plan to use these grid markers again, save the parameters as a 
template.

• Enter a name in the Parameter Set list box.

• Click Save.

4. Click OK. The boundary color of the cells changes to violet.

Grid Templates.  

To use a Grid Marker Template:

1. If you want to use an existing grid marker template, select the template 
from the Parameter Set list box.

2. Click Load.

Displaying the Standard Curve.  

• Click the Open Standard Curve button or choose Open Standard 

Curve from the Array menu. The standard curve window is displayed.
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Setting a Partial Quantity
You can restrict the area of a grid cell that is used for volume calculations. 
For example, this feature is useful when the spots in a grid are far apart rel-
ative to their size.

To specify a partial quantity:

1. Click the Preferences button or choose Preferences... from the 

Array menu.

2. In the Preferences dialog box, click the Part Quantity tab.
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3. Click On.

Note When Part Quantity is turned off, the entire area of the spot/grid cell 
is used.

4. Choose the type of partial boundary, Rectangle or Oval.

5. Enter the horizontal (0.68 - 100) and vertical (0.68 - 100) dimensions. 
The following examples illustrate these settings:

Type/Area Size Grid Area

Part Quantity = Off
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Mol Calculation
Image Analysis calculates the mean signal intensity, standard deviation, and 
volume of each spot. If you have specified quantification markers, Image 
Analysis also calculates the quantity of sample in each spot. 

• Click the Calculation button or choose Calculate from the Array 

menu. 

Note Values are only quantified if they fall within the highest and lowest 
standard marker values.

Displaying a Spreadsheet
You can select the spot information you want displayed in the Channel 
spreadsheet. 

1. Click the Preferences button or choose Preferences... from the 

Array menu.

2. In the Preferences dialog box, click the Spot Information tab. 

Part Quantity = On
Rectangle
H = 8 mm
V = 8 mm

Part Quantity = On
Oval
H = 8 mm
V = 8 mm

Type/Area Size Grid Area
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The calculated values appear in the spreadsheet and the volume of each spot/
grid cell is displayed on the image.

3. Click the Open Spreadsheet button or choose Open Spreadsheet 

from the Array menu.
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Exporting a Spreadsheet
You can save the spreadsheet as a tab delimited text file for export to other 
programs, such as Microsoft Excel and Microsoft Word.

To export a spreadsheet:

1. Choose Export... from the SpreadSheet menu.

2. In the Save As dialog box, select a location for the file, and then enter a 
unique name.

3. Click Save.
7-22



Array Analysis
Comparing Grids
Image Analysis allows you to compare grid data. You can compare data from 
two channels in the same grid or two different grids, including grids in dif-
ferent projects. For example, you can conduct data mining for gene 
expression by concentration or volume. The resulting images and spread-
sheets can be pasted into other applications.

To compare grid data:

1. Choose Send Data To Grid Comparison... from the Array menu. 

The Grid Comparison window is displayed. The list box contains all 
open projects with grid data.
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Data Sheet Filecard
You can view the numerical data for each grid in the Data Sheet. You can 
also copy the spreadsheet and use it in another application, such as Microsoft 
Excel.

Data Sheet Buttons.  

Item Description

Switch Active Channel Switch the active data channel.

Copy Spreadsheet Copies spreadsheet to clipboard

Switch Active Channel

Copy Spreadsheet
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2. Select the grids to compare by first clicking the first grid to highlight it.

3. Click the Channel 1 button .

4. Highlight the second grid, and click the Channel 2 button .

5. In the Compare by drop-down box, select a Concentration, Volume, 
Standard, Mean, or Area.

6. Click the Switch Active Channel button to display the grid data 

for each channel.

7. If you want to copy the spreadsheet to the clipboard, click the Copy 

Spreadsheet button .

Overlay View Filecard
You can overlay the two grids and to visually screen each spot for differences 
in the data values. You can adjust the gray scale for each channel and 
enhance the detection of spots with small values. The Screening feature 
allows you display only spots that exceed a minimum Channel 1/Channel 2 
ratio and view the numerical data for those spots. The Overlay View is par-
ticularly useful for quickly filtering spots for quantitative changes in 
expression.
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Item Description

Spot Radius Adjusts the spot radius.

Channel Setting Select the target channel and color.

Histogram Slider adjusts the top and bottom gray 
scale signal threshold.

Gray Setting... Displays the Gray Setting dialog box.
7-26



Array Analysis
1. Adjust the spot radius by using the sliding control bar.

The spot size changes dynamically in the overlay image.

Item Description

Screening Setting... Displays the Screening Setting window.

On/Off Pickup Mode Applies the screening settings to the 
overlay to detect spots.

Capture Image Copies overlay image to the clipboard.

Pickup Screened Spots Displays the comparison data in the 
Selected Spots spreadsheet.

On/Off Pickup Mode

Screening Setting...

Pickup Screened Spots

Capture Image
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2. Choose the target channel and its color from the drop-down list boxes.

3. The histogram displays the # pixels vs. raw gray scale value. Using the 
blue slider on the histogram to adjust the top gray scale threshold and 
red line slider to adjust the bottom gray scale threshold for the target 
channel. The threshold values and percentages change dynamically as 
you move the sliders. For an explanation of the histogram and 
thresholds, see Gray Level Adjustment on page 5-14.

Note You can also use the Gray Settings dialog box to adjust these 
threshold values.
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4. Click the Gray Scale... button. The Gray Scale Setting dialog box is 
displayed. 

5. Choose to use % (percentage) of total pixels or raw value as the gray 
scale unit for the thresholds.

6. Type values for the top and bottom gray scale thresholds in the fields. 

7. If desired, you can choose to use the optimal gray mapping mode. This 
mode is equivalent to the Equal Area mode. See Mapping Type Selector 
on page 5-18

8. Click the Screen Setting button . The Screen Setting dialog box is 

displayed.

9. Specify the Screening and Viewing options. 

Note You can choose to view a simple subtraction of the Channel 2 value 
from the Channel 1 value for each spot, or increase the gray scale 
value of weak spots. The latter can be used for detection, but is not 
recommended for quantitation by visual inspection.
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10. Apply the screening settings to the grid overlay by clicking the On/Off 

Pickup Mode button .

11. If desired, you can copy the image to the clipboard by clicking the 

Capture Image button .

12. Click the Pickup Screened Spots button . The Selected Spots 

spreadsheet is displayed containing the comparison data for the 
screened spots.
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Grid Comparison Filecard
In the Grid Comparison filecard you can compare histograms of the 
expression and volume ratios in the grids.

1. Click on the Grid Comparison tab. The expression and volume ratios for 
the channels is displayed in histograms.

The color of the channel with the greater expression and volume is 
displayed. The width represents its relative expression, and the height 
represents its relative volume.

Grid Comparison Buttons.  The Grid Comparison buttons allow you to 
view the expression and volume ratios separately.
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1. Click on the Show expression ratio button . The expression ratio 

histograms and numerical values for the two channels are displayed.

The color of the channel with the greater expression is displayed. The width 
represents its relative expression.

On/Off Graduation

Show both expression ratio and volume ratio

Show expression ratio

Show volume ratio
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2. Click on the Show volume ratio button . The volume ratio histo-

grams and numerical values for the two channels are displayed.

The color of the channel with the greater volume is displayed. The height 
represents its relative volume.
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Scatter Plot Filecard
You can view a scatter plot of the data from the two grids, and automatically 
track spots of interest to the grid in the Overlay View. An area of the plot can 
be magnified to view selected spots, and numerical spot data viewed in a 
spreadsheet.

1. Click on the Scatter Plot tab.
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Scatter Plot Buttons.  

2. Click the Show Spot Label button . A label with the grid coor-

dinate appears on each spot.

Item Description

Show Spot Label Display grid coordinates on each spot.

Plot Size Adjust the spot radius.

Reset Magnification Reset to the original magnification

Capture Image Copy the graph to the clipboard.

Pickup Spots in the range Display the spot data in the Selected 
Spots spreadsheet.

Reset Magnification

Plot Size
Show Spot Label

Capture Image

Pickup Spots in the range
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3. Double-click on a spot. 

The Overlay View filecard is displayed and the spot is selected on the 
grid
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4. To change the size of the spots, click the down arrow next to the Spot 

Size button , and choose the spot radius from the drop-down 

menu.

5. To magnify an area of the plot, drag the cursor to form a rectangle 
enclosing the area of interest.
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6. Release the mouse button. The plot is magnified so that the area 
occupies the entire graph.

7. Click the Pickup Spots in the Range button . The comparison data 

for the spots is displayed in the Selected Spots spreadsheet.
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8. To return to the original magnification, click the Reset Magnification 

button .

9. To copy the image to the clipboard, click the Capture Image 

button .
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8  Drawing Tools
You may use the Drawing tools before or after analysis functions to create 
text and graphics elements for inclusion any document or overlay trace. With 
the these tools, you can do the following:

• Call attention to faint or targeted bands.

• Include comments with the scanned image.

• Package experimental results with a professional appearance.
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Draw Menu and Tools

1. To use the drawing tools, click the Drawing Tool button or 

choose Drawing from the Tools menu. The Draw menu appears in the 
menu bar and the Drawing tool buttons are activated.

2. In the View menu, choose to display the Draw 1, Draw 2, Draw 3, and 
Text Attribute toolbars.
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Right-click Menu
You can also choose the line and paint attributes by placing the cursor over 
the window and right-clicking the mouse.

Setting the Margins
To create a margin for annotations around the image:

1. Click the Paper Position . The Comments Area Settings dialog 

box is displayed.

2. Type in the desired top, bottom, left, and right margins in pixels, and 
Click OK. The margins are added to the image.
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Rotating Text
To rotate text boxes:

1. Select the text box you want to rotate.

2. Click the Rotate text... button . The Rotation Setting dialog box is 

displayed.
8-4



Drawing Tools
3. Choose to enter a free rotation angle or select a fixed rotation from the 
drop-down list box, and specify the angle.

The text box is rotated clockwise through the angle.

4. Position the text box as desired.
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Draw Tools 

Tool Draw 1 Function

Select Tool Select a figure. To select multiple figures, click while 
pressing the Shift key.

Line Tool Draws lines.

Rect Tool Draws rectangles.

Ellipse Tool Draws an ellipse (rectangle with rounded corners). 

Oval Tool Draws ovals.

Polygon Tool Any shape bordered by straight lines. Click to establish 
the point for the beginning of each straight line. Double-
click at the end of the last point.

Text Tool Drag to create a text box, and then type text.

Paper Position Set the width of the top, bottom, left, and right margins 
around the image.

Select Tool

Line Tool

Text Tool

Rectangle Tool

Ellipse Tool

Oval Tool

Polygon Tool

Paper Position
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Tool Draw 2 Function

Bring Forward Moves selected figure forward one layer.

Send Backward Moves selected figure back one layer.

Bring to Front Brings selected figure to top layer.

Send to Back Sends selected figure to back layer.

Align Left Aligns selected figures left.

Align Vert Center Centers selected figures vertically.

Align Right Aligns selected figures right.

Bring Forward

Send Backward

Bring to Front

Send to Back

Align Left

Align Vert Center

Align Right
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Align Top Aligns selected figures along top edges.

Align Horiz Center Centers selected figures horizontally.

Align Bottom Aligns selected figures along bottom edges.

Lock Locks selected figure in position.

Unlock Unlocks selected figure.

Edit Polygon Drag apex handles to change polygon shape.

Tool Draw 2 Function

Align Top

Align Horiz Center

Align Bottom

Unlock

Lock

Edit Polygon
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Tool Draw 3 Function

Paint Color Set color of shape fill.

Transparency Makes paint color transparent.

Paint Color

Transparency
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Line Color Set line color.

Line Width Set thickness of line.

No Line Makes line is transparent.

Line Type Choose solid line, dashed line, or dotted line.

Tool Draw 3 Function

Line Color

Line Width

No Line

Select Line Type
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Polyline Draw lines connected at different angles.

Polygon Draw closed polyline.

Line marker styles Select arrows, circles, or diamonds to mark line 
endpoints.

Tool Draw 3 Function

Polyline

Polygon

Straight Line

Arrow

Double-headed Arrow

Circle
Diamond
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Tool Text Attributes Function

Font Sets text font and size.

Text Color Sets color of text.

Bold Bold text.

Italic Italic text.

Underline Underline text.

Align Left Align text lines left.

Align Center Center text lines.

Align Right Align text lines right.

Rotate text... Rotate text.

Font

Text Color

Align Left

Align Center

Align Right

Bold

Italic

Underline Rotate text...
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Working with Draw Objects
• To select an object, click on it with the cursor to select it. A selected 

object has rectangles at its four corners. 

• To move an selected object, drag it to the new location. 

• To change the size of a selected object, click one of the corner handles 
and drag it. To make the size change proportional, hold the Shift key as 
you drag the corner. 

• To delete a selected object, press the Delete key.
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9 Maintenance
Cleaning
WARNING! Always turn the power switch OFF before performing 

maintenance.

To clean the exterior surfaces of the unit, use only a clean cloth or sponge 
moistened with mild detergent solution. Wipe dry with a cloth. Never use 
benzene, paint thinner or other organic solvents for cleaning purposes, and 
never apply adhesives or other chemicals to the exterior surfaces of the unit. 
Doing so could result in discoloration and deformation of the covers, with 
consequent loss of laser beam protection. 

Never attempt to clean, adjust or perform any other maintenance operation 
on the laser head, the photomultiplier tube, or any other optical, mechanical 
or electrical component of the unit.

CAUTION! Accumulation of dust in the interior of the scanning unit 
has been known to cause fires. Ask your service 
representative to conduct regular maintenance at least once 
a year.

Service
In the event that fire, flood, earthquake or other adverse environmental inci-
dent affect the instrument, contact your Hitachi Software Engineering repre-
sentative for inspection and service. Do not attempt to reinstall, relocate, or 
adjust the FMBIO II instrument. 

The FMBIO II unit should be serviced annually by Hitachi Software Engi-
neering service personnel. 

!

!
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Laser Head 
Never attempt to replace the laser head or make any other mechanical repairs 
or adjustments to the equipment. 

Photomultiplier Tube
The photomultiplier tube settings are carefully adjusted before shipping. Do 
not attempt to change or adjust the photomultiplier tube settings. If any 
defective operation occurs, such as a noticeable decrease in signal power, 
contact a Hitachi Software Engineering service representative. 

Operating Temperature
Do not use the scanning unit in a location where the surrounding air temper-
ature exceeds 30°C (86°F). At ambient room temperatures greater than 
30°C, the scanning unit may fail to emit the laser beam, making it impossible 
to produce an image. Should the laser fail due to excessive room tempera-
ture, place the power switch in the OFF position, and allow the scanning unit 
to cool. If the room temperature is close to 30°C, use an air conditioner to 
lower the ambient temperature. The minimum operating temperature is 10°C 
(50°F).

Moving the Scanning Unit 
The unit’s optical scanning device is a precision instrument. Do not relocate 
or move the scanning unit without prior authorization from Hitachi Software 
Engineering, or risk voiding your warranty.

Shipping
The FMBIO II unit is a precision device that weighs approximately 50 kg. 
When transporting it, you must protect it from impact and torque. Pack it in a 
sturdy shipping container with a rigid structure and ample internal cushion-
ing. Transport it on a sturdy cart. The equipment must always stay upright; 
never tip it on its side or on its end. 
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Shutdown
When the FMBIO II unit is not to be used for an extended time, turn off the 
Main switch on the rear panel, and disconnect the power cord.

Troubleshooting the Scanning Unit
At the first sign of a problem with the operation of the scanning unit, check 
the red Error light on the front panel.

Red Error Light Flashing
1. Turn off the Power switch and wait 5 seconds.

2. Turn on the Power switch and wait for the FMBIO II self-diagnostic 
routine to end.

3. If the Error light continues to flash, call Hitachi Software Engineering 
service personnel.

Responding to Problems

WARNING! Shutdown the Scanning Unit at the first sign of 
trouble. If the Scanning Unit emits an unusual smell, 
smoke, noise or excessive heat, immediately turn the 
power switch Off, disconnect the power cord. 

If the Scanning Unit emits an unusual smell, smoke, noise or excessive heat:

• Immediately turn the power switch to OFF.

• Disconnect the power cord.

• Contact your nearest authorized Hitachi Software Engineering Service 
representative. 

If you continue to use the scanning unit under these circumstances, fire or 
electric shock may result.

Water Spills Inside the Scanning Unit
If there is a spill:

• Immediately turn the power switch to OFF.

!
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• Disconnect the power cord

• And contact your nearest authorized Hitachi Software Engineering 
Service representative. 

If you continue to use the scanning unit under these circumstances, fire or 
electric shock may result.

Foreign Objects In the Scanning Unit
If foreign objects are discovered or may have dropped inside the equipment:

• Immediately turn the power switch to OFF.

• Disconnect the power cord.

• And contact your nearest authorized Hitachi Software Engineering 
Service representative. 

If you continue to use the scanning unit under these circumstances, fire or 
electric shock may result.

Equipment or Power Cord is Damaged 
If the Scanning Unit or the Power Cord is damaged:

• Immediately turn the power switch to OFF.

• Disconnect the power cord.

• Contact your nearest authorized Hitachi Software Engineering Service 
representative. 

If you continue to use the scanning unit under these circumstances, fire or 
electric shock may result.

Never under any circumstances repair the equipment by yourself.

Unknown Cause of Damage 
If the cause of damage is unknown, and the prompting image fails to appear, 
then refrain from using the Scanning Unit.

• Immediately turn the power switch to OFF.

• Disconnect the power cord.

• Contact your nearest authorized Hitachi Software Engineering Service 
representative. 
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10  Allele Calling with STaR Call
STaR Call™ Genotyping Software converts base-pair values generated by 
Image Analysis to allele names. STaR Call takes advantage of the quanti-
tation features in Image Analysis to perform automated genotype calling and 
analysis of artifact (“stutter”) bands. First, the calculated band sizes are 
imported into STaR Call. STaR Call then compares these values with a 
selected STR Lookup table that contains size ranges for each allele. Based on 
comparison of band sizes with allele ranges, bands are assigned a locus name 
and repeat number. Weak bands occurring in the stutter position are iden-
tified as artifacts and are excluded from the final output. Genotype data 
generated by STaR Call are easily converted to common message format 
(CMF) files for export to the Combined DNA Index System (CODIS) 
forensic database.

This chapter discusses how to apply STaR Call to evaluate alleles and stutter-
band artifacts. If you are interested in evaluating STaR Call Genotyping 
Software, or obtaining a quotation, please contact your FMBIO Sales 
Representative. 
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Installing the STaR Call Software
The STaR Call software is available for both the PC and Macintosh. Both 
versions require that Excel be previously installed. The Macintosh version 
will run with either Excel 5 or Excel 98. The PC version will run under 
either Windows 95 or Windows 98.

STaR Call Installation - Windows Version

Requirements

• At least 2 MB of free memory to load the STaR Call macro and the data 
file.

• Microsoft Windows 95 or Windows 98, with Excel 95 or Excel 97. 
Consult the documentation that came with the Microsoft Excel software 
for Microsoft Excel's memory requirements.

Installing STaR Call

Note To install and use the STaR Call software, you must have Excel 
loaded on your computer. If Excel is not already installed on your 
hard drive, install it before attempting to install STaR Call. 

1. If you have just installed Microsoft Office or Excel, run Excel once to 
allow it to complete some automatic configuration steps.

2. Make sure that Excel is closed.

3. Insert the STaR Call disk into the drive.

4. Select the directory corresponding to the version of Excel that is 
installed; either Excel 95 or Excel 97.

5. According to which version of Excel you have:

• If you have Excel 95 installed, double click the INSTALL.xla file. 

• If you have Excel 97 installed, double click the install.xla file. 

6. If a dialog box appears asking you if you want to enable or disable 
macros, click the Enable Macros button. The STaR Call Installer dialog 
box is displayed. Click the Install button.
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Starting STaR Call

STaR Call will automatically start whenever you load Excel, and a 
STaR Call spreadsheet will open.

If you want use Excel for other than STaR Call, you may unload it by 
selecting Unload from the STaR Call menu. To use STaR Call again you 
must restart Excel.

If you do not want STaR Call to start each time you run Excel, you may 
remove it as described below.

Removing STaR Call

1. Make sure that Excel is not running.

2. Locate the Excel startup folder. The Excel startup folder location 
depends on which version of Office you are using. If you are having 
trouble finding the Excel startup folder, use the Find application: Click 
the Start button, select Find > Files or Folders. Then type ‘fmbiostr.xla’ 
in the Named field and click the Find Now button.

3. Remove the files fmbiostr.xla and codisdbf.xls from the startup folder.

STaR Call Installation - Macintosh Version

Requirements

• At least 2 MB of free memory to load the STaR Call macro and the data 
file.

• Microsoft Excel 5 or Excel 98.

Consult the documentation that came with the Microsoft Excel software 
for Microsoft Excel's memory requirements. If you have less memory 
than is required by Excel, it will be necessary to have the virtual 
memory turned on. If you have insufficient memory, you may get 
various error messages. Many error messages occur due to memory 
allocation problems.
10-3



FMBIO®
Installing STaR Call

Note To install and use the STaR Call Software, you must have Excel 
loaded on your computer. If Excel is not already installed on your 
hard drive, install it before attempting to install STaR Call. 

1. If you have just installed Microsoft Office or Excel, run Excel once to 
allow it to complete some automatic configuration steps.

2. Make sure that Excel is closed.

3. Insert the STaR Call disk into the drive.

4. Select the folder corresponding to the version of Excel that is installed; 
either Excel_5 or Excel_98.

5. According to which version of Excel you have:

• If you have Excel_5 installed, double click the INSTALL.xla file. 

• If you have Excel_98 installed, double click the install.xla file. 

6. If a dialog box appears asking you if you want to enable or disable 
macros, click the Enable Macros button. The STaR Call Installer dialog 
box is displayed. 

7. Click the Install button. If you have previously installed STaR Call, a 
window will be displayed asking if you would like to replace the 
codisdbf.xls file.

• Click the Yes button if you would like to replace it (a copy of the 
old file will be stored in a backup folder located in the Excel startup 
folder).

• Click the No button if you want to keep the old version of 
codisdbf.xls file and continue installing the STaR Call macro.

• Click Cancel to cancel the installation.

8. At the end of the installation, the following message box will inform 
you of a successful installation. Click OK.
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9. Restart Excel. STaR Call should automatically load when Excel is 
started. It will appear as a menu item as shown below and the STaR Call 
spreadsheet will open.

Starting STaR Call

STaR Call will automatically start whenever you load Excel.

If you want use Excel for other than STaR Call, you may unload it by 
selecting Unload from the STaR Call menu. To use STaR Call again you 
must restart Excel.

If you do not want STaR Call to start each time you run Excel, you must 
remove it as described below.

Removing STaR Call

1. Make sure that Excel is not running.

2. Locate the Excel startup folder. The Excel startup folder location 
depends on which version of Office you are using. 

Note If you are having trouble finding the Excel startup folder, use the 
Find application: Enter Command+F from the desktop, select ‘Find 
items on local disks’ and ‘name’ and ‘contains’. Then type 
‘fmbiostr.xla’ in the ‘contains’ box and click the Find button.

Remove the files fmbiostr.xla and codisdbf.xls from the startup folder.
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Short Tandem Repeats
Short tandem repeats (STRs) are short, repetitive DNA sequences two to 
seven base pairs long with alleles differentiated by the number of times a 
sequence is repeated. STR loci may be detected by polymerase chain 
reaction amplification using labeled primers. Electrophoretic separation is 
then used to distinguish alleles by size.

STRs are abundant and widely distributed throughout the human genome. 
They are well characterized and highly polymorphic, making them ideal for 
use in individual human identification.

The discriminatory power of STR analysis is greatly enhanced by evaluating 
samples at more than one locus simultaneously (multiplexing). When com-
paring forensic samples at eight loci, matching probabilities can exceed 1 in 
118,000,000. In parentage investigations, multiple-locus analysis can result 
in paternity probabilities of 0.9979 and higher.

STR data are efficiently analyzed using a unique combination of instrumen-
tation, non-isotopic chemistry, and software that makes processing DNA 
samples fast, safe, and easy for human identity applications and databasing.
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Preparing for Allele Evaluation
Before you can use STaR Call Genotyping Software, you must use 1D-Gel 
tools in Image Analysis to analyze a gel. Perform the following steps to gen-
erate results for allele evaluation.

1. In a one-dye image, adjust the gray level (see page 5-14). In a multi-
color project, perform a color separation (see page 5-52).

2. Define the lanes to be analyzed (see page 6-11). STaR Call can accept 
up to 51 lanes for analysis.

3. Use the Automatic Band Detection tool to define bands (see page 6-11). 
Check bands and edit as necessary.

4. Register marker lanes, using the Logarithms curve fit (see page 6-13).

5. In the 1D-Gel menu, choose Preferences.... In the Calculation filecard, 
choose Normalized Volume and Type 4 (see page 5-81). 

Note Excel spreadsheets accommodate up to 256 data columns. If the gel 
image contains many lanes, you may need to limit the number of 
result types on the table to assure all data is imported into Excel. 
You can safely eliminate mm, Rf, and IOD%.

6. Click the Volume Calculation button to generate results (see 

page 5-88).
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Exporting 1D-Gel Analysis Results

1. Click the Open Spreadsheet button or choose Open Spreadsheet 

from the 1D-Gel menu or to display the table of analysis results.

If the image is a multi-color project, Image Analysis displays results for 
each channel. 

2. In the SpreadSheet menu, choose Export....

3. Indicate where you want to save the tab-delimited text file, name the 
file, then click Save.

4. Save any changes to the project.
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Using STaR Call to Evaluate Alleles
After you analyze a 1D gel and export the results, you are ready to use 
STaR Call Genotyping Software for allele calling.

1. Open Excel.

STaR Call appears as a menu on Excel’s menu bar, and a table named 
codisdbf.xls appears.

Important: Do not close the codisdbf.xls table while using 
STaR Call, because STaR Call uses it for allele calling.

If you do not see the STaR Call menu on the Excel menu bar, choose 
New from the File menu to make it appear.
10-9



FMBIO®
Options

To open the options dialog box, choose Options from the STaR Call menu.

Command Description

Import STR... Imports up to 6 Image Analysis generated DAT 
files. You can choose Plain, with OD, or with 
IOD%. 

Recalculate Recalculates all the DAT files in the selected 
analysis workbook and assigns alleles to each base 
pair. Recalculate the DAT files after changing a 
STR Lookup table.

Edit STR Cutoff... Allows you to edit the cutoff percentage values for 
assigning stutter bands.

CODIS STR Export... Displays two options:

• Export v2.0 —exports a STaR Call 
analysis to a CODIS import file.

• Update CODIS values —updates the valid 
CODIS values using an export file gen-
erated from the CODIS system.

Compare Analyses... Compares the Merged sheets of two analyses 
workbooks.

STR Lookup Table... Allows you to create, edit, and delete STR Lookup 
tables.

Options Allows you to choose the order of merged allele 
sorting and whether the phenotype or genotype is 
listed in the merged landscape worksheet.

Help Displays the help text.

About Displays information about the STaR Call 
program.
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You can choose the sorting order for the alleles in the merged worksheet. The 
worksheets for the individual DAT files will sort alleles in ascending order. 

You can also select whether single values representing phenotypes or 
duplicate values representing genotypes are displayed in the merged land-
scape worksheet. 

Note If you are exporting data to CODIS, choose Phenotype.

STR Lookup Table

A STR Lookup table is used when evaluating an STR table. The lookup 
tables are saved in a file called codisdbf.xls.
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Stutter band reporting.   To evaluate stutter, STaR Call calculates the OD 
(or IOD) ratios of adjacent bands. If a band is in the stutter position (n-4) 
and the related ratio falls within a user-defined cutoff range, that ratio is 
reported in the Percentages column. Information on this band is not exported 
to CODIS (see page 10-21) and does not appear in the Merged Landscape 
worksheet (see page 10-20).

• To include a stutter band in either CODIS or the Merged Landscape 

Title Description

Ranges Values derived from the -, +, and Paste Values 
columns used to assign the allele names.

Genotype Values determined by the Evaluate STR Data 
function.

- & + Variance values used to derive the values in the 
Ranges column.

Paste Values Average values for allelic ladders selected in the 
Evaluate STR Data function are copied to this 
column and used as the basis for calculating ranges.
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worksheet, delete the value in the Percentages column.

• To change the cutoff range, choose Edit STR Cutoff Values from the 
STaR Call menu.

Creating, editing, or deleting a STR Lookup table.  

• In the STaR Call menu, choose STR Lookup Table. The STR Lookup 
Table dialog box is displayed.

To create a STR Lookup table:

1. Enter a valid sheet name in the Create New Lookup Table field.

2. Click the New button.

To edit a STR Lookup table:

1. In the STaR Call menu, choose STR Lookup Table. The STR Lookup 
Table dialog box is displayed.

2. Select the STR Lookup Table in the Edit or Delete Lookup Table list 
box.

3. Click the Edit button.

To delete a STR Lookup table:

1. In the STaR Call menu, choose STR Lookup Table. The STR Lookup 
Table dialog box is displayed.

2. Select the STR Lookup Table in the Edit or Delete Lookup Table list 
box.
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3. Click the Delete button.

Importing STR files

The Import STR function converts an Image Analysis generated table to a 
STaR Call table format. It removes all the unnecessary columns such as the 
migration distance and Rf columns, and adds columns for allele scoring. It 
also adds rows for CODIS export information as follows:

Row
Number Description

1 The Lane name generated by Image Analysis

2* Specimen Number

3* Sample ID

4* Specimen Category

5* Tissue Type

6* Tissue Form

7* Population Group

8 Include/Exclude lane.

9 Sub Headings

10 Start of bp and Genotype values (OD & Percentages).

* Actual values are used when exporting to CODIS.

To import an STR file:

1. In the STaR Call menu, choose Import STR....

Note Always use the Import command to open the Image Analysis results 
file in STaR Call. Errors occur when you use the Open command to 
open a saved results file.

2. In the Import STR dialog box, click the Browse button.
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3. Locate the file you want to evaluate.

4. Select a STR Lookup Table in the drop-down list box.

5. Repeat the process to add more files.

6. Select a conversion method:

STR (plain) —Uses base-pair sizes to call alleles. Deletes all columns 
except for the bp column.

STR with OD values —Uses base-pair sizes to call alleles, and OD 
values to calculate n-4 stutter percentages. Deletes all columns except 
for the bp column and the OD column.

STR with IOD values —Uses base-pair sizes to calls alleles, and IOD 
values to calculate n-4 stutter percentages. Deletes all columns except 
bp column and the OD column.

7. Click OK to import the files. The Evaluate Select Allelic Ladders dialog 
box is displayed.

Note Do not choose Recalculate. No recalculation of values can occur 
until the STR files are imported.

A dialog box displays lanes along with the number of bands in each 
lane. You are prompted to choose the lanes containing allelic ladders for 
averaging. The default selection is all of the lanes that contain the 
highest number of bands. The default choices are highlighted. 
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Note This is a good time to verify that the correct number of bands are in 
the chosen lanes. The number in parentheses preceding the lane 
number is the number of bands in the lane. 

The allelic ladder dialog box offers three ways to select allele ladders:

a. Click the Auto Select button to let STaR Call choose the lanes with 
the most bands, as in the example shown here. The average of these 
ladders becomes the standard for comparison.

b. Click on one allelic ladder to select it as the standard for 
comparison.

c. Press and hold down the Ctrl key as you click more than one allelic 
ladder. These ladders will be averaged and the average used as the 
standard for comparison. 

8. Click OK to complete allelic ladder selection.

STaR Call puts the average base-pair values of the allelic-ladder standards 
into the STR Lookup table. These allelic standard values appear in the Paste 
Values column. Ranges are then generated using the “Paste Values” for the 
allelic ladder and the values from the “-” and “+” columns.

After the STR Lookup table is filled, the current table is evaluated. Each 
base pair value is compared to the ranges in the lookup table. 
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If the base pair value is within the range for an allele, the corresponding 
allele is entered into the Genotype column. Otherwise, “Not in range” is 
displayed. 

If you evaluate STR data with OD or IOD values, stutter percentages are 
entered under the Percentages column for all values that fall within the 
stutter cutoff range assigned for that locus.

Note If a band is “not in range,” it is not included in the stutter 
calculations.

After the evaluation is complete, a workbook is created containing work-
sheets containing data from the individual DAT files, the corresponding 
allele evaluations with the selected lookup tables, and merged worksheets 
containing results from all the DAT file. 

To display a worksheet click on its tab at the bottom of the window. If you 
cannot view the entire worksheet, click on the arrows in the scroll bar at the 
bottom right of the window. If you cannot see the tab for a worksheet, click 
on the arrows at the bottom left of the window. The following types of work-
sheets are created:

Summary Worksheet.  Provides a summary of the analysis, STR import, 
and any comparison performed using the Compare Analysis function.
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Analysis Worksheet.  Provides allele evaluation using the selected STR 
Lookup table.

Merged Worksheet.  Merges data from all analyses. Differences in the data 
among the different analyses are highlighted.Differences in the data among 
the different analyses are highlighted. Excluded alleles are highlighted in 
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red. Non-agreeing allele calls in overlapping loci between the PowerPlex 1.1 
and PowerPlex 2.1 systems are highlighted in yellow.

You can edit values for “Not in range” alleles, e.g., microvariants, in the 
merged worksheet. 

1. Click on the cell containing the data you want to edit. 

2. Type the value.
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3. Click on another cell in the sheet.

After you have finished editing the worksheets, choose Created Merged 
Landscape from the STaR Call menu. The new merged landscape worksheet 
will reflect the current values in each worksheet.

Merged Landscape.  Shows a summary of allele calls. It does not display 
the following:

• Lanes labeled as allelic ladders.

• Lanes marked Exclude in the CODIS portion of STaR Call.

• Bands with values reported in the Percentages column (stutter bands)

• Bands marked “Not in range”.

4. Carefully evaluate bands that STaR Call has not assigned to a genotype. 
Some “Not in range” bands may be only slightly outside the allele 
range. You can correct these calls as needed.

Adding an STR

1. Select the analysis workbook.

2. Choose Import STR... from the STaR Call menu.

3. Click Yes when asked if you want to add a file to the current analysis.

4. In the Import STR dialog box, click any available Browse button to 
select a file.

5. Select a STR Lookup Table in the drop-down list box.

Recalculating Results

To recalculate results:
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• Choose Recalculate from the STaR Call menu. STaR Call copies the 
STR Lookup tables, evaluates the STR files, and creates the Merged and 
Merged Landscape worksheets.

Comparing Analyses

To compare two analyses:

1. Choose Compare Analyses... from the STaR Call menu. The Compare 
dialog box is displayed.

2. Select the two analysis workbooks in the drop-down list boxes. Click the 
Browse button to open a workbook.

3. Select the Compare lane information option if required.

4. Click OK.

Printing and Saving Results

Your evaluation is now complete. You may print and save the STaR Call 
table of genotypes and stutter percentages. Save the file either as a tab-
delimited text file or an Excel workbook.

Exporting Data to CODIS

You can add CODIS information to the table of STaR Call results and 
prepare a file to upload your allele calls to the CODIS database.

To export to CODIS:

1. In the STaR Call menu, choose CODIS STR Export.... The CODIS STR 
Header dialog box appears.
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Title Description

CMF Header Version This is the Common Message Format header 
version.

CMF Message Type This is the message type.

CMF Message ID Accepts numeric values only.

Imaging System 
Organization/Company

You can enter up to 64 alphanumeric characters. 

Imaging System Utilized You can enter up to 64 alphanumeric characters. 

Imaging System ORI You can enter up to 10 alphanumeric characters. 

Laboratory ORI You can enter up to 10 alphanumeric characters. 

Creation Date/Time Use the format DD-MMM-YYYY HH:MM:SS.

CMF Type This is the results type.

CMF Version This is 1.0.

Technology This is the technique used.
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2. Enter the required information. Click the [+/-] button to add or delete list 
values.

3. Click Next. The CODIS STR Specimen Information Dialog Box is 
displayed.

Reading by You can enter up to 20 alphanumeric characters. 

Reading Date Use the format DD-MMM-YYYY. Reading date 
must be in 4-digit format.

Reading Time Use the format HH:MM:SS.

No. of Reading(s) This accepts numeric values only.

Title Description
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Title Description

Lane/Marker Name Default is lane number

Specimen Number You can enter up to 24 alphanumeric characters.

Use marker name as 
specimen number

Check this box if you want to use the lane/
marker name as the specimen number. Copies 
row 1 to row 2.

Exclude Lane Check this box if you want to exclude lane(s) 
from being exported to CODIS.

Included/Excluded 
Lane List

Displays a list of lane names where any lanes 
highlighted will be excluded from export.

Sample ID You can enter up to 8 alphanumeric characters. 

Specimen Category You must enter a valid CODIS value up to 40 
alphanumeric characters long.
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4. Enter the required information. Click the [+/-] button to add or delete list 
values.

• To copy the corresponding control value from the currently selected 
lane to the remaining lanes, click the [>>] button. 

• To copy the Sample ID, Specimen Category, Tissue Type, Tissue 
Form and the Population Group values for the currently selected 
lane to the remaining lanes, click the [All >>] button.

5. Click Export to convert data to a CODIS-compatible data file.

6. Enter a unique name and location.

Tissue Type You must enter a valid CODIS value up to 15 
alphanumeric characters long. 

Tissue Form You must enter a valid CODIS value up to 10 
alphanumeric characters long. 

Population Group You must enter a valid CODIS value up to 15 
alphanumeric characters long. 

Title Description
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7. Click Save. A CODIS worksheet is added containing the header 
information.

The CODIS Specimen Information appears in the Merged worksheet.
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Appendix A - Software Reference
Keyboard Shortcuts
Keyboard shortcuts are a combination of keys that send a command to the 
computer. Each keyboard shortcut behaves just like one of the commands in 
the Menu bar. Most keyboard shortcuts use the Control key, represented by 
the abbreviation Ctrl, and one other key.

For example, to open a project, you can either choose Open Project from the 
File menu, or you can use the keyboard shortcut. To use the keyboard 
shortcut to open a project, hold down the Control key and then press the O 
key. This shortcut is represented as Ctrl+O.

Menu Command Keyboard Shortcut

Close Ctrl+W

Copy Ctrl+C

Cut Ctrl+X

Duplicate Ctrl+D

New Project Ctrl+N

Open Project Ctrl+O

Paste Ctrl+V

Print Ctrl+P

Save Project Ctrl+S

Select All Ctrl+A
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Icons - Image Analysis Tools

File and Edit Tools

Name Usage

New Project Create a new project.

Open Project Open an existing project.

Save Project Save a project.

Cut Remove selected object and store in the clipboard.

Copy Copy selected object and store in the clipboard.

Paste Place contents of the clipboard at the cursor.

Print Print the contents of the active window.

Windows Help Place the What’s This? cursor on an Windows 
element and click to see Help topic.

New Project

Open Project

Save Project

Cut
Copy

Paste

Print

Windows Help
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Image Tools

Tool Description

Zoom Out Each click reduces the image.

Zoom In Each click to enlarges the image.

Magnification 
Input/List Box

Displays current magnification. Enter the desired 
magnification or select a magnification from the 
drop-down list.

Zooming Tool 1. Click the button. The cursor transforms into a 
magnifying glass with a “+” sign. 

2. Drag the magnifying glass cursor to create a 
rectangle surrounding a region of the image. 
The image is magnified to show the region.

Fit Window Click to fill the entire window with the image.

Moving Tool Click the button, and then drag the image.

Zoom Out Zooming Tool

Zoom In Fit Window

Moving Tool

Magnification Input/List Box
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Command Description

Gray Level Adjustment See Gray Level Adjustment on page 5-14.

Color Separation See Color Separation on page 5-30

Show Image 
Setting Dialog

See Image Setting Dialog Box on page 5-11.

Image Information View sample, image and scanning infor-
mation from the FMBIO II ReadImage file.

Export Image See Saving an Image on page 5-7

Transparent Background See Transparent Background on page 5-36

Line Selection Draw a line to select a location on the image

Area Selection Draw a rectangle to select an area on the 
image.

Show Spectrum See Spectrum on page 5-26

Color Separation

Gray Level Adjustment

Image Information

Show Image Setting Dialog

Line Selection

Area Selection

Show Spectrum
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Tool Description

Normalize Baseline Normalizes vertical range.

Switch Axis Switches between the horizontal and vertical 
spectrum views.

Display Channel Toggles display of spectrum for individual 
channels. 

Switch Axis

Normalize Baseline

Display Channel
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1D-Gel Tools

Tool Description

Select Select objects.

Lane Selection Define a single lane.

Multiple Lane Selection Define multiple adjacent lanes.

Lane Alignment Aligns lanes with migration lines.

Automatic Lane Fitting Automatically adjusts lane boundaries.

Lane Template Saves all lanes on image.

Lane Selection Tool

Multiple Lane Selection Tool

Band Edit

Lane Alignment

Lane Template

Select Tool

Automatic Lane Fitting

Delete Band
Automatic Band Detection
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Tool Description

Show/Hide Lanes Toggle display of lane boundary lines.

Show/Hide 
Band Information

Toggle display of band information.

Show/Hide 
Comments

Toggle display of label information entered 
in spreadsheet.

Lane Style Toggle among different display options: cen-
ter line with lane borders, center lines only, 
lane boundaries only, and lane display off.

Band Style Toggle among the different band styles: band 
display off, peak and range bands displayed, 
and only peak bands displayed.

Show/Hide Comment

Show/Hide Band Information

Show/Hide Lanes

Lane Style

Band Style
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Tool Description

Overlay Trace Displays new overlay trace of selected 
lanes.

Set Marker Displays Marker Setting window.

Volume Calculation Performs a volume calculation.

Open Spreadsheet Displays spreadsheet.

Preferences Displays Preferences window.

Open Base Pair Standard Curve Displays BP Standard Curve window.

Quantification Setting Displays Quantification Setting window.

Preferences Display Preferences dialog box.

Multi-Band 
Color Separation

Displays Multi-Band Color Separation 
window.

Open Spreadsheet

Volume Calculation

Set Marker

Preferences

Open Base Pair Standard Curve

Quantification Setting

Multi-Band Color Separation

Overlay Trace
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Multi-Band Color Separation Tools

Tool Description

Band Colors Select a band color for the selected band.

None No color is assigned. Does not use band for multi-
band color separation.

Overlap Overlapped band. Does not use band for multi-band 
color separation. 

Not Band Band is not listed in template. Color list is shifted 
down.

Skip The Detected Band numbering skips the band.

Band Colors None
Overlap

Not Band

Skip
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Trace Overlay Tools

Tool Description

Zoom In Vertically Magnify in vertical direction.

Zoom Out Vertically Reduce in vertical direction.

Drawing Use drawing tools for Overlay Trace window.

Overlay Trace Setting Displays Overlay Trace Setting window.

Zoom In Vertically

Zoom Out Vertically

Drawing Tool

Overlay Trace Setting
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Array Tools

Tool Description

Drawing Use to draw text and graphics.

Select Select objects.

Create Rectangle Spot Define a rectangular shaped spot.

Create Oval Spot Define an oval shaped spot.

Create Grid Spot Define a grid over an array of spots.

Show/Hide 
Spot Information

Toggle display of spot information.

Show/Hide Comment Toggle display of label information.

Drawing Tool

Select Tool

Create Rectangle Spot

Create Oval Spot

Create Grid Spot

Show/Hide Spot Information

Show/Hide Comment
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Command Description

Set Selected 
Spots to Background

Used selected spots to represent the back-
ground value.

Set Selected 
Spots to Marker

Uses selected spots as the markers.

Calculation Performs a calculation.

Open Standard Curve Displays the Standard Curve window.

Open Spreadsheet Displays the Spreadsheet window.

Preferences Displays the Preferences window.

Array Template Save or apply spots and grids.

Set Grid Marker Displays the Grid Marker Setting 
window.

Set Selected Spots to Background

Set Selected Spot(s) to Marker

Calculation

Preferences

Set Grid Marker

Open Standard Curve

Open Spreadsheet

Ungroup

Group

Array Template

Grid Comparison
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Drawing Tools
For a description of the Drawing tool icons, see Chapter 8, Drawing Tools.

Tools Index
This an index of all tool buttons in Image Analysis.

Group/Ungroup Group the selected spots/grids.

Grid Comparison Opens the Grid Comparison module.

Command Description
A - 13



FMBIO®
A - 14



Tools
A
Align Bottom  8-9
Align Center  8-13
Align Horiz Center  8-9
Align Left  8-8, 8-13
Align Right  8-8, 8-13
Align Top  8-9
Align Vert Center  8-8
Area Selection  5-6, 5-8, 5-26, 5-29
Arrow  8-12
Automatic Band Detection  5-41, 5-

46, 5-66, 6-4, 6-13, 6-23, 6-
30, A-6

B
Band Color  5-50, 6-25
Band Edit  5-41, 5-67, 6-4, 6-13, 6-

30, A-6
Band Style  5-42, 5-70, 6-5, 6-13, 6-

30
Bold  8-13
Bring Forward  8-8
Bring to Front  8-8

C
Calculate, Array  7-20
Calculation  7-3, 7-20, A-12
Circle  8-12
Color Separation  5-6, 5-32, 5-35, 

A-4
Create Grid Spot  7-2, 7-8
Create Oval Spot  7-2, 7-6
Create Rectangle Spot  7-2, 7-6

D
Delete Band  5-41, 6-4, A-6
Diamond  8-12
Double-headed Arrow  8-12
Drawing  5-92, 7-2, 8-2

E
Edit Polygon  8-9
Ellipse  8-7
Export Image  5-6, 5-8

F
Fit Window  5-7
Font  8-13

G
Gray Level Adjustment  5-6, 5-16, 

6-9, 6-20, A-4
Grid Comparison  7-3
Group  7-3, A-12

I
Image Information  5-6, 5-28, A-4, 

A-5
Italic  8-13
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L
Lane Alignment  5-41, 6-4, A-6
Lane Selection  5-41, 5-46, 5-53, 6-

4, 6-23, A-6
Lane Style  5-42, 5-56, 6-5, 6-12, 6-

28
Lane Template  5-58, 5-60
Line  8-7
Line Color  8-11
Line Marker Style  8-12
Line Selection  5-6, 5-29
Line Type  8-11
Line Width  8-11
Lock  8-9

M
Marker Setting  5-71, 6-14, 6-18, 6-

31
Moving  5-7
Multi-Band Color Separation  5-40, 

5-47, 6-3, 6-23, A-8
Multiple Lane Selection  5-41, 5-54, 

6-4, 6-11, 6-27, A-6

N
New Overlay Trace  5-90
New Project  5-3, 5-38, 6-8
No Line  8-11
None  5-50, 5-51, 6-25
Not Band  5-50, 6-25

O
Open BP Curve  5-40, 5-76, 5-78
Open Project  5-3
Open Spreadsheet
A-16
1D-Gel  5-40, 5-86, 5-89, 6-3,
6-15, 6-32, 10-8, A-8

Array  7-3, 7-16, 7-21, A-12
Open Standard Curve  7-3, A-12

1D-Gel  5-40, 5-76, 5-78, 5-83,
6-3, A-8

Array  7-17
Oval  8-7
Overlap  5-50, 6-25
Overlay Trace  5-40, 6-3, A-8
Overlay Trace Setting  5-92, 5-93

P
Paint Color  8-10
Paper Position  8-7
Polygon  8-7, 8-12
Polyline  8-12
Preferences

1D-Gel  5-40, 5-43, 5-64, 5-77,
5-80, 5-84, 5-87, 6-3,
6-22, A-8

Array  7-3, 7-7, 7-12, 7-15, 7-
18, 7-20, A-12

Print  5-98

Q
Quantification  7-15
Quantification Setting  5-40, 5-82, 

6-3, 6-30, A-8

R
Rect  8-7
Rotate Text...  8-4, 8-13

S
Save Project  5-3
Select
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1D-Gel  5-41, 5-56, 6-4, A-6
Array  7-2, 7-6, 7-7, 7-10
Draw  8-7

Select Line Type  8-11
Send Backward  8-8
Send to Back  8-8
Set Grid Marker  7-3, A-12
Set Marker  5-40, 6-3, A-8
Set Selected Spot(s) to Marker  7-3, 

7-15, A-12
Set Selected Spots to Background  

7-3, 7-14, A-12
Show Image Setting Dialog  5-6, 5-

11, A-4
Show Spectrum  5-6, 5-27, 5-29
Show/Hide Band Information  5-42, 

5-88, 6-5
Show/Hide Comment

1D-Gel  5-42, 6-5
Array  7-2

Show/Hide Lanes  5-42, 6-5
Show/Hide Spot Information  7-2
Skip  5-50, 6-25
standard curve type  7-14
Straight Line  8-12

T
Text  8-7
Text Color  8-13
Transparency  8-10
Transparent Background  5-6, 5-36

U
Underline  8-13
Ungroup  7-3, A-12
Unlock  8-9
V
Volume Calculation  5-40, 5-84, 5-

89, 6-3, 6-15, 6-31, 10-7, 
A-8

Z
Zoom In  5-7
Zoom In Vertically  5-92
Zoom Out  5-7, A-3
Zoom Out Vertically  5-92
Zooming  5-7
A-17
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Index
Symbols
1D-gel

analysis  6-1,  6-6
defining bands  5-63
genotyping  10-7
menu  5-38
spreadsheet  5-86
tools  5-38,  A-6

605-nm filter  4-13

A
about, STaR Call  10-10
AC power  3-3
acrylamide gel  4-7
active channel  4-14
adding STR  10-20
agarose gel  4-7
All Area  4-18
allelic ladder  10-16,  10-16,  10-20
analysis worksheet  10-18
analyzing spots  7-6
area selection  5-6
Array

experiment  7-4
menu  7-1,  7-11
tools  7-2,  A-11

Auto Band  5-63
Auto Focus  3-12,  4-13
B
background

Array  7-12
cutoff threshold  4-11
gray level adjustment  5-81
percent  5-46
subtraction  5-81
value  5-81

Background Area  5-46
band

adding  5-67
area  5-45
boundary lines  5-69
deleting  5-68
display  5-13
editing  5-67
hiding  5-69
information  5-87
manual input  5-67
merging parameters  5-43
moving  5-68
recognition  5-63
volume  5-80,  6-6
volume percent  6-6

base pair  6-6
standard curve  5-76

Basic channel  5-33
batch analysis  5-99
Blend display mode  5-12,  5-33
buttons  A-2



Index
C
calling alleles  10-1 to 10-3
channel

active  4-14,  5-13
color  5-12,  5-13
displaying  5-12
sensitivity  4-8

cleaning
glass plates  3-9
sample stage  3-9
scanning unit  4-22,  9-1

closing Read Image  4-20
CMF

header version  10-22,  10-23
message ID  10-22
message type  10-22
type  10-22
version  10-23

CODIS  10-10,  10-12
preparing data for  10-21
specimen information  10-27

codisdbf.xls  10-9
color separation

excluding a channel  5-35
individual band  5-32
modifying results  5-35
theory  5-30

Color Separation window  5-33
Command menu  4-10 to 4-12,  4-21
comments  4-18
comparing

analyses  10-17,  10-21
grids  7-23
Index-2
creating
Array experiment  7-4
grid  7-7
oval spot  7-6
rectangle spot  7-6

creation date/time  10-22
curve fitting, least squares  5-77
cutoff threshold  4-11,  5-14,  5-81

fields  5-16,  5-23
histogram  5-17

D
Data Sheet filecard  7-24
Display Channel  5-28,  A-5
display mode  5-12
displaying

spreadsheet  7-20
standard curve  7-17

dpi  4-8
Draw

menu  8-2,  8-2
objects  8-14,  8-14
text attributes  8-13
tools  5-92,  8-2,  8-7,  A-13

Draw 1 tools  8-2,  8-7
Draw 2 tools  8-2,  8-8
Draw 3 tools  8-2,  8-10
Duration  5-65
dyes and stains, table  1-7

E
edge filter, long pass  4-25
Edit

menu  4-20
tools  A-2



Index
editing lane boundaries  5-56
eject filter  4-22
electrophoretic mobility  6-6
emission filter  4-25
error

codes  4-32
detected  3-3
light  9-3

evaluating alleles  10-9
Excel  10-9
excluding lane  10-24
exporting

image  5-7
lane trace data  5-94
markers  5-73
spreadsheet  7-22,  10-8
to CODIS  10-21

F
File menu, Read Image  4-20
File tools  A-2
filter

605 nm  4-13
eject  4-22
emission  4-25
long pass  4-25
orange glass  4-25
red glass  4-25
table of dyes and stains  1-7

FMBIO II
menu  4-13,  4-22
parameters  4-4
software requirements  2-3
FMBIO IIe
location requirements  2-2
printer requirements  2-5
shipment package  2-1
shutdown  9-3
specifications  1-5

focusing point  4-9

G
gamma level  5-13
Genotype  10-12
genotyping  10-1 to 10-27
glass plates

cleaning  3-9
loading  3-10 to 3-11
orientation  3-10
specifications  3-9

Gradient
End  5-65
Start  5-65

gray level adjustment  4-10,  5-14,  
5-16

grid  7-25
histogram  5-17
showing range  5-18
template  5-24
visually defining  5-22

grid
cell marker  7-16
comparison  7-23
expression ratio  7-32
modifying  7-10
options  7-7
screening  7-29
templates  7-17
volume ratio  7-32
Index-3



Index
Grid Comparison filecard  7-32
grouping, spots and grids  7-10

H
help, STaR Call  10-10
High (signal)  5-28
high signal cutoff threshold  4-11,  

5-14
histogram  5-17,  5-21

I
icons

ImageAnalysis  A-2
image

adding  5-4
diagnostic guide  5-25
exporting  5-6,  5-7,  A-4
icon  5-4
information  5-6,  A-4
margins  8-3
menu  5-4
multi-color  5-9
setting  5-11
tools  5-4,  A-3

imaging
system organization  10-22
system utilized  10-22

importing
markers  5-73
STR files  10-14,  10-20

installing
STaR Call  10-2,  10-4

K
keyboard shortcuts  A-1
Index-4
L
laboratory ORI  10-22
lane

boundary lines  5-52,  5-56
copying and deleting  5-57
list  10-24
selecting  5-57
template  5-57,  6-4

lane detection
auto  5-55,  6-4,  6-11
manual  6-11

Lane window  5-48
magnification  5-48

lane/marker name  10-24
laser

beam  3-4
head  9-2

line selection  5-6
long pass filters  4-25
Low (Background)  5-28

M
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	Figure 1-1. Interior view of FMBIO scanning unit

	FMBIO Specifications
	Software Features
	FMBIO Read Image
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	Fluorescent Labels
	Table 1-1: Dyes and Stains Detected with the FMBIO

	2 Installation

	Preparing for Installation
	Contents of FMBIO Shipment

	Installing the Scanning Unit
	Installing the FMBIO Software
	1. Turn off the screensaver.
	2. Disable all virus protection programs.
	3. On the CD, open the ReadMe file to find out about changes and updates.
	4. Click the Start button, then choose Run....
	5. Enter the pathname for the setup.exe file on the CD (for example, D:\setup.exe), then click OK.
	6. Follow the instructions on the screen.
	File Compression
	Understanding Personal Computers
	Setting Color Display
	1. In the Windows Taskbar, click on the Start button. Choose Settings > Control Panel.
	2. In the Control Panel window, double-click the Display icon.
	3. Click the Settings tab, then select the 256 Colors setting or higher.

	Printer
	Peripheral Storage Devices
	3 Operating the Scanning Unit
	1. Start ReadImage software. See page�3-2.
	2. Turn on power to the FMBIO scanning unit and wait for the self-diagnosis routine to finish. Se...
	3. Check that the 605-nm filter is in Channel 1 for autofocusing. See page�3-5.
	4. Clean the sample plates and scanner sample stage. See page�3-8.
	5. Load the sample on the FMBIO sample stage. See page�3-10.
	6. Choose the appropriate parameter set in the ReadImage dialog box and, if necessary, adjust the...
	7. Use ReadImage software to begin scanning the sample. A scan may take from five to ninety minutes.



	Starting the FMBIO Scanner
	Figure 3-1. Inside front panel with Power switch
	Figure 3-2. Rear view of FMBIO scanning unit
	1. Turn on the computer that is connected to the scanner by a SCSI cable.
	2. Set the Main switch to the On ( | ) position.
	3. Open the front panel of the scanning unit and turn on the Power switch.

	Self-diagnosis Normal
	Error Detected
	Autofocus Calibration
	Inserting Optical Filters
	1. To stop the scan, click the Pause button.
	2. A dialog box opens to display three options: Save, Don’t Save, and Cancel:
	3. In the FMBIO menu, turn off Autofocus. See the directions for setting an autofocus on page�4-13.
	4. Replace the 605-nm filter and restart the scan. See the directions for changing the optical fi...
	1. Choose Eject Filter in the FMBIO menu.
	2. Open the front panel, then open the optical filter service door.
	3. Pull out the appropriate filter holder.
	4. Hold the filter holder in your left hand, so that the arrow on the edge faces you and points t...
	5. In this position, find the two set screws in the groove on the right edge of the filter holder...
	6. Use a 1.5-mm Allen wrench to loosen the set screw that holds in place the filter you want to c...
	Figure 3-3. Changing optical filters
	7. After one full turn of the set screw, hold the filter holder over a clean, lint-free tissue an...
	8. Return the filter holder to a horizontal position and hold the replacement filter over the app...
	9. Turn the set screw one full turn to tighten the filter.
	10. Return the filter holder to its place in the scanning unit. Be sure the finger hole in the fi...



	Preparing for Scanning
	Opening the Cover
	Figure 3-4. Front view of FMBIO scanning unit

	Glass Plates
	Scanner Sample Stage

	Loading the Sample
	Figure 3-5. Loading the glass plates on to the scanner bed
	Orientation of glass plates
	Removing spacers
	1. Set the Power switch to the On position and open the cover of the scanning unit.
	2. Clean and thoroughly dry the surfaces of the glass plates. You may want to mark the front of t...
	3. Before putting the glass plate on the scanner bed, adjust the sliding sample support so that i...
	4. Carefully and firmly place the end of the longer glass plate up against the sample alignment s...
	5. As you carefully begin to lower the rear end of the glass plate to lay flat on the scanner bed...
	6. When both ends of the glass plate are firmly supported on the scanner bed, gently close the sc...


	Scanning the Image
	Beginning the Scan
	Auto Focus

	Stopping a Scan
	1. To stop a scan in progress, click Pause.
	2. A dialog box offers three actions after you click Pause: Save, Don’t Save, and Cancel:


	Scanning Guidelines
	Auto Focus
	PreRead
	Scan area
	Time
	Repeats
	Signal.
	Resolution
	Saving parameters
	Multiple scans of the same gel
	4 Read Image Software

	Opening Read Image
	Read Image Files
	Setting the Parameters
	Additional Scanning Parameters

	Features of the Parameters Window
	1. In the Parameter Name pull-down list, choose the material type you want to scan.
	2. Examine the parameters in the window and modify them as needed to accommodate your particular ...
	3. Click OK to apply the scanning parameters to your scan. See page�4-15 for information about de...
	Defining the Parameter Name
	Selecting SCSI ID
	Setting the Reading Resolution
	Reading Sensitivity
	Setting Repeats
	Focusing Point

	Settings in the Command Menu
	Preparing to Scan
	Setting Gray Level Adjustment
	Cutoff Thresholds
	1. Choose Gray Level Adjustment... in the Command menu.
	2. Enter cutoff threshold values in the fields labeled Low (Background) and High (Signal).
	3. Click OK to save the Gray Level Adjustment settings.


	Defining Image Orientation

	Settings in the FMBIO II Menu
	Performing an Autofocus
	Performing an autofocus as part of a routine scan
	1. Place the 605-nm filter in Channel 1. See page�3-6 for directions.
	2. Select Auto Focus in the FMBIO menu.
	3. Select the appropriate ReadImage settings and load the sample.
	4. Click the Read button on the Scan Control window.


	Selecting Active Channels
	1. Before beginning a scan, place the appropriate filters in the filter holders.
	2. Choose the corresponding channels in the FMBIO menu to make them active. Read Image collects e...
	3. Check the reading sensitivity setting for each active channel in the FMBIO Parameter window. S...


	Scan Control Window
	Using the Scan Control Window
	Defining Scan Area
	1. Click the PreRead button to preview the pre-defined scan area.
	2. To redefine the scan area, place the cursor in the scan area and drag it to the area of intere...

	Adding Comments
	Read

	Additional Features
	File Menu
	New
	Open
	Close
	Saving Read Image Files
	Recent Files
	Exit

	Command Menu
	Read
	PreRead
	Set Parameter...
	Set Gray Level Adjustment..., Orientation

	FMBIO Menu
	Auto Focus
	Channels
	Do Cleaning
	Eject Filter


	Imaging Basics
	Multi-Color Images
	Long Pass Filters

	Example Scanning Process
	1. Turn on power to the computer.
	2. Turn on power to the FMBIO II. (The switch is behind the pull-down panel, on the front left).
	3. After electrophoresis has been performed, keep the polyacrylamide gel- plate assembly together...
	4. Place the gel-plate assembly in the scanner.
	a. Press the button on the top right of the front of the instrument, and open the sample door.
	b. Slide the right side stage bar to the proper distance to support the plate, without obscuring ...
	c. Place the plate assembly (long plate face down) on the stage, resting the plate assembly on th...

	5. Start the FMBIO II Readlmage program.
	6. Click the Setting button. The Read Image Parameter dialog box is displayed.
	7. Set the Scanning parameters:
	a. Choose the Parameter Name. In this example, Acrylamide is entered.
	b. Choose the resolution. 150 dpi is an example for the initial setting.
	c. Enter the sensitivity. In this example, 80% is enter for Channels 1 and 3, and 100% for Channe...
	d. Enter the focusing. 0 is shown in this example. It may need to be lower for the thinner plates...
	e. Choose the number of repeats. A example initial setting is 256.
	a. Click OK to return to the Scan Control window.

	8. In the FMBIO II menu, set the active channels. A separate image is collected for each channel.
	9. Since the instrument will always autofocus before the first read after power-up, turn Auto Foc...
	10. In the Command menu, set the gray level adjustment for polyacrylamide gels. Examples might be...
	11. Make any changes needed to Orientation in the Command menu.
	12. Add any comments to an image file by typing those comments in the text box in the lower secti...
	13. Click the PreRead button to quickly identify the gel area to scan.
	14. Designate the scan area by dragging with the mouse from top left to lower right in the viewin...
	15. Click Read. Specify a file name, and a location for the saved file.
	16. Wait for the instrument to complete all of its scans. The FMBIO II will autofocus and might s...
	17. To view the results, use the Image Analysis software.
	18. Adjust the grayscale to optimize the image.
	19. If the image is satisfactory, proceed to Chapter 5.
	20. If the grayscale adjustment does not produce an adequate image, make the adjustments suggeste...
	Table 4-1: Image Troubleshooting Guide

	ReadImage Error Codes
	Error code = 161, 162, 163, 164, 165, 167, or 169
	1. Press the Power switch to the Off position and wait at least 5 seconds.
	2. Press the Power switch to the On position.
	3. If the error code persists, call Hitachi Software Engineering service personnel.

	Error code =166
	Error code = 168
	Error code = 192.
	Error code = 193.
	5 Image Analysis Tools

	Image Analysis Projects
	Creating a New Project
	Opening a Project
	Saving a Project

	Image Menu and Tools
	1. In the Project menu, choose New 1D-Gel Experiment or New Array Experiment.
	2. Select an image file from the directory window. The image icon is added to the project tree.
	3. Double-click the image icon to display the selected image.
	1. Click the button. The cursor transforms into a magnifying glass with a “+” sign.
	2. Drag the magnifying glass cursor to create a rectangle surrounding a region of the image. The ...
	Saving an Image
	1. If you want to crop the image, click the Select area to draw buttonor choose Area Selection fr...
	2. Choose Save Image as... from the Image menu. The Save Image as dialog box is displayed.
	3. Select the appropriate parameter settings, and click OK. The Save As dialog box is displayed.
	4. Specify a location for the file in the Directory window, and enter a filename
	5. Click the Save button.

	Viewing a Multi-Color Image
	1. Click the folder expansionsymbol next to the image icon to display the names of each layer in ...
	2. In this example, during one multi-color scan CTTv, DDDD, and inlane- CXR were the active chann...


	Image Setting Dialog Box
	Display Mode
	Displaying a Channel
	Changing Channel Color
	Changing Intensity Level
	Displaying Detected Bands

	Gray Level Adjustment
	Cutoff Thresholds
	Gray Level Adjustment Window
	Channel Selector
	Background and High Signal cutoff thresholds
	Histogram
	Show Selected Range
	Mapping Type Selector

	Procedure
	Using the histogram
	1. Select a channel and mapping type.
	2. To adjust the high signal cutoff threshold value, place the pointer over the blue line. The po...
	3. Drag the line along the gray level axis until the desired value is displayed. The new high sig...
	4. To adjust the background cutoff threshold value, place the pointer over the red line. The poin...
	5. Drag the line along the gray level axis until the desired value appears. The new background cu...
	6. Click the Try button to apply the modified gray levels to the actual image. To return to the o...
	7. Continue to try different gray level settings until your are satisfied with the signal and bac...
	8. Repeat the procedure for each channel.
	9. When you are finished, click OK.

	Visually defining signal and background pixels
	1. Select a channel and mapping type.
	2. In the Whole Image window, drag the Zoom Cursor to a region containing average intensity bands...
	3. In the Zoom window, surround a band with the Selection Cursor.
	4. Click the High Signal button. The image displays appear with the new high signal cutoff thresh...
	5. Move the Selection Cursor to a background area away from the band.
	6. Click the Background button. The selected background cutoff threshold is applied to the Whole ...
	7. Click the Try button to apply the modified gray levels to the actual image. To return to the o...
	8. Continue to try different gray level settings until your are satisfied with the signal and bac...
	9. Repeat the procedure for each channel.
	10. When you are finished, click OK.

	Using the percent and number fields
	1. Enter numbers in either the percent or absolute value fields, and then click OK.
	2. Click the Try button to apply the modified gray levels to the actual image. To return to the o...
	3. Continue to try different gray level settings until your are satisfied with the signal and bac...
	4. Repeat the procedure for each channel.
	5. When you are finished, click OK.

	Creating a template
	1. Click the Template button.
	2. Click the Create New button. The Template dialog box is displayed.
	3. Type a unique name for the template, then click the Close button.
	1. Select a channel.
	2. Click the Template button.
	3. Select the template name, then click the Apply button.


	Image Diagnostic Guide

	Spectrum
	Area Selection Method
	1. Click the Area Selection buttonor choose Area Selection from the Image menu.
	2. Position the tool at a corner of the group of bands you want to select. Drag the cursor down t...
	3. Release the mouse button. A selection rectangle is displayed. If necessary, adjust the rectang...
	4. Click the Spectrum View buttonor choose Show Spectrum from the Image menu. The Spectrum window...
	5. To change the dimensions of the graph, resize the window.
	Normalize Baseline tool

	Straight Line Method
	1. Click the Area Selection buttonor choose Line Selection from the Image menu.
	2. Drag the cursor in a straight line over the location you want to analyze.
	3. Release the mouse button. A selection line is displayed. If necessary, adjust the line by drag...
	4. Click the Spectrum View buttonor choose Show Spectrum from the Image menu.


	Color Separation
	Color Separation Theory
	1. Calculate the bleed-through rate:
	2. The bleed through rate (Rab) is calculated for each pixel value in Channel 2 and the correspon...
	3. The operations explained above for Channel 1 are then applied to Channel 2.

	Individual Band Color Separation
	1. Click the Color Separation buttonor choose Color Separation from the Image menu.
	2. Choose a channel from the Selected Fluorophore drop-down list box, and select a color.
	3. In the Whole Image window, move the Zoom Cursor to an area with medium intensity bands of that...
	4. In the Zoomed Area window, pick a band of medium intensity that matches the color, but does no...
	5. Click the Set button to make the color of the selected band represent the fluorophore. Image A...
	6. Use one of the other channels in the Selected Fluorophore list.
	7. Repeat this process for each of the remaining channels.
	8. If the Color Separation parameters are to be used again in the future, click the Template... b...
	9. When you are satisfied with the color settings, click OK.
	10. If you want to remove the color separation, uncheck the Show Color- Separated Images checkbox...

	Using a Color Separation Template
	1. Click the Color Separation buttonor choose Color Separation... from the Image menu.
	2. Once the Color Separation window has opened click the Template... button. The Template dialog ...
	3. Select a template, then click the Apply button.
	4. Click Close.
	5. Click OK. The selected Color Separation template is applied to the new image.

	Modifying Color Separation Results
	1. In the Image Setting dialog box, turn off the Show color-separated images option.
	2. Click the Color Separation buttonor choose Color Separation... from the Image menu.
	3. Choose one of the overlapping dyes (carboxy-x-rhodamine) from the Selected Fluorophore drop-do...
	4. In the Target Channel section, enter a zero (0) in both the Background and Percent entry field...
	5. In the Mode section, click Preview to examine the new values in the Whole Image window and Zoo...
	6. In the Selected Fluorophore list, use the drop-down list to choose the second overlapping dye ...
	7. Enter a zero (0) in both the Background and fluorescein Percent entry fields.
	8. Preview the color separation.
	9. If you want to remove the color separation, uncheck the Show Color- Separated Images checkbox ...

	Transparent Background

	1D-Gel menu and Tools
	1. Click the New Project buttonor choose New Project from the File menu.
	2. Choose New 1D-Gel Experiment from the Project menu.
	Multi-Band Color Separation
	Band Selection Parameters
	1. Choose New 1D-Gel Experiment from the Project menu.
	2. Click the Preferences buttonor choose Preferences... from the 1D-Gel menu.
	3. Click the Multi-Band Color Separation tab. This filecard displays the default Band Selection P...
	4. Try these settings and, if necessary, adjust them for different gels:
	Overlap
	Band Area
	Background Area 1
	Background Area 2
	Background %

	Multi-Band Color Separation Window
	1. Find a portion of a lane containing a minimum of one non-overlapping band of each color.
	2. Click the Lane Selection Tool buttonor choose 1D-Gel > Tool > Lane Selection. Drag down and th...
	3. Click the Automatic Band Detection buttonor choose 1D-Gel > Function > Auto Band.
	4. After Image Analysis has automatically detected the lane, click the Multi-Band Color Separatio...
	Lane Window
	Magnification Selector
	5. If you are not satisfied with the separation of the colors, you can adjust the Multi-Band Colo...
	6. On the right side of the window the Status Edit Sheet displays the detected band numbers.
	7. Review each band in the Status Edit Sheet, verifying that the assigned colors are representati...
	8. If you want to change the color or status of a band, click its row in the Status Edit Sheet. T...
	9. If this Multi-Band Separation Marker is to be used in the future (i.e. Controls such as K562, ...
	10. Once the bands have been verified, then click OK. The Color Separation window is displayed wi...
	11. Click Preview. Image Analysis performs the multi-band separation on the images in the Color S...
	12. If the Color Separation parameters are to be used again in the future, click the Template... ...
	13. Click OK. Image Analysis creates a set of color separated images, each channel displaying onl...
	14. If you want to remove the color separation, uncheck the Show Color- Separated Images checkbox...



	Indicating Lanes
	Defining a Single Lane
	1. Click the Lane Selection Tool buttonor choose 1D-Gel > Tool > Lane Selection.
	2. Position the tool at a corner of the lane. Drag the cursor down to the opposite corner below t...

	Defining Multiple Lanes
	1. Click the Multiple Lane Selection Tool buttonor choose 1D-Gel > Tool > Multiple Lane Selection.
	2. Position the tool above the top migration line at the corner of the first lane in a sequence o...
	3. Drag the tool below the bottom migration line to the opposite corner of the last lane in the s...
	4. Release the mouse. The Multiple Lane Setting dialog box is displayed.
	5. Choose either Automatic Lane Detection and Fitting or Manual Input.
	6. Click OK. By default, Image Analysis displays a central line down each defined lane, with addi...

	Displaying Lane Lines
	Editing a Lane Boundary
	Copying and Deleting Lanes
	Selecting Multiple Lanes
	Lane Templates
	1. Click the Lane Template buttonor choose Lane Template... from the 1D-Gel menu. The Template di...
	2. Click the Add button. In the Lane Template Saving dialog box, deselect any lanes you do not wa...
	3. Click Save.
	4. Assign a unique name when prompted, then click OK.
	5. The template name is listed with the number of saved lanes in brackets.
	1. Click the Lane Template buttonor choose Lane Template... from the 1D-Gel menu, then select the...
	2. Click Apply.


	Defining the Migration Area
	1. Click on a migration line. Each migration line has a handle at each end.
	2. Click the left or right handle and drag it to change the angle of the migration line with resp...
	3. Click on any other point along the migration line and drag it up and down to move the migratio...

	Defining Bands
	Automatic Band Detection
	Automatic Band Detection Preferences
	Using the Auto Band Tool
	1. Choose Select All from the Edit menu to select all lanes for automatic detection, or hold down...
	2. For each detected band, Auto Band creates a Band Start line, Band Peak line, and Band End line...
	3. Check the accuracy of the automatic detection. Switch from one to the other channel by selecti...
	4. Magnify the image to view individual bands more closely. If you still cannot view a detected b...
	5. If necessary, you can manually add, move, and delete band lines. See Manual Band Input on page...
	6. To customize you auto band detection, adjust the Automatic Band Detection preferences, page�5-64.


	Manual Band Input
	1. Double-click on the lane you want to edit. The lane is selected and the Band Edit buttonis act...
	2. Magnify the image with the Zoom tools to view the band.
	3. Align the Band Edit cursor over the center of the band image.
	4. Click on the band. Image Analysis places the band lines onto the band, and the cursor transfor...
	5. Drag the Band End line down to the desired position, then release the mouse button.
	6. Go back and click on the group of band lines. The Band Start line becomes active. Drag the Ban...
	Moving bands
	1. Double-click on the lane you want to edit. The lane is selected and the Band Edit buttonis aut...
	2. Click on the band line to select it. The band line changes from yellow to violet.
	3. Drag the band line to the new position.

	Deleting bands
	1. Draw a rectangle around the bands you want to delete.
	2. Press the Delete key.
	1. Double-click on the lane you want to edit. The lane is selected and the Band Edit buttonis aut...
	2. Click on any band line to select it. The band line changes from yellow to violet.
	3. Press the Delete key.

	Hiding bands
	Displaying band lines.


	Standard Markers
	Registering Markers
	1. Click the Marker Setting buttonor choose 1D-Gel > Marker....
	2. Select a channel and a marker mode from the drop-down list boxes. There are three marker modes:
	3. Click on the lane numbers in the list that contain the same marker. To select more than one la...
	4. Select the marker from the Marker list.
	5. Click the Set Marker to >> button.
	6. Continue this process for each marker or marker group.
	7. Click OK to complete the marker registration.

	Importing and Exporting Markers
	1. Click the Import... button. The Open File dialog box is displayed.
	2. Select a marker set file, and click the Open button. The size markers are added to the BP Valu...
	1. Click the Export... button. The Save As dialog box is displayed.
	2. Enter a name for the marker set, and click Save.

	Working with Marker Templates
	Adding Marker Templates
	1. Click the Add button. The New Marker dialog box is displayed.
	2. Enter the name of the marker template, then click OK.
	3. Select the new marker, then enter the length of the marker band in the BP field.
	4. Click Add. The new band length appears in the BP list.
	5. Repeat this process for each band in the new marker.

	Base Pair Standard Curve
	1. Click the Open BP Curve buttonor choose Open BP Curve from the 1D-Gel menu. The curve is fitte...
	1. Click the Preferences buttonor choose Preferences... from the 1D-Gel menu, then click the Calc...
	2. Click on the Use Least Squares Method for bp calculation option to place a checkmark in the box.
	3. Click OK. The calculation is performed automatically.
	4. Click the Open BP Curve buttonor choose Open BP Curve from the 1D-Gel menu. In addition to the...


	Calculating Volumes and Peak Heights
	Background Value
	Background of Gray Level Adjustment
	User Defined

	Calculating Normalized Volume (IOD)
	Volume Calculation Types
	Type 1
	Type 2
	Type 3
	Type 4

	Setting Quantification Markers
	1. Click the Quantification Setting buttonor choose Quantification Setting... from the 1D-Gel menu.
	2. Select a channel from the drop-down list box.
	3. Select a lane number containing standard markers from the drop-down list box. The defined band...
	4. Click on a marker band to highlight it, then enter a concentration value in the field below th...
	5. Click Enter. The value appears in the Concentration column.
	6. Continue to enter concentration values for all marker bands.
	7. Place a checkmark in the box next to each marker band you want to use.
	8. Select a standard curve fit in the drop-down list.
	9. Select a straight line or logarithmic X-axis scale.
	10. Click OK.
	11. Click the Open Standard Curve button or choose Open Standard Curve from the 1D-Gel menu. The ...

	Volume Calculation
	Displaying Results
	1. Click the Preferences buttonor choose Preferences... from the 1D-Gel menu, then click the Band...
	2. Select the variables to display.
	1. Click the Template... button. The Template dialog box is displayed.
	2. Click the Add... button, and type in a name for the template. The default name for the first t...
	3. Click OK, and then click Close.
	Spreadsheet Display
	1. To display a spreadsheet of results, click the Open Spreadsheet buttonor choose Open Spreadshe...
	2. Select a channel by clicking its tab at the bottom of the spreadsheet.

	Entering Spreadsheet Data
	1. Click on the field.
	2. Enter the data.

	Band Information display
	1. Click the Preferences buttonor choose Preferences... from the 1D-Gel menu, then click the Band...
	2. Select the lanes. The information is displayed next to the band.


	Updating Spreadsheet Values
	Exporting the Spreadsheet
	1. Click the Open Spreadsheet buttonor choose Open Spreadsheet from the 1D-Gel menu.
	2. Choose Export... from the SpreadSheet menu.
	3. In the Save As dialog box, select a location for the file, and then enter a unique name.
	4. Click Save.


	Overlay Trace
	Overlay Trace Window
	1. Open one or more 1D-Gel Experiment windows that have defined lanes.
	1. Select the lane or lanes of interest by clicking the Arrow cursor on the desired lane. Shift-c...
	2. A maximum of 16 lanes may be converted into Lane Trace format at one time.
	3. Click the New Overlay Trace buttonor choose New Overlay Trace from the 1D-Gel menu. The Overla...
	Vertical Zoom tools
	Drawing tools
	1. Click the Drawing Tool buttonor choose Draw from the Trace menu. The Drawing Tool bars become ...
	2. Use the Drawing tools to draw and type text on the overlay trace. See Chapter 8, Drawing Tools.
	3. When you have finished, choose Save Project... from the File menu. An Overlay Trace icon is ad...


	Overlay Trace Setting Window
	Exporting Lane Trace Data
	1. Define the desired lanes in the images.
	2. View the lane traces if desired.
	3. The lane trace data can be exported to a folder as a set of Microsoft Excel spreadsheets by ch...
	4. Specify the folder to store the files, and click Select.
	5. Open the desired file in Microsoft Excel.
	6. The spreadsheet displays the migration distance (mm) and the intensity (OD) of the trace.


	Printing
	Print Setup
	Print Preview
	Printing

	Batch Analysis
	Procedure
	1. Choose Batch Control from the 1D-Gel menu. The 1D Batch Control dialog box is displayed.
	2. Choose the templates and enter the appropriate parameters in the fields.
	3. If you want to use this set of Batch Control settings again, click on the Save/Load Setting......
	4. Click the Add... button, and enter a name for the Batch Control template.
	5. Alternatively, if you want to Load a previous Batch Control template, select the template by c...
	6. When you have finished entering the parameters, click OK in the Batch Control dialog box. Imag...

	6 1D-Gel Analysis
	1D-Gel Menu and Tools
	1. Choose New 1D-Gel Experiment from the Project menu.

	Analyzing 1D-Gels

	Summary of Analysis Steps
	1. Open project.
	2. Create 1D-Gel analysis.
	3. Adjust gray level.
	4. Set lanes.
	5. Set migration lines.
	6. Perform color separation (if required).
	7. Review image.
	8. Autoband.
	9. Set markers.
	10. Calculate base pairs.
	11. View results.

	Single-Color Experiment Flowchart
	Single-Color Experiment Procedure
	Create a New Project (page�5-3)
	1. In the File menu, click the New Project buttonor choose New Project. A new Project window is d...
	2. In the Project menu, choose Add Image..., then select a file that contains a digital image of ...

	Create 1D-Gel analysis (page�5-14)
	Adjust Gray Level. (page�5-14)
	1. Click the Gray Level Adjustment buttonor choose Gray Level Adjustment from the Image menu. The...
	1. In the Full Image Display, drag the Zoom Cursor to a region containing average intensity bands...
	2. The area appears in the Zoom Display.
	3. In the Zoom Display, surround a band with the Selection Cursor.
	4. Move the Selection Cursor to a background area away from the band, then click the Background b...
	5. Use the High Signal and Background threshold marker lines in the histogram to adjust the gray ...
	6. When you have finished, click OK.

	Set Lanes (page�5-52)
	1. Click the Multiple Lane Selection Tool buttonor choose 1D-Gel > Tools > Lane Selection.
	2. Create a rectangle surrounding the group. Position the tool above the top migration line at th...
	3. Drag the tool below the bottom migration line to the opposite corner of the last lane in the s...
	4. Release the mouse. The Multiple Lane Setting dialog box is displayed.
	5. Choose either Automatic Lane Detection and Fitting or Manual Input.
	6. Click OK. By default, Image Analysis displays a central line down each defined lane, with addi...
	7. If any of the lanes need adjustment, click the lane to highlight it and move it to the correct...

	Set Migration Lines (page�5-52)
	Autobanding (page�5-63)
	1. Select Normalized Volume (IOD) and choose Type 4 as the calculation type in the 1D-Gel Prefere...
	2. Click the Automatic Band Detection tab to edit the autobanding parameters.
	3. Try these settings and adjust the settings as needed for different gels:
	4. Choose Edit > Select All to select all the lanes.
	5. Click the Automatic Band Detection buttonor choose 1D-Gel > Function > Auto Band. You might ne...
	6. Click the Band Edit buttonor choose 1D-Gel > Tool > Band Edit, then use the cursor to place ba...

	Set Marker (page�5-71)
	1. Click the Quantification Setting buttonor choose Quantification Setting... from the 1D-Gel Menu.
	2. Click the Marker Setting buttonor choose Set Marker... from the 1D-Gel menu.
	3. Highlight the lanes containing the marker by holding down the Shift key while clicking on them...

	Calculate Base Pairs (page�5-80)
	1. Click the Volume Calculation buttonor choose Volume Calculation from the 1D-Gel menu to calcul...
	2. Click the Open Spreadsheet buttonor choose Open Spreadsheet from the 1D-Gel menu to view the t...
	3. Choose Export from the SpreadSheet menu to save the spreadsheets as comma-delimited text files...


	Multi-Color Experiment Flowchart
	Multi-Color Experiment Procedure
	Create a New Project (page�5-3)
	1. In the File menu, choose New Project. A new Project window is displayed.
	2. In the Project menu, choose Add Image..., then select a file that contains a digital image of ...
	3. The Image menu appears in the menu bar and its corresponding tool buttons become active.
	4. Click the Marker Setting buttonor choose Set Marker... from the 1D-Gel menu.
	5. If you are using an internal lane standard (such as Promega’s CXR), select the channel used to...
	6. If an internal lane standard was not used, select the channel used to scan the any standard ma...

	Create 1D-Gel analysis (page�5-14)
	Adjust Gray Level. (page�5-14)
	1. In the Image Setting dialog box, select Mono as the display mode.
	2. Click the Gray Level Adjustment buttonor choose Gray Level Adjustment from the Image menu. The...
	3. In the Full Image window, drag the Zoom Cursor to a region containing average intensity bands/...
	4. In the Zoom window, surround a band with the Selection Cursor, then click the High Signal butt...
	5. Move the Selection Cursor to a background area away form the band, and then click the Backgrou...
	6. If these gray level adjustment parameters is to be used again in the future click the Template...
	7. Repeat the gray scale adjustment for each channel. Switch to a different channel by placing a ...
	8. Click OK to apply these values to the image.

	Perform Color Separation (page�5-30)
	1. Select Blend as the display mode.
	2. Review the Multi-Band Separation parameters. Click the Preferences buttonor choose Preferences...
	3. Try these settings and, if necessary, adjust them for different gels:
	4. Click the Lane Selection Tool buttonor choose 1D-Gel > Tool > Lane Selection.
	5. Find a lane that contains a minimum of one band of each color.
	6. Position the tool at a corner of the lane above the top migration line. Drag the cursor down t...
	7. Click the Automatic Band Detection buttonor choose 1D-Gel > Function > Auto Band.
	8. After Image Analysis has automatically detected bands in the lane, click the Multi-Band Color ...
	9. If you are not satisfied with the separation of the colors, adjust the Multi-Band Color Separa...
	10. After the Multi-Band Color Separation window is displayed, click the Copy>> button or load a ...
	11. Click the row of the band you want to edit. The Status Edit buttons are activated.
	12. If this Multi-Band Separation Marker is to be used in the future (i.e. Controls such as K562,...
	13. Once the band colors have been verified, click OK. The Color Separation window is displayed.
	14. Click OK to perform the color separation. Image Analysis creates an image for each channel th...

	Set Lanes (page�5-52)
	1. Click the Multiple Lane Selection Tool buttonor choose 1D-Gel > Tool > Multiple Lane Selection.
	2. Create a rectangle surrounding the group. Position the tool above the top migration line at th...
	3. Drag the tool below the bottom migration line to the opposite corner of the last lane in the s...
	4. Release the mouse. The Multiple Lane Setting dialog box is displayed.
	5. Choose either Automatic Lane Detection and Fitting or Manual Input.
	6. Click OK. By default, Image Analysis displays a central line down each defined lane, with addi...
	7. If any of the lanes need adjustment, click on the lane to highlight it and move it to the corr...

	Set Migration Lines (page�5-52)
	Autoband (page�5-63)
	1. Select Normalized Volume (IOD) and choose Type 4 as the calculation type in the 1D-Gel Prefere...
	2. Click the Automatic Band Detection tab to edit the autobanding parameters.
	3. Try these settings and adjust the settings as needed for different gels:
	4. Choose Edit > Select All to select all the lanes.
	5. Click the Automatic Band Detection buttonor choose 1D-Gel > Function > Auto Band. You might ne...
	6. Click the Band Edit buttonor choose 1D-Gel > Tool > Band Edit, then use the cursor to place ba...

	Set Marker (page�5-71)
	1. Click the Quantification Setting buttonor choose Quantification Setting... from the 1D-Gel Menu.
	2. Click the Marker Setting buttonor choose Set Marker... from the 1D-Gel menu.
	3. Highlight the lanes containing the marker by holding down the Shift key while clicking on them...

	Calculate Base Pairs (page�5-80)
	1. Click the Volume Calculation buttonor choose Volume Calculation from the 1D-Gel menu to calcul...
	2. Click the Open Spreadsheet buttonor choose Open Spreadsheet from the 1D-Gel menu to view the t...
	3. Choose Export from the SpreadSheet menu to save the spreadsheets as comma-delimited text files...

	7 Array Analysis

	Array Menu and Tools
	Creating an Array Analysis
	1. Create a new project.
	2. Choose New Array Analysis in the Project menu.
	3. Select a file that contains a digital image. A new Array experiment is added to the project tr...
	4. Double-click the Array Experiment icon. An Array Experiment window containing the image is dis...
	5. To deselect an item, remove the checkmark adjacent to it.
	6. Click OK.

	Analyzing Spots in an Image
	Creating a rectangle or oval spot boundary
	1. Click the Create Rectangle Spot or Create Oval Spot.
	2. Drag the cursor to draw a rectangle or oval around each spot of interest.

	Modifying the boundary of a spot
	1. Click the Select Tool buttonor choose Array > Tool > Select.
	2. Place the cursor inside the boundary until it transforms into a crosshair, then drag the cross...
	1. Click the Select Tool buttonor choose Array > Tool > Select.
	2. Place the cursor over a transformation handle (initially the upper left or lower right handle)...
	1. Click the Select Tool buttonor choose Array > Tool > Select.
	2. Place the cursor over a rotation handle (initially an upper right or lower left handle), and t...

	Duplicating a spot boundary
	Creating a Grid
	1. Click the Preferences buttonor choose Preferences... from the Array menu.
	2. In the Grid Option filecard, enter the number of cells in the H (horizontal) and V (vertical) ...
	3. If you entered 1 as the number of cells horizontally, enter a value in the cell width field.
	4. If you entered 1 as the number of cells vertically, enter a value in the cell height field.
	5. Click OK.
	6. Click the Create Grid Spot button.
	7. Place the crosshair cursor in the center of the spot at the top corner, and then drag the curs...
	8. Release the mouse button, then move the cursor down until the inner rectangle passes through t...
	9. Then click the mouse button. The grid is created according to the grid options set in the Pref...

	Modifying a Grid
	Grouping Spots and Grids
	1. Hold down the Shift key, and then click the single spots or grids you want to group. Any type ...
	2. Choose Group from the Array menu.
	3. Change the spot parameters. Your changes will affect all spots in the group.

	Creating a Template
	1. Click on the Array Template button. Array Template dialog box is displayed.
	2. Click Add. The Select Spots and Grids dialog box lists the spot and grid elements in the image...
	3. When you are finished, click the Save button. The template appears in the list preceded by the...
	4. Click on the Array Template button. The Array Template dialog box is displayed.
	5. Click on the desired template in the list, and click Apply.

	Background Calculation
	1. Click the Preferences buttonor choose Preferences... from the Array menu.
	2. In the Preferences dialog box, click the Volume Calculation tab.

	Registering the Background Value
	1. Create a rectangle or oval spot surrounding the area that represents the background.
	2. Click the Set Selected Spots to Background buttonor choose Set Selected to Background from the...
	3. The boundary color changes to yellow.

	Registering Markers
	Standard Curve Type
	1. Click the Preferences buttonor choose Preferences... from the Array menu.
	2. In the Preferences dialog box, click the Quantification tab.
	3. Select the desired standard curve in the list box, then select a straight or Logarithmic scale...
	4. Click OK.

	Spot Markers
	1. Select any spot or group of spots, then click the Set Selected Spot(s) to Marker buttonor choo...
	2. Click the Open Spreadsheet buttonor choose Open Spreadsheet from the Array menu.
	3. Enter a quantity value for each marker spot in the column labeled “Mol.”. If necessary, use th...

	Grid Cell Markers
	1. Double-click on the grid containing the marker cells. The Grid Marker dialog box is displayed.
	2. In the Grid Marker table, enter the amount of each marker corresponding table cell. Any cell c...
	3. If you plan to use these grid markers again, save the parameters as a template.
	4. Click OK. The boundary color of the cells changes to violet.

	Grid Templates
	1. If you want to use an existing grid marker template, select the template from the Parameter Se...
	2. Click Load.

	Displaying the Standard Curve

	Setting a Partial Quantity
	1. Click the Preferences buttonor choose Preferences... from the Array menu.
	2. In the Preferences dialog box, click the Part Quantity tab.
	3. Click On.
	4. Choose the type of partial boundary, Rectangle or Oval.
	5. Enter the horizontal (0.68 - 100) and vertical (0.68 - 100) dimensions. The following examples...

	Mol Calculation
	Displaying a Spreadsheet
	1. Click the Preferences buttonor choose Preferences... from the Array menu.
	2. In the Preferences dialog box, click the Spot Information tab.
	3. Click the Open Spreadsheet buttonor choose Open Spreadsheet from the Array menu.

	Exporting a Spreadsheet
	1. Choose Export... from the SpreadSheet menu.
	2. In the Save As dialog box, select a location for the file, and then enter a unique name.
	3. Click Save.


	Comparing Grids
	1. Choose Send Data To Grid Comparison... from the Array menu.
	Data Sheet Filecard
	Data Sheet Buttons
	2. Select the grids to compare by first clicking the first grid to highlight it.
	3. Click the Channel 1 button.
	4. Highlight the second grid, and click the Channel 2 button.
	5. In the Compare by drop-down box, select a Concentration, Volume, Standard, Mean, or Area.
	6. Click the Switch Active Channel buttonto display the grid data for each channel.
	7. If you want to copy the spreadsheet to the clipboard, click the Copy Spreadsheet button.


	Overlay View Filecard
	1. Adjust the spot radius by using the sliding control bar.
	2. Choose the target channel and its color from the drop-down list boxes.
	3. The histogram displays the # pixels vs. raw gray scale value. Using the blue slider on the his...
	4. Click the Gray Scale... button. The Gray Scale Setting dialog box is displayed.
	5. Choose to use % (percentage) of total pixels or raw value as the gray scale unit for the thres...
	6. Type values for the top and bottom gray scale thresholds in the fields.
	7. If desired, you can choose to use the optimal gray mapping mode. This mode is equivalent to th...
	8. Click the Screen Setting button. The Screen Setting dialog box is displayed.
	9. Specify the Screening and Viewing options.
	10. Apply the screening settings to the grid overlay by clicking the On/Off Pickup Mode button.
	11. If desired, you can copy the image to the clipboard by clicking the Capture Image button.
	12. Click the Pickup Screened Spots button. The Selected Spots spreadsheet is displayed containin...

	Grid Comparison Filecard
	1. Click on the Grid Comparison tab. The expression and volume ratios for the channels is display...
	Grid Comparison Buttons
	1. Click on the Show expression ratio button. The expression ratio histograms and numerical value...
	2. Click on the Show volume ratio button. The volume ratio histograms and numerical values for th...


	Scatter Plot Filecard
	1. Click on the Scatter Plot tab.
	Scatter Plot Buttons
	2. Click the Show Spot Label button. A label with the grid coordinate appears on each spot.
	3. Double-click on a spot.
	4. To change the size of the spots, click the down arrow next to the Spot Size button, and choose...
	5. To magnify an area of the plot, drag the cursor to form a rectangle enclosing the area of inte...
	6. Release the mouse button. The plot is magnified so that the area occupies the entire graph.
	7. Click the Pickup Spots in the Range button. The comparison data for the spots is displayed in ...
	8. To return to the original magnification, click the Reset Magnification button.
	9. To copy the image to the clipboard, click the Capture Image button.


	8 Drawing Tools

	Draw Menu and Tools
	1. To use the drawing tools, click the Drawing Tool buttonor choose Drawing from the Tools menu. ...
	2. In the View menu, choose to display the Draw 1, Draw 2, Draw 3, and Text Attribute toolbars.
	Right-click Menu
	Setting the Margins
	1. Click the Paper Position. The Comments Area Settings dialog box is displayed.
	2. Type in the desired top, bottom, left, and right margins in pixels, and Click OK. The margins ...

	Rotating Text
	1. Select the text box you want to rotate.
	2. Click the Rotate text... button. The Rotation Setting dialog box is displayed.
	3. Choose to enter a free rotation angle or select a fixed rotation from the drop-down list box, ...
	4. Position the text box as desired.

	Draw Tools
	Working with Draw Objects
	9 Maintenance
	Cleaning
	Service
	Laser Head
	Photomultiplier Tube
	Operating Temperature
	Moving the Scanning Unit
	Shipping
	Shutdown
	Troubleshooting the Scanning Unit
	Red Error Light Flashing
	1. Turn off the Power switch and wait 5 seconds.
	2. Turn on the Power switch and wait for the FMBIO�II self-diagnostic routine to end.
	3. If the Error light continues to flash, call Hitachi Software Engineering service personnel.

	Responding to Problems
	Water Spills Inside the Scanning Unit
	Foreign Objects In the Scanning Unit
	Equipment or Power Cord is Damaged
	Unknown Cause of Damage
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	Installing the STaR�Call Software
	STaR�Call Installation - Windows Version
	Requirements
	Installing STaR�Call
	1. If you have just installed Microsoft Office or Excel, run Excel once to allow it to complete s...
	2. Make sure that Excel is closed.
	3. Insert the STaR�Call disk into the drive.
	4. Select the directory corresponding to the version of Excel that is installed; either Excel 95 ...
	5. According to which version of Excel you have:
	6. If a dialog box appears asking you if you want to enable or disable macros, click the Enable M...

	Starting STaR�Call
	Removing STaR�Call
	1. Make sure that Excel is not running.
	2. Locate the Excel startup folder. The Excel startup folder location depends on which version of...
	3. Remove the files fmbiostr.xla and codisdbf.xls from the startup folder.


	STaR�Call Installation - Macintosh Version
	Requirements
	Installing STaR�Call
	1. If you have just installed Microsoft Office or Excel, run Excel once to allow it to complete s...
	2. Make sure that Excel is closed.
	3. Insert the STaR�Call disk into the drive.
	4. Select the folder corresponding to the version of Excel that is installed; either Excel_5 or E...
	5. According to which version of Excel you have:
	6. If a dialog box appears asking you if you want to enable or disable macros, click the Enable M...
	7. Click the Install button. If you have previously installed STaR�Call, a window will be display...
	8. At the end of the installation, the following message box will inform you of a successful inst...
	9. Restart Excel. STaR�Call should automatically load when Excel is started. It will appear as a ...

	Starting STaR�Call
	Removing STaR�Call
	1. Make sure that Excel is not running.
	2. Locate the Excel startup folder. The Excel startup folder location depends on which version of...


	Short Tandem Repeats
	Preparing for Allele Evaluation
	1. In a one-dye image, adjust the gray level (see page�5-14). In a multi- color project, perform ...
	2. Define the lanes to be analyzed (see page�6-11). STaR�Call can accept up to 51 lanes for analy...
	3. Use the Automatic Band Detection tool to define bands (see page�6-11). Check bands and edit as...
	4. Register marker lanes, using the Logarithms curve fit (see page�6-13).
	5. In the 1D-Gel menu, choose Preferences.... In the Calculation filecard, choose Normalized Volu...
	6. Click the Volume Calculationbutton to generate results (see page�5-88).

	Exporting 1D-Gel Analysis Results
	1. Click the Open Spreadsheet buttonor choose Open Spreadsheet from the 1D-Gel menu or to display...
	2. In the SpreadSheet menu, choose Export....
	3. Indicate where you want to save the tab-delimited text file, name the file, then click Save.
	4. Save any changes to the project.

	Using STaR�Call to Evaluate Alleles
	1. Open Excel.
	Options
	STR Lookup Table
	Stutter band reporting
	Creating, editing, or deleting a STR Lookup table
	1. Enter a valid sheet name in the Create New Lookup Table field.
	2. Click the New button.
	1. In the STaR�Call menu, choose STR Lookup Table. The STR Lookup Table dialog box is displayed.
	2. Select the STR Lookup Table in the Edit or Delete Lookup Table list box.
	3. Click the Edit button.
	1. In the STaR�Call menu, choose STR Lookup Table. The STR Lookup Table dialog box is displayed.
	2. Select the STR Lookup Table in the Edit or Delete Lookup Table list box.
	3. Click the Delete button.


	Importing STR files
	1. In the STaR�Call menu, choose Import STR....
	2. In the Import STR dialog box, click the Browse button.
	3. Locate the file you want to evaluate.
	4. Select a STR Lookup Table in the drop-down list box.
	5. Repeat the process to add more files.
	6. Select a conversion method:
	7. Click OK to import the files. The Evaluate Select Allelic Ladders dialog box is displayed.
	a. Click the Auto Select button to let STaR�Call choose the lanes with the most bands, as in the ...
	b. Click on one allelic ladder to select it as the standard for comparison.
	c. Press and hold down the Ctrl key as you click more than one allelic ladder. These ladders will...

	8. Click OK to complete allelic ladder selection.
	Summary Worksheet
	Analysis Worksheet
	Merged Worksheet
	1. Click on the cell containing the data you want to edit.
	2. Type the value.
	3. Click on another cell in the sheet.

	Merged Landscape
	4. Carefully evaluate bands that STaR�Call has not assigned to a genotype. Some “Not in range” ba...


	Adding an STR
	1. Select the analysis workbook.
	2. Choose Import STR... from the STaR�Call menu.
	3. Click Yes when asked if you want to add a file to the current analysis.
	4. In the Import STR dialog box, click any available Browse button to select a file.
	5. Select a STR Lookup Table in the drop-down list box.

	Recalculating Results
	Comparing Analyses
	1. Choose Compare Analyses... from the STaR�Call menu. The Compare dialog box is displayed.
	2. Select the two analysis workbooks in the drop-down list boxes. Click the Browse button to open...
	3. Select the Compare lane information option if required.
	4. Click OK.

	Printing and Saving Results
	Exporting Data to CODIS
	1. In the STaR�Call menu, choose CODIS STR Export.... The CODIS STR Header dialog box appears.
	2. Enter the required information. Click the [+/-] button to add or delete list values.
	3. Click Next. The CODIS STR Specimen Information Dialog Box is displayed.
	4. Enter the required information. Click the [+/-] button to add or delete list values.
	5. Click Export to convert data to a CODIS-compatible data file.
	6. Enter a unique name and location.
	7. Click Save. A CODIS worksheet is added containing the header information.

	Appendix A - Software Reference

	Keyboard Shortcuts
	Icons - Image Analysis Tools
	File and Edit Tools
	Image Tools
	1. Click the button. The cursor transforms into a magnifying glass with a “+” sign.
	2. Drag the magnifying glass cursor to create a rectangle surrounding a region of the image. The ...

	1D-Gel Tools
	Multi-Band Color Separation Tools
	Trace Overlay Tools
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